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Welcome
This manual is intended to provide instruction and reference for core features and
functions within the Manitou Central Station (CS) Supervisor Workstation, Version 1.6.4,
hereinafter referred to as SWS. SWS allows Supervisors to efficiently perform the
following functions:

· View the alarm queue to display current alarm traffic and Operator response
information

· Define access permissions for user groups and users that can be applied to limit
certain aspects Manitou functionality

· Change and customize Event Codes and Categories
· Manage system hardware
· Monitor all system functions and resources
· Receive warnings and error messages

About Bold Technologies
Bold Technologies, an industry leader since 1981, has stood the test of time in Central
Station and alarm automation software. Formerly known as Bradley On-Line Data
Systems, Bold Technologies created the Bold Central Station Automation System and
through the years, shaped the development of contemporary alarm monitoring by
introducing faster and more sophisticated software innovations. We promote excellence
and technological innovation through strategic partnerships and support of
organizations dedicated to advancing industry standards. As a proven leader in the
security industry, our strength is founded on a company-wide commitment to helping
our Customer group through superb products and services. This commitment guides
Bold's decisions for future development.

About Manitou
Bold Technologies, recognizing that the future was about innovations within the
Windows® world, began building the Manitou system from the ground up in 1999.  The
first sites went live on this new-age monitoring system in 2002.  The Manitou system
was completely redesigned and revolutionary, opening the alarm industry up to new
concepts and ideas. This endeavor has changed the industry paradigm and encouraged
broad advancements industry-wide.
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Mantiou CS 2.0.0 System
Requirements

Please have the following components in place prior to upgrading to Manitou CS 1.6.4:

ü Database Drive Space Allocation 
You will need to have enough disk space to double the current size of your existing
Manitou Database. For example, if your current Manitou Database is 20 GB you will
want to have at least 20 GB of free space on that drive. 

ü Installation of a Verified SSL Certificate for BoldNet
If you plan to use BoldNet, you will need to have an SSL Certificate installed. This
certificate must be verified by a trusted root authority.

ü Latest Microsoft Windows Updates

ü Microsoft .NET 4

ü Microsoft Windows Server 2003 or higher
You need to be running Windows Server 2003 or higher on all machines hosting
Manitou applications, components and/or services. We recommend, however, that
you run Microsoft Windows Server 2008.

ü Microsoft Windows XP Professional or higher
If you are running any Manitou services on a Workstation (e.g., publishing that
requires a faxing service), you will need to run Windows 7 Professional or higher. If
you are not running any Manitou services on your Workstation, we still recommend
running Microsoft Windows 7 Professional or higher.

ü A monitor and graphics card that supports resolution of 1680 x 1050
If you will be using Workflow, you will need a graphics card and monitor that
supports 1680 x 1050 resolution.

ü Microsoft Windows SQL Server 2005 or higher

ü You will need to stop data entry during the upgrade
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Getting Started
Logging into SWS
Perform the following steps to log into SWS:

Double-click the SWS icon on your desktop. The icon displays as follows:

Result: the SWS login screen displays as shown in the following screenshot:

Enter your username and password, and click "OK".  
Result: The Supervisor Workstation window displays as shown in the following
screenshot:
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Supervisor Workstation Navigation
The SWS Window
Manitou was designed for use with the Windows platform.  The window displayed
below is the SWS window with the Users form selected in the Application Pane.  The
SWS window can be divided into the following four areas:
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· Toolbar

Provides access to the Toolbar Menus, and icons.

· The Navigator Pane

Provides navigation quick links between forms and shortcuts.
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· The Application Pane

The Application Pane is the area on the SWS window that displays the active Manitou
form. In the example screenshot displayed above, the Applications Pane is outlined with
a red rectangle and displays the Users form. All data on Customers, Output Devices,
Receivers, and Action Patterns displays here.

· The Status Bar

The Status Bar provides a quick-view into Manitou's Alarm Queue by displaying a list of
alarm priorities and informational messages.

Note: the clock at the bottom of the Status Bar displays the time as kept by the Manitou
server. Whenever possible, individual machines should be synced to the server. If you
need to report the exact time an alarm was received , please refer to this server time
display.
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Pushpins

Pushpin icons are located in the upper-right corners of the Navigator Pane and Jump To
menu. Pushpins allow users to select which panes display onscreen.

Pinned
pushpin

A "pinned" pushpin denotes that the pane displays on the SWS window.  To
"turn", or hide the pane, click the pin icon.  Once the mouse is drawn away
from the pin, the frame 
disappears.  It is now in auto-hiding mode and will now display only when the
mouse is directed over it.

Turned
pushpin

A "turned" pushpin denotes a pane that is hidden from the SWS window.  To
view the pane, scroll over it with your mouse pointer.  To re-pin to the
application desktop, once the 
pane expands, click the push pin, switching it from "turned" to "pinned".
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Navigator Pane
The Navigator Pane 
This pane contains links to all Customers, recent alarms, and shortcuts. It includes three
separate tabs as displayed in the screenshot below:

Click the tabs to toggle between screens, or press the corresponding function key on
your keyboard.

The Navigation Tree
The Navigation Tree offers quick navigation between forms in Manitou.  It includes the
following two main features:

The Current Folder Icon
The "Current" folder icon on the Navigation Tree displays all forms currently open in the
Application Pane. In the example displayed in the screenshot below, there are five forms
currently open in the Application Pane. These forms display as subcategory icons under
the"Current" folder icon. Click the subcategory icons below the "Current" folder icon to
switch between active forms.

The Shortcut Folder Icon
The "Shortcut" folder icon on the Navigation Tree displays user-defined forms the
Supervisor has designated to display as shortcuts.

Perform the following steps to add a new form to your Navigation Tree "Shortcuts"
folder:
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1. Right-click the "Shortcuts" folder icon, and select the "Customize Shortcuts" folder
icon.

Result: the "Customize Shortcuts" screen displays as shown in the screenshot below:

2. Select the shortcut you want to add from the left column, and then click the
right-facing single arrow.

Result: the shortcut you selected displays in the right column.

3. Continue adding shortcuts to the right column until you have added all the shortcuts
you want, then click "OK".

Result: the "Customize Shortcuts" screen disappears and the shortcuts you added now
display under the "Shortcuts" folder icon in the Navigation Tree.

4. Switch between the shortcuts to switch between active forms in the Application Pane.

Notes - F3

The "Notes-F3" tab allows a Supervisor to message himself a personal reminder. Notes
posted to the "Notes-F3" tab are designed to be personal and are not published to the
database. Once a note displays at the time the Supervisor designates, Manitou removes
it from the system.

Perform the following steps to post a reminder note to the "Notes-F3" tab.

1. To post a note using the "Notes-F3" tab, click it.
Result: a date dropdown menu and a list of times displays a 24-hour period in which to
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enter notes.
2. Double-click the half hour time period in which you want the reminder to display.
Result: the "Enter Note" screen displays as shown in the following screen shot:

3. Enter a note and select a time for the system to give you an advance reminder, and
click "OK".

Result: the "Enter Note" screen disappears, and the description now displays in the
time field you selected. When the time you selected for the advance reminder arrives, an
advance reminder message displays.
4. Click "OK".
5. When the time you selected for delivery of the note arrives, a screen displays your

note.
6. Click "OK".
Result: Manitou permanently deletes the note setting from the system. 

IM - F7

The "IM-F7" tab is an instant messenger service available to logged on users.  Messages
can be sent to individuals, groups, or all users currently logged in to the system. 
Additionally, messages can be set to display across the Status Bar Watchdog messages.

Perform the following steps to send an instant message to another Manitou user:

1. Click the "IM-F7" tab
Result: a list of Manitou users displays along with the following window:
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2. Select a user from the list designated as "Online" and enter your message in the
lowest area of the Navigation Pane.

3. Click the "Send" icon displayed in the following screenshot:
Result: Manitou sends your message to the recipient you designated.

Note: To send a message to multiple users rather than an individual, select a user group
as the recipient. To send a message to every Manitou user, select "Everybody" as a
recipient. To send a message that displays as a Status Bar Watchdog message, select the
"Show on banner" option to the left of the "Send" icon. Instant Messages are not private.
They are logged in to the database.

Status Bar
The Status Bar
The Status Bar provides a quick-view into Manitou's alarm queue by displaying a list of
alarm priorities and informational messages.

Alarm Counts
Manitou rates alarm severity by assigning numbers 1 through 10 (with 1 being of
highest priority and 10 being the lowest), these fields show how many alarms are
currently listed in the system.  Each priority number has a field (to the right) associated
with it showing how many alarms are currently in queue.  Along with queue counts, the
Status Bar also shows whether alarms are Suspended, New, Viewed or Actioned.

The Status Bar cannot be hidden, but a Supervisor can collapse it so that only the
Watchdog messages are visible.  The Supervisor performs this function by using the
Minimize and Maximize buttons located at the far right of the Status Bar.

Minimize
button

Minimizes the Status Bar to show only Watchdog messages

Maximize

Expands the Status Bar to show Counts and Watchdog messages
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button

Manitou displays each alarm in the alarm count in one of two different colors to indicate
how much has passed since it was received. The SWS uses the following colors to help a
Supervisor distinguish between alarms:  

· White background with black text - active alarms that are less than 60 seconds old
· Red background with white text - alarms that are older than 90 seconds

Note: only one alarm per priority level needs to age for the field color to change.

Manitou also separates alarms into fields on the Status Bar pursuant to the following
status designations: 

· Suspended Alarms - alarms that have been suspended by users. 
· New Alarms - alarms that have not yet been viewed or actioned by users.
· Viewed Alarms - alarms that have been viewed.
· Actioned Alarms - alarms for which a user has performed at least one action

pattern. 
Note: Alarm count information relates only to the Monitoring Group to which the
current user belongs. They do not reflect alarm volume for the system as a whole.

Watchdog Messages
Watchdog messages display on the Status Bar just below the alarm status fields.  These
messages notify the Supervisor of signal processing and alarm progress activities within
the system. Watchdog messages are also color coded according to the following system:

· Green - denotes non-critical information
· Yellow - denotes priority information
· Red  - denotes critical inforation

Message Buttons
Three buttons have been added at the end of the Watchdog message field to help. These
message buttons function as follows:

Ellipsis
button

The "..." displays a list of all Watchdog messages. 

Number
button

The "0" button displays the number of Watchdog messages in the queue
behind the current message.

Clear
button

The "Clear" button clears the Watchdog message field until the next message
is received.
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Toolbar Menus
The SWS includes the following Toolbar Menus:

File Menu
The Toolbar File Menu includes the following options:

Close - closes the current open window
Close All - closes all open windows listed under the "Current"
file icon of the Navigator Pane
Save - saves any changes to a record
Edit Record - enables the user to edit the current record
Delete - deletes the current record
Print - prints selected material to the designated printer
output
Properties - allows a user to enable certain functions such
Debugging Mode and the use of an internal RTF viewer for
reports 
Change Password - allows a user to change his password
Lock Station - locks the user station and requires the user to
enter his password to unlock it
Logoff - logs the current user off the system without exiting
the software
Exit - exits the software
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View Menu
The Toolbar View Menu includes the following options:

Navigator - hides the Navigator Paneand maximizes the Application
Pane
Status - hides and unhides the Status Bar 
User Status - displays the activities of every workgroup user
currently logged into Manitou
Processes - displays all the Manitou applications currently active in
Manitou
Alarm Queue - displays all the active alarms in Manitou and allows a
user to display the Alarm Queues for different Monitoring Groups 

Tools Menu

The Tools Menu includes the following options:

System Log - provides details of user activity on Manitou
including log in/off information, Publisher, Report Server,
and Watchdog messages
Raw Data Log - provides detail on alarms and other receiver
signals in the format they are presented to the FEP. The Raw
Data Log is primarily a diagnostic tool.
System Application Log - provides diagnostic information
regarding each application in Manitou and any functionality
issues that may exist
Voice Recordings - SecurVoice allows a user to record
telephone conversations via Manitou
Calls - provides a log of calls into and out of Manitou
Options - allows a user to customize the color coding in
Manitou
Reprocess Tickets -  allows a user to manually print tickets
in the event of an emergency
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Maintenance Menu
The Maintenance Menu includes the following options:

Users - displays the Manitou User form
User Groups - displays the Manitou User Groups form
Workstations - displays the activity for every Workstation
within the user's User Group 
Events - allows a user to display the Event Codes, Event
Categories, or Event Maps forms
Setup - allows a user to quickly access 21 different Manitou
setup options
Class Codes - allows a user to keep different types of
customer accounts separate. For example, a grocery store
chain may be assigned to a single Group Code to categorize 
stores at a group level. At the next level, Class Codes are
assigned to all grocery stores, regardless of a specific
grocery store chain. 
Group Codes - allows a user to categorize and report on
categories of businesses that might have multiple branches
or locations
Resolution Codes - allows a user to use predefined alarm
codes for particular alarm situations. For example, an alarm
may be received that has been set off as a result of a 
thunderstorm. The user may wish to resolve the alarm by
entering "WE" for "Weather," where "WE" has been
previously defined in the Resolution Codes section of SWS as
a 
false alarm.  
Schedule Window Codes - allow the SWS user to create and
apply simple deviations to OWS Schedule Windows
Accounting Companies - allows a user to integrate Manitou
with accounting software such as Sedona and Quickbooks
Control Panels - allows a user to create and maintain a
global list of Control Panels in common use across the
Manitou system
Global Holidays - allows Manitou users to program the
system with the dates of public holidays for the current year
Maintenance Issues - allows a Manitou Operator to make a
record of any malfunctions occurring at the Customer site
Script Messages - allows users to create messages that can
be saved and sent to Customers via email or fax
Web Membership - allows users to access features in
BoldNet
Audit Trail - allows a user to keep a detailed log of changes
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made during data entry

Reports Menu

The Reports  Menu includes the following options:

System Reports - allows a user to access frequently used reports
Scheduled Reports - allows you to search for and view specific
Scheduled Reports in Manitou
Report Queue - lists the status of all reports queued
Report Templates - allows you to change the default settings for
subsequent Manitou Reports

Help Menu

The Help Menu includes the following options:

Help on Supervisor Workstation - accesses the
help file attached to the SWS
Help Online - accesses the online help features
Manitou Support Online - connects to an online
Bold support technician
Remote Support Session - allows a Bold technician
to access a system remotely
About Operator Workstation - provides
information about the software version installed and
Bold contact information

Forms in the View Menu
User Status

The User Status screen provides information about the current status of each Manitou
system user, as well as details about recent sessions. 

The list in the User Status window includes all system users and indicates whether or
not they are currently logged into the Manitou system. In addition to control room
personnel, the list includes anyone who has remote access to Maintou. 

Using the Session Details Filter Tab
The Session Details Filter Tab allows a user to filter the user list using the parameters
you set.

1. To use the filter tab, simply click the tab at the bottom of the User Status screen as
shown in the following screenshot:
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Result: the "Filter Criteria" window displays as shown in the following screenshot:

2. Deselect any user categories you want to exclude from the user list, and click "Apply".
Result: the user list displays with users of the types you de-selected removed from the
list.

Processes
Various Processes run silently in the background of Manitou and undertake routine and
repetitive tasks such as logging and printing. 

Accessing the Processes Screen
The Processes screen displays the status of Manitou system processes and can assist
system engineers in the diagnoses of problems. 

To access the Processes screen:
Click "View", and then click "Processes".
Result: the "Processes" screen displays as shown in the following screenshot:
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A user can select a specific Process for viewing simply by clicking the row on which it
displays.

Click the Refresh icon in the top left corner of the Processes screen to refresh the
Processes list.

Process Threads
A thread is a subpart of a procedure that can be scheduled to run independently from its
main Process. Select a Process and select "Show threads for all processes" to display all
threads associated with the Process.

Process Sessions
A session is every instance that a Process is running on the Manitou system. Select
"Show sessions for all processes" to display a list of every active session for all the listed
Processes in Manitou. 

Alarm Queue
The Alarm Queue displays live alarms that are received by Manitou. The Alarm Queue is
read-only in SWS. Users cannot process the alarms displayed.  

Accessing the Alarm Queue Screen
To access the Alarm Queue Screen: 
Navigate to the View menu, and then select "Alarm Queue".
Result: the Alarm Screen displays as shown in the following screenshot:
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Note: not all SWS Alarm Queue columns display in the screenshot above.
Note: an alarm's color represent its priority and status. The color code is displayed in
the screenshot above. An SWS Administrator can change the color code by selecting the
Tools menu, and then clicking "Options". 
Each time an alarm is received, it displays in the Alarm Queue. The Alarm Queue
displays the following information:

· Alarm Priority Level - Manitou rates alarm severity by assigning numbers 1 through
10+ (with 1 being of highest priority and 10+ being the lowest).

· Code - the Code field displays a two-letter Event Code that is translated into an Event
when Manitou receives an alarm signal. 

· Event - the Event is the activity that caused an alarm signal. Manitou translates the
Event Code it receives and displays the Event in the Alarm Queue.

· Area - an area is a larger location, system, or object than a Zone.  For example, the
third floor of an office building might be Area 3.  Area 3 might contain multiple zones,
each having its own detection devices. The user defines the Area numbers in the
Manitou OWS when he sets up a new customer. Typically, a residence only has one
Area. 

· Zone - a zone is a geographic area, system, or object that has some sort of detection
device in it. Each Area is divided into separate Zones. The user determines the Zone
numbers in the Manitou OWS when he sets up a new customer. For a residence, a Zone
might correlate to a specific room in a house, such as the master bedroom. 

· User - this field displays initials of the user handling the alarm. 
· Availability - an alarm being handled by a user will appear as "Unavailable". Alarms

not yet being handled display as "Available". 
· Status - the Status refers to the level of handling that has taken place on an alarm. For

example, if a user has completed some of the Action Pattern items for an alarm, but
left it open, the Status displays as "Actioned". 

· Suspend Time - a user might choose to suspend an alarm after completing Action
Pattern items and dispatching an Authority. This field shows how much time has
passed since the suspension began. 

· RLP (Receiver Line Prefix) - this field displays the prefix for the device that received
the alarm signal. 

· TXID (Transmitter ID) - this field displays the ID code for the Transmitter that sent the
alarm signal. 

· P/F/M (Police/Fire/Medical) - if the user has dispatched an Authority for the alarm,
the P/F/M field displays as "Yes."
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· Point ID - the Point ID identifies the specific place from which the alarm originated.
For example, if the alarm on the back door of a house is triggered, the Point ID field
displays "back door".

Using the Alarm Queue Filter
The Alarm Queue Filter allows a user to filter the Alarm Queue using the parameters you
set.

To reach the Alarm Queue Filter:
Select the filter tab at the bottom left corner of the Alarm Queue screen.
Result: the Alarm Queue Filter screen displays as shown in the following screenshot:

Users can narrow the types of alarms that display in the Alarm Queue by using the
following filters:

· Postal Code: this field allows a user to enter a specific Postal Code where the alarm
they want occurred.

· Customer ID: this field allows a user to enter a specific Customer ID associated with
the alarm they want.

· Priority: this field allows a user to select only alarms of a specific Priority. A user can
also set one of the "Less Than", "Equal To", or "Greater Than" options to further
narrow the filter parameters.
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· Alarm Age: this field allows a user to select only alarms of a specific duration. A user
can also set one of the "Less Than" or "Greater Than" options to further narrow the
filter parameters.

· Contacted Authority: this checkbox allows a user to select only alarms in which the
user contacted an Authority.

· More Activity: this checkbox allows a user to select only alarms for which the user
completed action plan items in addition to contacting an Authority.

· Event Category: this area allows a user to select single or multiple Event Categories
tied to an alarm signal. 

· Event Definition: this area allows a user to select single or multiple Event Codes tied to
an alarm signal.

· Alarm Type: this area allows a user to select between one of three Alarm Status Types.
· Dealer: this field allows a user to select only the alarms associated with a specific

Dealer.
· Branch: this field allows a user to select only the alarms associated with a specific

Branch.
· Police: this field allows a user to search only for alarms in which a specific Police

Authority was contacted. 
· Current Filter: this area displays all the Alarm Queue filters that are already active.

Once you have entered all your search criteria, click "Select".
Result: the system returns you to the Alarm Queue screen and the "Filter On" button
now displays green as shown in the following screenshot:

To remove any active filters, click either the "Remove Filter" button on the Alarm
Queue screen, or the "Reset" button on the Alarm Queue Filter screen. 

Forms in the Tools Menu
System Log

The System Log provides a Supervisor with details of a specific user's activity on
Manitou. Supervisors can also view user activities with the Report Server, Publisher, and
Watchdog Messages. 

Viewing the System Log
Navigate to the Tools menu, and select "System Log".
Result: the "System Activity Log" screen displays as shown in the following screenshot:



Manitou CS  Supervisor Workstation User Guide | © Copyright 2017 Bold Technologies LTD

22

Note: the System Activity Log screen displays up to 300 listings. If more than 300
listings are available, click "More" to display the additional listings. 
Note: Once the System Activity Log displays, the system does not automatically update
it until you click the "Refresh" button displayed in the following screenshot:

 

The System Log Filter 
A user can narrow the System Activity Log list by using a filter.

To access filter options, click the Filter tab located at the bottom left of the "System
Activity Log" screen.
Result: the System Log Filter screen displays as shown in the following screenshot:
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Select the filters you want to apply to your System Activity Log list, and click "Search".
Result: your filtered search results display.

Date and Time Filter Options
A user can set the date and time search parameters using the date and time fields. 

The "Reverse" checkbox is selected by default. This selection displays a the system's
most recent activity at the top of the list. To display the oldest activity first, deselect the
"Reverse" checkbox.

To display all activity for a date range except that which occurred during a certain time
window, select the "Except Time" checkbox.

Other Filter Options
To display only a certain type of user activity, select that activity from the "Category:"
dropdown menu.

A user can further limit search results to the activity of a specific user by selecting that
user from the "User Id:" dropdown menu.

To display all activity except that of a certain type or by a certain user, select the "Except
Category" or "Except User" checkboxes.

Raw Data Log
The Raw Data Log displays details regarding alarms and other signals received by
Manitou. The data is displayed in the original format received by the Front End
Processors (FEPs). The Raw Data Log is primarily used for diagnostic purposes, but can
be useful in tracing a signal from a specific customer. 

Viewing the Raw Data Log
Navigate to the Tools menu, and select "Raw Data Log".
Result: the "Raw Data Activity Log" screen displays as shown in the following
screenshot:
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Note: the Raw Data Activity Log screen displays up to 300 listings. If more than 300
listings are available, click "More" to display the additional listings. 
Note: when first accessed, the Raw Data Log displays only the raw data received by FEP
1 for the current date. 

Date and Time Filter Options
A user can set date and time search parameters using the date and time dropdown
menus and fields. 

To apply a date and time filter to the Raw Data Log list, select the filters to apply in the
Search criteria area at the top of the screen, and click "Search".
Result: your filtered search results display.
Note: The "Reverse" checkbox is selected by default. This selection displays the system's
most recent activity at the top of the list. To display the oldest activity first, deselect the
"Reverse" checkbox.

Searching by FEP, Receiver Line Prefix, and Transmitter ID
An FEP list similar to the Navigator window displays to the left of the log list. This list
displays all FEPs and their associated receivers. It allows a user to determine the source
of any raw data displayed. 

A user can access Raw Data for a target as broad as an individual FEP, or as narrow as an
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individual Receiver Line. 

To search for Raw Data associated with a specific FEP, Receiver, or Receiver Line, select
the appropriate piece of hardware from the FEP list, and click "Search". 
Result: your filtered search results display.

To search for Raw Data associated with a specific Receiver Line Prefix or a Transmitter
ID, select the Receiver Line Prefix from the dropdown menu, or enter the Transmitter ID
into its field, and click "Search".
Result: your filtered search results display. 
Note: Users may only search using one FEP, Receiver, or Receiver Line at a time. 

System Application Log
The System Application Log allows users to view Manitou application log files. All of the
applications in Manitou (for e.g., the Broker, Sentry, Marshaller, etc.) report their
activities and errors to the log. This information can prove helpful with system
diagnostics and maintenance. 

To view the System Application Log:
Navigate to the Tools menu, and select "System Application Log".
Result: the System Application Log screen displays as shown in the following
screenshot:

Date and Time Filter Options
A user can set date and time search parameters using the date and time dropdown
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menus and fields. 

To apply a date and time filter to the System Application Log list, select the filters to
apply from the "From:" and "To:" fields, and click the "Refresh" button as shown in the
following screenshot:

Result: your filtered search results display.

Application Filter Options
A user can set a parameter to search by Manitou Application.

To perform a search by Manitou Application, deselect the Applications you want to
exclude from the "Applications:" list, and click the "Refresh" button.
Result: your filtered search results display.  

Priority Filter Options
A user can set a parameter to search by the Priority code associated with the
Application process.

To perform a search by Priority code, deselect the items you want to exclude in the
"Priority:" list, and click  the "Refresh" button.
Result: your filtered search results display. 

Search Text Options
A user can set a parameter to search by specific text he enters.

To perform a text search, enter the text for which you want to search into the "Search
Text:" field, and click the "Filter Search" button.
Result: your filtered search results display. 

Voice Recordings
The Voice Recordings function in the Manitou SWS records telephone conversations
between a Monitoring Company and its contacts. The user can then play them back at a
later time. 

In order to access the Voice Recordings function, users must have the SecurVoice
application installed and correctly configured on their system.
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Adding the SecurVoice Device 
Perform the following steps to install and configure SecurVoice in SWS:

Navigate to the Maintenance menu and click "Setup", and then "Service Provider
Devices". 

1. Click "Edit", and then click "Add".
Result: the "Add Service Provider Device" window displays as shown in the following
screenshot:

2. Enter "SecurVoice" into the "External Device:" field.
3. Select "Voice Recorder" from the "Protocol:" dropdown menu, and click "OK".
4. Click "Save".

Next, the user must set up SecurVoice as the current Voice Recorder. 

1. Select System Options.

2. Under Voice Recordings, select SecurVoice as the Voice Recorder System.

Select Workstations in the Supervisor Workstation. In the Recorder ID/Channel column,
select the appropriate channel name. These channels must first be set up using the
SecurVoice software:
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A lack of a license will prevent the user from selecting the appropriate channel name.

Note: Currently, live monitoring is not available.

In the Supervisor Workstation, select the Tools menu. From  here, select Voice
Recordings.

Enter any search parameters and click the Refresh  button. 

· Channel - Which channel to search for clips. Leaving the Channel field blank will
result in all channels.

· From and To - The date and time range for the clips.

· Allow time overlap - If a clip's beginning or ending time falls inside the date and time
range, it will be included. Otherwise, the clip's beginning and ending time must fall
completely within the date and time range. 

The search criteria will display below:



Voice Recordings 29

Users may listen or save a clip. To listen to a clip, select a clip from the grid, and either
click "Listen to Selected Recording," or right-click the row in the grid and select "Listen
to Selected Recording":

To save a copy of the clip, select the desired clip and click "Save Selected Recording," or
right-click and select "Save Selected Recording". 

Please note that lack of proper permissions will prevent the user from performing these
actions.
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Options
Account Creation/Maintenance

· Auto-generate contract number - When "Yes" is selected, this option automatically
generates a contract number (Customer ID) for each new Customer Record entered. 
This number matches the serial number of the record in the database.  The automatic
number may be overridden when first entering the new Customer Record by manually
typing a contract number into the Customer ID field.

· Contact (Person/Individual) user-defined fields - The Manitou System
Administrator uses this option to create either text fields or checkbox fields.  This
option exists to add additional Central Station specific information into Customer
Records.  A Central Station may employ up to 200 user-defined fields. 

· Customer user-defined fields - This option allows System Administrators to create
additional fields or checkboxes that display on Report forms with an "Advanced"
button. This option exists to add additional Central Station specific information into
Customer Records.  A Central Station may employ up to 200 user-defined fields.

· Display customer logs in their local time -  When "Yes" is selected, this option
defaults to the Customer's local time zone regardless of Workstation time zone
settings. Selecting "Yes" also affects which time zone information shows for Reports
relating to Customer log information. The Customer's time zone displays on Reports
rather than the Monitoring Company's time zone.

· Drop down to combination search/data entry field threshold - This option
changes how the Authority, Dealer, and Branch options are selected on the Details
page of the Customer Record. When the number of records of a specific type is less
than the threshold number (default = 25), then the required record may be chosen
from a pick list. When the number of records of type exceeds the threshold number,
then Manitou provides a search function.

· Maximum number of days of log information to transfer from system account to
new customer account - Sets the maximum number of days of Customer log
information that transfers to a new Customer’s account when Transmitter information
is not on file or when a new Transmitter is added to a Customer.

· New Customer Monitoring Status - The option determines the default monitoring
status when a new Customer is added. The options are: "Always Active", "Always
Pending", "Default Active", and "Default Pending".

· Require Customer edit comments -When "Yes" is selected, this option requires the
Operator to enter comments into the Notes dialog whenever he edits and saves
changes to a Customer Record.
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· Require Operator to type password before validation - When "Yes" is selected, this
option displays a password verification dialog box whenever the Operator attempts to
edit a Customer Record.  When "No" is selected, the dialog box still displays, but is
prepopulated.

· Require password before viewing a Customer - When "Yes" is selected, the
Operator must enter a password before viewing a Customer Record.

Accounting
· Accounting company ID required - When "Yes" is selected, this option requires an

Accounting Company ID for each Customer.

· Display accounting status - When "Yes" is selected, this option displays of
accounting status data on the Alarm  form and the Customer Record.

Alarm Handling
· Alarm handling mode - This option allows you to select whether Alarm Handling

status is activated only in Alarm Handling, or in both Alarm Handling and the Alarm
Queue.

· Alarm Notifications - This option allows you to select how Operators get notified
when an Alarm arrives and what kind of Operator acknowledgement is required. The
options are "Pop-up Dialog", "Ribbon (Acknowledgement is Optional)", "Ribbon
(Acknowledgement is Optional)", "Ribbon (Acknowledge Notification Before Next
Action)", and "Ribbon (Acknowledge Notification Before Closing Alarm)".

· Alarm queue display style - The options for display style are "Detailed" and
"Summary by Master Customer".  The detailed option displays all active alarms for a
particular Monitoring Group. The summary option shows one Alarm per Master
Customer.

· Alarm queue event color scheme - The options for the color scheme are "Default",
"Age-Based", and "Event-Based". Age-based coloring utilizes the color style defined in
the Manitou CS Alarm Queue color options. Event-based coloring utilizes the Alarm
color style defined in Event Codes for each event and also an LED indicator to show
aging based on the Manitou CS Alarm Queue color options.

· All action pattern commands are optional - Selecting "Yes" allows Operators to
close Alarms without completing Action Pattern items.

· Allow Autoclient to close alarms that have "system ignored" actions - Selecting
"No" means Alarms with "system ignored" actions are deferred back to the Operator at
the time the Autoclient receives a close Action Pattern command.
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· Allow Operator validated pre-cancels - Selecting "Yes" allows Operator password
validation for pre-cancels.

 
· Allow operator validated temporary schedule changes - Selecting "Yes" allows

Operator password validation for temporary schedule changes.

· Ask for Fire Reference - Selecting "Yes" results in the system prompting an Alarm
Handling Operator for additional contact information when a Fire Authority has been
contacted.

· Ask for Medical Reference -  Selecting "Yes" results in the system prompting an
Alarm Handling Operator for additional contact information when a Medical Authority
has been contacted.

· Ask for Police Reference - Selecting "Yes" results in the system prompting an Alarm
Handling Operator for additional contact information when a Police Authority has
been contacted.

· Auto Dial Auto-Dialer - Selecting "Yes" results in the system automatically initiating
a call in the Auto-Dialer without Operator intervention.

· Auto-client continues processing alarm even if maintenance issues exist for
account - Selecting "Yes" means that maintenance issues will not cause the Autoclient
to defer an Alarm back to the Operator.

· Automatically transfer two-way audio call - Selecting "Yes" transfers two-way
audio associated with an Alarm to the Operator's extension when the Alarm is
handled.

· Call attempt count -  This option defines the minimum number of failed call attempts
before the Operator is prompted to determine if the action is complete. 

· Call List Must Contact - Selecting "Yes" results in the system requiring that call list
contacts denoted as "Must Contact" need to be actioned during Action Pattern
processing, even if the Alarm is canceled. 

· Check for audio alarms in alarm handling - If this option is turned On, the system
will check for audio alarms for the same account in alarm handling and prompt the
operator to switch to the audio alarm if one is found.

· Default PSAP Service - The option defines the default number lookup system to be
employed by PSAP.

· Disable Auto-Purge of Pre-Cancel - Selecting "Yes" prevents the system from
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purging pre-cancel Alarms when a canceled Alarm is closed and no other Alarms for
the Customer are outstanding.

· Disable prompting the user to send contact extension when auto-dialing -
Selecting "Yes" means that if a contact's phone number contains an extension, the
system will not display the usual message box prompting the Operator to send the
extension as part of the Action Pattern. 

· Duress Code Policy - The Duress Code Policy is a text-entry field. Enter the text you
want to display to an Operator after he verifies a Duress Password while processing
an Alarm.

· Force password validation if last Operator is logging off in Monitoring group -
Selecting "Yes" means the system will prompt the Operator for his password if he is
the last member of a Monitoring Group to log off.

· Maximum number of call list levels - This option defines how many nested levels of
call lists can exist when an Operator processes call list actions for an Alarm. 

· Maximum open alarms - This option defines how many active Alarm forms an
Operator can have open at any one time.

· Monitoring group overflow allowed- Selecting "Yes" enables the system to send
Alarms from Monitoring Groups other than 0 to Monitoring Group 0 if no Alarm
Handlers are active at the time the Alarm is received. This allows for part-time
monitoring of certain signals by other staff.

· Off test warning - This option defines the number of minutes after an expired On Test
event before the system warns the Operator that the Customer was recently put On
Test.

· Require comments when closing an alarm - Selecting "Yes" means the system
forces Operators to enter comments prior to closing any Alarm.

· Require resolution code when closing an alarm - Selecting "Yes" means the system
forces Operators to enter a Resolution Code prior to closing any Alarm.

· Schedule Change Requirements by Type - In the "Required" column, select the
types of Events for which the system will require a Temporary Schedule change. In the
"Warning"column, enter the maximum number of hours the Temporary Schedule
change will last. If exceeded, the system generates a warning to the Operator. The
maximum duration is 23 hours. If set to 0 hours, the system will not generate an
Operator warning.
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Note: checkboxes in the "Required" column must be selected in order for the "Extend
Schedule" functionality to be enabled for that Event Type in the Operator Workstation.

· Schedule Change to be Applied to All Schedules - Selecting "Yes" means that the
system applies an Alarm Handling quick schedule change to all other pending events
of the same type.  

· UL warning text - This option defines the UL warning text that displays to an
Operator when he handles an Alarm for a UL Customer. 

Alarm Tracking
· Alarm Tracking Cancellation -  This option defines how the cancellation of Customer

Alarm tracking occurs. Your options are "Ask", "Don't ask - cancel", and "Don't ask -
don't cancel". The "Ask" option means that the system asks the Operator if he wants to
continue tracking the Customer after he completes the last Alarm for the Customer
Record. "Don't ask - cancel" means the system cancels Customer tracking without
asking the Operator if he wants to continue it. "Don't ask - don't cancel" means the
system continues to track the Customer after the Operator handles the last Alarm and
does not ask him whether he wants to continue tracking.

· Alarm tracking mode - This option defines whether every Alarm opened by an
Operator is then tracked to that Operator. If "Automatic" is selected, every Alarm an
Operator opens tracks back to that Operator. If "Manual" is selected, the Operator
must manually select the Tracking form on the Operator Workstation while in Alarm
Handling mode, and then select the Customer Record. 

· Alarm Tracking Timeout - This option defines the number of minutes that Alarm
tracking remains active with no outstanding Alarms for the Customer.

· Limbo tracking option - This option defines the minimum Alarm priority that causes
Limbo Tracking to be released.  For example, if it is set to 3, and an Alarm is received
with priority 3, any Limbo Tracking entries that would otherwise have tracked the
Alarm are released and the Alarm becomes immediately available for handling.  When
this option is set to 0, new Alarms never cause Limbo Tracking entries to be released.

· Limbo tracking timeout - This option defines how many seconds tracking holds on
an Operator Workstation between log out and login before dropping tracking. 
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Color Options
If you click the "Tools" menu and select "Options", the following window automatically
displays:

Use this form to customize the color coding that displays in SWS. Select a foreground
and background color. When you finish modifying the color palette, click "Save".

Contact Point Device Defaults
AutoText Default Output Device Type - This option defines the default Output Device
Type for AutoText. Your choices are: "APCO-ALARM" and "MEDIAGATEWAY".

AutoText Default Script Message - This option defines the default script text for
AutoText. 

AutoText Default Service Provider Device - This option defines the default Service
Provider Device for AutoText. Your choices are: "APCO-ALARM", "AUTOSIM",
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"AUTOTEXT", and "OPENVOICE".

OpenVoice Default Output Device Type - This option defines the default Output
Device Type for OpenVoice. Your choices are: "APCO-ALARM" and "MEDIAGATEWAY".

OpenVoice Default Script Message -  This option defines the default script text for
OpenVoice.

OpenVoice Default Service Provider Device - This option defines the default Service
Provider Device for OpenVoice. Your choices are: "APCO-ALARM", "AUTOSIM",
"AUTOTEXT", and "OPENVOICE".

Country/Locale
This information is populated from the Country settings defined in the Monitoring
Company record in the Operator Workstation. It is read-only. 

General
· Customer with "Pending" status to be made "Active" upon receipt of a signal -

This option defines when to set a Customer's status to "Active" based on receiving a
signal. Your choices are: "Never", "Any Signal", and "Not On Test Signal".

· Default On-Test Time - This option defines the default duration in hours for placing a
Customer On Test.

· Monitoring Company person may access dealer accounts - Select "Yes" to allow
representatives from a Monitoring Company to access Customers assigned to Dealer
via VRT or the Web.

· On-Test Protection - The On-Test Protection feature presents a dialog message to
technicians who attempt to put an account On-Test from BoldNet or BoldNetMobile if
no open service tickets exist for the account in SedonaOffice. In order for the dialog
message associated with On-Test Protection to display, you must first enable the
option in the Manitou Supervisor Workstation.  

Perform the following steps to enable the “On-Test Protection” feature:

1. Open the Supervisor Workstation.
2. Navigate to the “Tools” menu, and select “Options” as shown in the following

screenshot:
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Result: the following form displays:

3. Expand the “General” node in the Navigation Tree as shown in the following
screenshot:



Manitou CS  Supervisor Workstation User Guide | © Copyright 2017 Bold Technologies LTD

38

4. Select the “On-Test Protection” option.
Result: the “On-Test Protection” option displays as shown in the following
screenshot:

5. Click “Edit”.
6. Select “Yes”.
7. Click “Save”.

Note: the following conditions must be met for the dialog message to display, as
described:

· The user attempting to place the account On-Test must be designated as a
“Technician” in the “Type” field on the Monitoring Company “Contact List”
form.

· The technician must be attempting to place the account On-Test from either
BoldNet or BoldNetMobile.

· The account the technician is placing On-Test must be linked to a SedonaOffice
account.

· Script Message for Maintenance Issue assignment -  This option allows you to
create a script message and to send it to a technician when a new or updated
Maintenance Issue is assigned to him. Open the Maintenance Issues section of this
document to access more information about the following topic:"Sending a Script
Message for a New Maintenance Issue".

· Statistics - Customers to display for 'top' lists - This option defines the maximum
number of Customers to display for 'top' lists of Customers with Alarms or with False
Alarms.
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· Statistics - Days used to calculate 'top' lists - This option defines the number of
days used to calculate 'top' lists of Customers with Alarms or with False Alarms.

Location/GPS
· Location Services Key - Enter the license key for Location Services here.

· Mapping Types - This option defines the type of mapping software Manitou uses for
Location Services. Your choices are: "MAPPOINT", "BOLDTRAK", "BING", and
"GOOGLE". This setting does not apply to Disaster Mode setup in the Operator
Workstation.

Output Details
· Email - From Address - Use this option to enter the return email address you want to

display on outgoing email messages. If you change this value, your changes will not
take effect until you restart the Publisher.

· Email - From Name - Use this option to enter the company name for the Central
Station you want to display on all outgoing emails.  If you change this value, your
changes will not take effect until you restart the Publisher.

· Email - Subject Includes Customer's Street Address and City - Select "Yes" to
include the Customer's Street Address and City information with the standard email
subject.

· Fax - Company Name - Use this option to enter the company name for the Central
Station you want to display on all outgoing faxes.  

· Fax - Delivery Report Address - Use this option to define the address to which you
want fax delivery confirmations sent.

· Fax - Delivery Report Type - Use this option to define the manner in which you want
fax delivery confirmations reported. Your choices are: "Email" and "MAPI".

· Fax - Department Name - Use this option to enter the department name within the
Central Station you want to display on all outgoing faxes.  

· Fax - From Name - Use this option to enter the name of the individual sender you
want to display on all outgoing faxes.  

· Pager - Company Name - Use this option to enter the Central Station name you want
to display on all pager text messages.  

· Pager - Default Message - Use this option to define the pager message you want to go
out to alpha text pagers when no other pager message applies.  
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· Publisher File Directory - Use this option to define the location on the server hard
drive where you want the Report Publisher to store its temporary files for faxing,
emailing, and publishing.

· Third Party fax driver details - Use this option to define a third-party faxing
software solution if you determine that the default faxing options do not meet your
needs. The third-party driver software documentation will provide specific details
about what information you must enter here. 

Passwords
Use the options available on this form to define the minimum complexity requirements
for passwords and account lockout rules.

When you select the Enhanced Security checkbox the following applies:

· You cannot use letter or number sequences (for example, 567 or ghi).
· You cannot use any previous passwords.
· You cannot use the user name as part of the password (for example, User1 cannot

have a password of User159).
· The password can’t contain the User ID itself.
· The User ID must be at least six characters.
· The password can’t be “password.”

Note: The Enhanced Security option is per a UL 1981 requirement.
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Purge
· Alarm activity detail to keep (days) - Use this option to define the number of days

you want the system to keep Alarm Activity details for analysis purposes.

· Database backup instructions - This informational field contains the programming
language string required to complete a proper database backup. This option is for
informational purposes only. The database backup does not actually run from this
information. This is utilized only if replication is not implemented for the Monitoring
Company. 

· Database backup time of the day -  This informational field contains the time the
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database backup is set to run. The database backup does not actually run from this
information. This is utilized only if replication is not implemented for the Monitoring
Company. 

· Number of days before purging temporary open/close schedules - This option
defines the number of days you want expired temporary Open/Close schedule entries
to remain in the system before they are purged.

· Number of hours before purging expired reminders - This option defines the
number of hours you want expired reminders to remain in the system before they are
purged.

· Number of days before purging expired temporary comments - This option
defines the number of hours you want expired temporary comments to remain in the
system before they are purged.

· Number of hours to keep completed scheduled reports - This option defines the
number of hours you want completed Scheduled Reports to remain in the system
before they are purged.

· Number of hours to keep failed reports - This option defines the number of hours
you want failed Reports to remain in the system before the system before they are
purged. We do not recommend setting this option to zero because the system will
likely purge the Reports before you have a chance to review them and determine the
cause of the failure.

· Number of hours to keep on-demand reports - This option defines the number of
hours you want On-Demand Reports to remain in the system before the system before
they are purged.

·
· Number of hours to keep previewed reports - This option defines the number of

hours you want Previewed Reports to remain in the system before the system before
they are purged.

· Number of months of customer logs to keep - This option defines the number of
calendar months you want Customer Logs to remain in the system before they are
purged. If set to zero, the Customer Logs will never purge. 

· Number of months of raw data to keep - Raw Data Logs display Receiver signals in
their raw form. This option defines the number of calendar months you want Raw
Data Logs to remain in the system before they are purged. 

· Number of months of system logs to keep - System Logs contain login and log out
information as well as results from the Report server. This option defines the number
of calendar months you want System Logs to remain in the system before they are
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purged. 
 
· Paged Contacts Expiration - This option defines the number of minutes after which

the system should purge non-responding paged contacts. The minimum value for this
option is ten minutes.

Reports
· Include primary receiver line prefix/transmitter ID with customer name -  This

option defines whether and how to display the primary Transmitter's Receiver Line
Prefix/Transmitter ID with the Customer name on selected Reports. Your choices are
"0=No", "1=Beginning", and "2=End". If you select "0", the Receiver Line Prefix and
Transmitter details will not display in your Report. If you select "1" or "2", the
Receiver Line Prefix and Transmitter details display at either the beginning or the end
of the Customer name, respectively.

· Maximum report size - This option defines the maximum number of megabytes a
Report may be before it is automatically aborted.

· Report segment size - This option defines the maximum number of megabytes a
Report may be before it is automatically separated into segments.

· Script for e-mail body text - This option defines the script the system uses for Report
e-mail body content. 

· Size, in kilobytes, at which reports will zip for email publication - Zipping a
Report reduces its size. This option defines the maximum number of kilobytes an
RTF-type Report may be before it is automatically zipped for email distribution. When
set to "0", the system will always zip Reports for emailing. When set to "-1", the system
will never zip Reports for emailing. 

· Sort order of reports - This option defines the order in which Customers display on
the Alarm Detail, Alarm Activity, and Customer Masterfile Reports when sorted by
Contract ID. Your choices are "Numeric" and "Alpha". If you select "Numeric", the
following order will display: "1", "2", "10", "Bob", "Acme", and "11Test". If you select
"Alpha" the following order will display: "1", "10", 11Test", "2", "Acme", and "Bob". 

Response
· Fast Fire - This option defines the maximum number of seconds an Operator has to

respond to a fire emergency that requires an immediate Authority response.

· Fast Other - This option defines the maximum number of seconds an Operator has to
respond to a non-fire, non-panic/social emergency that requires an immediate
Authority response.
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· Fast Panic/Social - This option defines the maximum number of seconds an Operator
has to respond to a panic/social emergency that requires an immediate Authority
response.

· Medium Fire - This option defines the maximum number of seconds an Operator has
to respond to a fire emergency that does not require an immediate Authority
response.

· Medium Other - This option defines the maximum number of seconds an Operator
has to respond to a non-fire, non-panic/social emergency that does not require an
immediate Authority response.

· Medium Panic/Social - This option defines the maximum number of seconds an
Operator has to respond to a panic/social emergency that does not require an
immediate Authority response.

Signal Processing
· Address lookup for GPS signals and alarms - If this option is set to Yes, address

lookup is performed for signals and alarms. If set to No, address lookup is performed
for alarms only.

· Auto-generate On Test and Off Test signals when a Customer goes On and Off
Test - Auto-generate On Test (*OTS – On Test Started), Off Test (*OTE – On Test
Expired), and (*OTR – On Test Removed) signals for when the customer goes On and
Off Test. The default value is No.

· Cancel and abort time limit - This option defines the maximum number of minutes
during which Alarms may be automatically canceled or aborted due to signal
processing attributes or the transmitter programming Restore command. If you want
to disable the time limit, enter "0".

· Cancellation of a CanCancel alarm can occur across different transmitters - If this
option is turned on, the cancellation of a CanCancel alarm can occur regardless of
which customer transmitter the CanCancel and following Cancel signal(s) are received
on. Along with CanCancel/Cancel, Reset Timeout is also affected in the same way by
this option. Programming that is restricted to a specific transmitter still requires that
specific transmitter to take effect. The default value is No, requiring a Cancel signal to
be received on the same transmitter as the CanCancel alarm came in on. 

· Check transmitter default event programming before dealer event
programming - If you select "Yes", the system checks default transmitter event
programming before Dealer event programming if it finds no other Customer event
programming.
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· Do not bypass duplicate event check for video or audio alarms - If you select
"Yes", the system will perform duplicate checks for Audio/Video associated Alarms.

· Dual reporting signal timeout - This option defines the maximum number of
seconds the Signal Handler will wait for the second signal before Reporting it as
missing.

· Early Close window - This option determines the maximum number of minutes prior
to a "May Close" or "May Open/Close" window that a close type signal generates an
Early Close Event instead of an Unscheduled Close Event. This applies to Customers
with the Open/Close Monitoring Service not set to "Record".

· Early Open window - This option determines the maximum number of minutes prior
to a "May Open", "May Open/Close" or "May Open/Close Once"  window that an open
type signal generates an Early Open Event instead of an Unscheduled Open Event.

· Fill caller ID 1 - If you select "Yes", the Signal Handler automatically fills the Caller ID
1 field on a Transmitter if both Caller ID1 and Caller ID 2 are empty.

· Generate alarm event upon expiration of temporary comment follow-up date - If
you selected "Yes", the system generates an Alarm Event when a temporary comment
follow-up date expires.

· Generate duplicate alarms - This option defines whether duplicate Alarms generate
a new Alarm or be logged while an identical Alarm is currently outstanding. If you
select "No", the system prevents the same Alarm from being presented to an Operator
while an identical Alarm is still outstanding.

· Generate duplicate events - This option defines whether duplicate Events generate a
new Event or be logged while an identical Event is currently outstanding. If you select
"No", the system prevents the same Event from being presented to an Operator while
an identical Event is still outstanding.

· Generate Maintenance List Items - This option defines which Maintenance List
items the Signal Handler creates for signals received without a corresponding
Monitoring Service. Your choices are "Neither Open/Close nor Test Signals", "Open/
Close Signals", "Test Signals", and "Open/Close and Test Signals".

· Ignore caller ID mismatches - If you select "Yes", the system will not force Alarms for
signals received with Call ID information that matches another Customer or does not
match the Caller ID information of the signal's Transmitter.

· Late Close window - This option defines how many minutes after a "Must Close"
window a close type signal generates a Late Close Event instead of an Unscheduled
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Close Event.

· Late Open window - This option defines how many minutes after a "Must Open"
window an open type signal generates a Late Open Event instead of an Unscheduled
Close Event.

· Log signals that are not on file - If you select "Yes", the system logs signals that
arrive for a Transmitter or Receiver Line Prefix not found within the system.

· Number of minutes to search for binary clips when trying to append them - You
use this option to enter the number of minutes you want to look for binary clips when
trying to append to them. This should not be greater than a month's time.

· Pre-cancel time-out - This option defines the number of minutes before a pre-cancel
automatically expires.

 
· Prevent duplicate video alarms from being forced to Operator - If you select

"Yes", the system prevents duplicate video Alarms from being forced to an Operator.

· Prevent the system from forcing Video and Audio associated alarms to an
Operator screen - If you select "Yes", the system prevents Video and Audio being
forced to the Operator. This allows the AutoClient to take initial action on Alarms
where possible.

· Redirect event codes for non-intelligent panels - If you select "Yes", the system
displays the Event Category column on the Zones list in Customer Maintenance and
the Redirect Code on the Event Codes form of the Supervisor Workstation. This allows
Events from non-intelligent panels to be programmed with minimal Transmitter
programming lines.

· Runaway inter-signal time - This option defines the minimum number of seconds
the system requires before determining the Customer is in runaway condition. If a
signal arrives during this timeout period of the previous signal for the same
Transmitter, the system increments the runaway count. If the signal arrives outside of
this timeout period, the runaway count is reset to 1.

· Runaway signal count - This option defines the minimum number of signals after
which the system recognizes that the Customer is in runaway mode. If you set the
runaway signal count to 0 or 1, no runaway count can be generated. The runaway
count is tallied by Transmitter, and not for the Customer as a whole.

· Track additional panel statuses - If you select "Yes", the system tracks Bypass and
Trouble statuses in addition to Unrestored Alarms. If tracked, these statuses display
on the Zone Status form of the Customer Record, in the Summary form on the
Customer status window that shows on the main Alarm form, and on the main
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Customer Address form.

· Two-trip signal timeout - This option defines the number of seconds after which the
Signal Handler considers a second or following signal to be a valid Alarm.  following
the receipt of a first round two-trip signal. The first round signal is always logged. If
the second signal does not arrive within this time period, no Alarm will generate. The
signals must be for the same Two-Trip ID, have the same Event Category, and come
from the same Transmitter.

System
· Dealer billing by monitoring service - If you select "Yes", Dealer Billing will be done by Monitoring Service rather than by Class Code.

· Dealer billing prorating - If you select "Yes", Dealer Billing charges will be prorated
based on when the services start or end. If there is no start date entered and the
service is denoted as chargeable, service begins at the time of entry. If a start date is
specified, the service begins on the specified start date.

· Dealer billing standard annual cycle - This option defines in which month the
Standard Annual Dealer Billing Cycle should begin.

· Dealer billing standard quarter cycle - This option defines in which month the
Standard Quarterly Dealer Billing Cycle should begin. 

· Dealer billing standard semi-annual cycle - This option defines in which month the
Standard Semi-Annual Dealer Billing Cycle should begin.

· Dealer billing summary billing - If you select "Yes", the system generates Dealer
Billing invoices in summary format for recurring charges.

· Do not warn if alarm arrives for deactivated customer - If you select "Yes", the
system will not notify the Operators that an Alarm arrived for a Deactivated Customer.

· DragonFly Customer Type - Specifies the type of Customer (Residential, Commercial,
and so on).

· DragonFly Key - This string can be any value and you use it for calculating the
signature to verify validity.

· DragonFly Receiver Line Prefix - This selection will determine the Receiver Line
Prefix of the Transmitter of the Customer that is to be created/updated.

· DragonFly System Monitoring Type - The Monitoring Type used for the Monitoring
Service tied to the System and is created automatically when generating a new
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DragonFly Customer.

· DragonFly Token - This string can be any value and is used for calculating the
signature to verify validity.

· DragonFly Transmitter Type - This selection will determine the Transmitter Type of
the Transmitter of the Customer that is to be created/updated.

· DragonFly Video Monitoring Type - The Monitoring Type used for the Monitoring
Service tied to a Transmitter (if the DragonFly Transmitter Type supports video).

· Last overdue signal check - This option defines the last expected Event time that the
system checked for overdue signals. Use this tool when the Overdue Checker has been
closed for any length of time. Setting this option to the current date and time prevents
the Overdue Checker from going back to the very last time it looked for overdue
signals and sending in a large quantity of Overdue Alarms. 

· Next dealer billing cycle to generate - This read-only option displays the year and
month of the next billing cycle to generate.

· PBX assistant - This option defines for which Operator types the PBX Assistant is
active to display the call control panel. Your choices are: "Central Station Operator",
"Dealer Restricted Operator", and "Branch Restricted Operator".

· PBX Assistant Auto-Ready - This option defines when an agent's availability is
automatically set to ready. Your choices are: "Never", "At Logon", and "Register Alarm
Handler".

· Resolution code group setup - This option defines the number and length of the
desired levels of Resolution Code capability. Each group's start and stop points define
the length of the group in characters. Utilizing different Resolution Code groups allows
you to better classify the nature and conclusion of an Alarm.

· Use External Browser for URLs - If you select Yes, URLs are opened by the default
browser on the workstation. If you select NO, URLs are opened in the integrated
Manitou CS Operator Workstation browser.

· Validate the resolution code is complete - If you select "Yes", the system requires
an Operator to enter a valid Resolution Code when closing an Alarm or when updating
existing data.

· Web membership database details - This read-only option displays the last known
information for the Active Web Membership Database.

· Web timeout - This option defines the number of minutes that pass before an active
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Web session times out. The maximum number of minutes is 480. If timed out, the Web
user must log in again before continuing with the session.

· Workflow functionality - If you select "Yes", you can create Workflows and Workflow
Components to use in conjunction with Action Patterns.

Version/Revision
· Client Revision (Dealer) - This is a read-only field that displays the minimum

Manitou Dealer client revision number allowed to run on the system. This is updated
by Manitou Support personnel upon each upgrade to help ensure old clients are not
attempting to run against new Application servers. 

· Client Revision (Operator) - This is a read-only field that displays the minimum
Manitou client revision number allowed to run on the system. This is updated by
Manitou Support personnel upon each upgrade to help ensure old clients are not
attempting to run against new Application servers. 

· Client Revision (Supervisor) - This is a read-only field that displays the minimum
Manitou  Supervisor Workstation client revision number allowed to run on the
system. This is updated by Manitou Support personnel upon each upgrade to help
ensure old clients are not attempting to run against new Application servers. 

· Version of the database - This is a read-only field and displays the current version of
the Manitou system. This cannot be edited from the user interface. Each new release
contains an update to the version on the database. 

Voice Recordings
These options are used to configure the interface to a voice recording system.
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Watchdog
· Number of months of Watchdog logs to keep - This option defines the number of

months before the system purges Watchdog logs.  If the Supervisor Workstation is
open, Watchdog messages do not go to the Client workstation. They will only display
in the Supervisor Workstation. 

Reprocess Tickets
The Ticket Printer module is utilized in the event of an emergency that disables Manitou
from receiving or properly displaying alarms. If such an emergency occurs, Operators
may still be able to respond to alarms and manually enter ticket details into Manitou. 

Reprocess Tickets is a function only used after the Ticket Printer module for Manitou
has been deployed. Only Manitou users who purchase the separate Ticket Printer
module have access to the Reprocess Tickets function.

Ticket Printer prints out alarms that contain the following information:

· the customer's name, address, site number, contact list, and general and duress
passwords

· the customer's alarm, monitoring, and service status
· Dealer information including standing comments
· the alarm priority number, time and date of alarm, area and zone, receiver and

transmitter ID, Point ID and Actions
· the alarm Action Pattern
· Control Panel details
· the name of the Operator handling the alarm

Once the emergency ends and the Central Station no longer needs to use Ticket Printer,
users may reprocess Ticket Printer tickets back into Manitou.

Perform the following steps to reprocess Ticket Printer tickets in the SWS:

1. Navigate to the Tools menu, and click "Reprocess Tickets".
Result: the "Reprocess tickets" window displays as shown in the following screenshot: 
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2. Click the "..." button to browse for the Ticket Printer file.
Note: the Ticket Printer file has a .tps file type and can likely be found in the Windows
System32 folder of the server where the Ticket Printer module is installed.

3. Once you have located the Ticket Printer file, select it, and click "OK".
Result: Manitou reads the Ticket Printer file and sends the received alarm signals to the
appropriate accounts. Operators should now return to handling any remaining alarm
operations as they normally would.

Forms in the Maintenance Menu
Users

Accessing the User form allows an SWS user to add, edit, or delete users from the
Manitou system. All Operators, Supervisors, System Administrators, and other staff who
require access to Manitou must be individually added to the Manitou User form. The
User form can also be used to restrict access to certain Manitou functions.  User
restrictions defined in the SWS apply to the SWS, OWS, and DWS.

Perform the following steps to access the User form:

Navigate to the Maintenance screen, and click "Users".
Result: the User form displays as shown in the following screenshot:
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Adding a New User
Perform the following steps to add a new user to Manitou:
Note: to add a new user, you must have Supervisor or Administrator access to the
Manitou system.

1. Navigate to the Maintenance screen, and click "Users".
Result: the User form displays as shown in the following screenshot:
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2. Click "Edit", and then click "Add".
Result: the "Add User" window displays as shown in the following screenshot:

3. In the "ID:" field, enter a username. 
Note: the username can be up to 12 characters in length. The username is the name the
new user will enter when logging into Manitou. 
4. In the "Name:" field, enter the first and last name of the new user.
Note: the name can be up to 35 characters in length.
5. Click "OK".
Result: the "Add User" window closes and the system returns the user to the "User"
form. 
6. If you want, enter an email address or telephone number for the new user in the

"Contact Point:" field.
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7. If you want, enter a telephone extension number into the "Extension:" field.
8. Enter the user's password information into the "Password:" field.
Note: an SWS user's password can be up to 28 characters and can contain letters of
either case, numbers, and special characters.
9. Reenter the same password into the "Confirm Password:" field.
Note: the "Password:" and "Confirm Password:" fields must be identical at the time you
save changes to the form, or an error message displays.
10. If you want, select a password change interval from the corresponding dropdown

menu.
Note: selecting this option forces a user to select a new password at the interval you set.
11. If you want, select the "Change at next logon:" checkbox.
Note: selecting this option encourages password secrecy because it forces the user to
quickly change the temporary password assigned by IT staff.
12. If you want, select the "Locked Until" checkbox and select a date and time for the

user's account to reopen.
Note: selecting this option allows the person adding a newly hired user to block the new
hire's Manitou access until his official start date.
13.If the new user is associated with a Dealer, select the Dealer from the "Dealer"

dropdown menu in the "Security Restrictions" portion of the form.
Result: the default user Security Restrictions for the Dealer prepopulate the "Access:"
and "Alarm Handling:" fields.
Note: you can override these Dealer default settings by manually selecting another
Access or Alarm Handling option.
13. If the user is associated with a Branch, select the Branch from the "Branch"

dropdown menu.
Result: the default user Security Restrictions for the Branch prepopulate the "Access:"
and "Alarm Handling:" fields.
Note: you can override these Branch default settings by manually selecting another
Access or Alarm Handling option.
14. Enter an Access Level in the "Accounting Access:" field.
Note: the three options for this field are: "User Group's Access", "Own ID/Password",
and "Not Allowed".
15. Select a Priority Level for alarms your new user can handle. 
16. If you want your new user to have instant messaging capabilities, select the "Allow

IM" checkbox.
Note: IM is an instant messenger service available to logged on users.  Messages can be
sent to individuals, groups, or all users currently logged in to the system. Additionally,
messages can be set to display across the Status Bar Watchdog messages. 
17. Select a Locale for your new user from the "Locale:" dropdown menu. 
Note: a Locale is a collection of parameters that affect how information is presented
within a particular group of users. Generally, users from different Locales can be
distinguished from each other on the basis of location and language. Locale settings can
also determine things such as number formats, date and time formats, and calendar
systems. 
18. Select a Country for your new user from the "Country:" menu.
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Note: the Country designation can affect formats for addresses, telephone numbers, and
calendar systems. 

User Groups
Manitou allows a user to configure a group of users at one time using the User Groups
function.  The User Groups form includes details about security levels and the amount of
access members of a designated User Group will have in Manitou. User restrictions
defined in the SWS apply to the SWS, OWS, and DWS.

Once a User Group has been configured, individual users must be assigned to the group.
Every Manitou User must belong to a User Group. 

Adding a New User Group
Because each User Group has already had its specific Manitou access parameters
defined, and because many User Groups have already been added to Manitou, it is not
likely that a user would need to create a new User Group. Please review the access
parameters for each existing User Group before creating a new one.

Perform the following steps to add a new User Group:

1. Navigate to the Maintenance menu, and select "User Groups".
Result: the User Group form displays as shown in the following screenshot:
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2. Click "Edit", and then click "Add".
Result: the "Add User Group" window displays as shown in the following screenshot:

3. Enter a description into the "Description:" field, and click "OK".
Result: the "Add User Group" window closes, and your new User Group displays as the
currently selected item on the User Groups form.
4. If the new User Group should be associated with a Dealer, select the Dealer from the

"Dealer" dropdown menu in the "Security Restrictions" portion of the form.
Result: the default user Security Restrictions for the Dealer prepopulate the "Access:"
and "Alarm Handling:" fields.
Note: you can override these Dealer default settings by manually selecting another
Access or Alarm Handling option.
5. If the new User Group should be associated with a Branch, select the Branch from the
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"Branch" dropdown menu.
Result: the default user Security Restrictions for the Branch prepopulate the "Access:"
and "Alarm Handling:" fields.
Note: you can override these Branch default settings by manually selecting another
Access or Alarm Handling option.
6. If you want your new User Group to have access to Accounts, select the "..." button to

the right of the "Accounts User ID:" field.
Result: the "Account System User IDs" window displays as shown in the following
screenshot: 

7. Select an Accounting Group and enter the password into the "Password:" and
"Confirm password:" fields, and click "OK".

Result: the "Accounts System User Ids" window closes and the system returns the user
to the "User Groups" form.
8. Select a Permission Profile from the "Permission Profile:" field. 
9. If you want, select the "Give audio beep if alarms available" option in the "Options"

portion of the form.
Note: selecting this option enables an audible sound for alarm handling for the User
Group.
10. If you want, select the "Can choose own password" option.
Note:  selecting this option enables users from this User Group to change their
password at will.
11. Enter the Maximum logged on time into the appropriate field.
Note: this option allows a user to set the maximum duration of a login session for the
User Group. After this time elapses, the user will be automatically logged off unless he
manually extends the session by three minutes at a time. If the user enters 0 into this
field, members of the User Group will never be automatically logged off. 
12. Enter the Maximum inactivity time into the appropriate field.
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Note: this option allows a user to set the maximum duration that a member of this User
Group can spend in the alarm processing mode without actively processing the alarm.
When the programmed time elapses, the system automatically defers the alarm. If the
user enters 0 into this field, members of the User Group will never be automatically
logged off.
13. Enter the Maximum alarm inactivity time into the appropriate field.
Note: this option causes the system to lock the Workstation if the user exceeds the
defined period of inactivity. If locking occurs, the system requires the user to enter his
password to unlock the Workstation. If the user enters 0 into this field, members of the
User Group will never be automatically logged off. 
14. Enter the Maximum job on test time into the appropriate field.
Note: This option sets the maximum duration that a member of this User Group may
place a Customer On Test. 
15. If you want, select the"Exit alarm handling on timeout:" checkbox.
Note: selecting this option causes the system to force an exit from alarm handling for
users of this User Group when a timeout occurs.  
16. Select the appropriate call types for your User Group to accept in the "Accept Call

Types:" checkbox field.
Note: selecting these checkboxes allows the user to designate the actions in which users
from this User Group can engage when handling Customer phone calls. For example, if
members of this User Group are allowed to cancel alarms based on Customer calls,
check the "Cancel Alarm" checkbox. 
17. Click "Save".

Workstations
The Workstations function is used to define which computers, users, and Monitoring
Groups can connect to the Manitou system.  

Access Levels are used to define the level of access each Workstation has to the Manitou
system. The following table provides an overview of Workstation Access Levels:

Access Level Description

Pending This level is automatically set when a new
Workstation is detected requesting access
to the Manitou system.

Unapproved The Workstation has been added to the
system, but has not yet been approved for
use and cannot therefore connect to the
database.

Non-Protected Area The Workstation can connect to Manitou
but may only access non-secure data.

Protected Area The Workstation has, potentially,
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complete access to the Manitou database.

Disabled Access to Manitou is temporarily blocked,
but not yet removed

Before utilizing the Workstation function, the Workstation must first be physically
connected to the Manitou network. A user must also have the Manitou client installed on
his Workstation. Once these items are complete, users can add a Workstation.

Adding a New Workstation
Perform the following steps to add a new Workstation to Manitou:

1. Navigate to the Maintenance menu, and then click "Workstations".
Result: the Workstations form displays as shown in the following screenshot:

2. Click "Edit".
3. Select the Workstation you want to add by clicking its row to the left of the "Name"

column.
Note: Workstations that have not yet been added display green.
Result: the row containing the Workstation you selected displays highlighted as shown

in the following screenshot:
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4. Click in the row of the Workstation you want to add at the far right of the "Security
Level" column.

Result: a dropdown menu displays as shown in the following screenshot:

5. Select the "Protected Area" row and click "Save". 
6. If you want to assign the Workstation to a physical Workstation Group, select the

appropriate group using the pick list in the "WS Grp" field. 
7. If you want to assign the Workstation to a Monitoring Group, select the appropriate

group using the pick list in the "Mon. Grp" field. 
8. Click "Save" .
Result: The newly added Workstation is now capable of connecting to the Manitou
database.

Disabling a Workstation
Perform the following steps to disable a Workstation that has already been added to
Manitou:

1. Navigate to the Maintenance menu, and then click "Workstations".
Result: the Workstations form displays as shown in the following screenshot:
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2. Click "Edit".
3. Select the Workstation you want to disable by clicking its row to the left of the

"Name" column.
Result: the row containing the Workstation you selected displays highlighted as shown
in the following screenshot:

4. Click in the row of the Workstation you want to add at the far right of the "Security
Level" column.

Result: a dropdown menu displays as shown in the following screenshot:
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5. Select "Disabled".
6. Click "Save". 
Result: the Workstation you selected to disable now displays as such in the "Security
Level:" column.

Event Codes
Event Codes are included with the signals Manitou receives from transmitters located at
remote sites. After Manitou receives an Event Code, it uses Signal Processing Attributes
to translate the signal information and gather information about the causal event. 

Manitou allows users to modify its programmed pattern for dealing with the events and
alarms connected to these codes. 

Adding an Event Code
Perform the following steps to add an Event Code:

1. Navigate to the Maintenance menu and click "Events", and then click "Event Codes".
Result: the "Event Codes" form displays as shown in the following screenshot:

Note: all the Event Codes already defined in Manitou display in the scroll down menu on
the left side of the form. Because so many Event Codes are already defined in Manitou,
you should confirm that the event for which you want to add a code does not already
exist before you add a new one.
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2. Click "Edit", and then click "Add". 
Result: the "Add Event Code" box displays as shown in the following screenshot: 

3. Enter the name of your new Event Code into the "Event Code:" field. 
Note: Event Codes must be two or three characters in length and must not duplicate

existing codes. 
4. Enter a description of the specific event the Event Code represents in the

"Description:" field, and click "OK". 
Result: the new Event Code displays in the list of those already defined in Manitou, and

displays on the form as the currently selected item.
5. Select a category to assign to your new Event Code from the "Event Category:"

dropdown menu.
Note: Event Categories are broad groups of Event Codes (for e.g., Fire or Burglary).
6. Select a Redirect Code from the "Redirect Code:" dropdown menu. 
7. Select a Zone State Code from the "Zone State Code" dropdown menu. 
8. Enter the priority level you want to assign to your new alarm in the "Priority:" field. 
Note: Manitou rates alarm severity by assigning numbers 1 through 10 (with 1 being of

highest priority, and 10 being the lowest).
9. If you want to assign your new Event Code a Global Action Pattern, select one from

the "Default Action Pattern:" dropdown menu.
10. If your new "Event Code" is an alarm, select "Yes" in the "Alarm:" field. 
Note: you can also indicate whether the alarm is Residential or Commercial.
11. If you want, enter general instructions for your new Event Code into the "Generic

Signal Instructions:" field.
Note: any text entered into the "Generic Signal Instructions:" field automatically

displays to users as part of the alarm handling action pattern.
12. If you want, click the "..." button to the right of the "Signal Processing Attributes:"

field.
Result: the "Signal Processing Attributes" window displays as shown in the following

screenshot:
Note: Signal Processing Attributes are also know as Soft Commands.
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11. Select all the Signal Processing Attributes that apply to your new Event Code, and
click "OK". 

Note: Every attribute you choose to associate with your new Event Code helps Manitou
better translate and understand the received signal.

12. If you want, click the "..." button to the right of the "Customer Attributes:" field.
Result: the "Customer Attributes" window displays as shown in the following

screenshot:
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13. Select all the Customer Attributes that apply to your new Event Code, and click "OK".
Note: Customer Attributes denote certain customer characteristics. Mainly, they are

used by management to classify events for report filtering. 
14. Select the number of seconds an alarm can age before it changes to Warning Level

status. 
15. Select the number of seconds an alarm can age before it changes to a Danger Level

status.
16. Select the number of seconds an actioned alarm can age before it changes to

Warning Level status.
17. Select the number of seconds an actioned alarm can age before it changes to a

Danger Level status.
18. Confirm that your selections on the Event Codes form are correct, and then click "

Save".

Removing an Event Code
Perform the following steps to remove an already defined Event Code from Manitou:

1. Navigate to the Maintenance menu and click "Events", and then "Event Codes".
Result: the "Event Codes" form displays as shown in the following screenshot:

Note: all the Event Codes already defined in Manitou display in the scroll down menu on
the left side of the form.
2. Click "Edit".
3. Select the Event Code you want to remove from the scroll down menu, and click "
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Remove".
Result: a window displays and asks you to confirm the removal as shown in the
following screenshot:

4.  Click "Yes", and then click "Save".

Event Categories
Event Categories are broad groups of  Event Codes. 

The Event Categories form displays all the Event Categories defined within Manitou, and
allows a user to add, edit, or delete them. 

Adding an Event Category
1. Navigate to the Maintenance menu and click "Events", and then click "Event

Categories".
Result: the "Event Categories" form displays as shown in the following screenshot:
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2. Click "Edit", and then click "Add".
Result: the "Add Event Category" window displays:

3. In the "Event Category:" field, enter the name of your new Event Category.
4. In the "Description:" field, enter a brief description of your new Event Category, and

click "OK".
Result: your new Event Category now displays in the Event Categories list, and displays
on the form as the currently selected item.
5. Select the Monitoring Group that will handle alarms for your new Event Category

from the "Monitoring Group:" dropdown menu. 
6. If you want, enter an Analysis Code in the "Analysis Code:" field.
Note: The Analysis Code is an identifying feature used for accounting and billing
purposes.
7. If you want, select a Default Action Pattern from the "Default Action Pattern:"

dropdown menu.
Note: the Default Action Pattern is the Global Action Pattern that an Operator uses for
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alarm handling, unless a Dealer or Customer Action Pattern has been defined.
8. If you want, select the "Operators cancel from queue allowed" checkbox.
Note: This option gives an Operator the ability to cancel an alarm in your new Event
Category while it is still in the Alarm Queue. 
9. If you want, select the "Allow close if no actions defined" checkbox. 
Note: This option gives an Operator the ability to close an alarm of your new Event
Category.
10. If you want, enter general instructions for your new Event Category into the "Default

Help for Event Category:" field.
Note: any text entered into the "Default Help for Event Category:" field automatically

displays to users as part of the alarm handling action pattern.
11. If you want, click the "..." button to the right of the "Signal Processing:" field.
Result: the "Signal Processing Attributes" window displays as shown in the following

screenshot:
Note: Signal Processing Attributes are also know as Soft Commands.

12. Select all the Signal Processing Attributes that you want to apply to your new Event
Category, and click "OK". 

Note: Every attribute you choose to associate with your new Event Code helps Manitou
better translate and understand the received signal.

13. If you want, click the "..." button to the right of the "Client Processing:" field.
Result: the "Customer Attributes" window displays as shown in the following

screenshot:
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14. Select all the Customer Attributes that apply to your new Event Category, and click "
OK".

Note: Customer Attributes denote certain Customer characteristics. Mainly, they are
used by management to classify events for report filtering. 

Removing an Event Category
Perform the following steps to remove an already defined Event Category from Manitou:

1. Navigate to the Maintenance menu and click "Events", and then click "Event
Categories".

Result: the "Event Categories" form displays as shown in the following screenshot:
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Note: all the Event Categories already defined in Manitou display in the scroll down
menu on the left side of the form.
2. Click "Edit".
3. Select the Event Category you want to remove from the scroll down menu, and click "

Remove".
Result: the Event Category you selected no longer displays in the list.

Event Maps
The Event Maps function provides a full list of Event Codes for each external alarm and
identifies the Manitou internal code. The signal is then translated prior to processing.
When signals are transmitted to Receivers, they exist in a standard intelligent or
non-intelligent format, and are translated within Manitou so that they may be handled
by Manitou users.  

The system interprets these signals by searching for mapping in the following
hierarchical order:  

· Customer Programming Level (the most specific)
· Transmitter Level
· Dealer Level
· Event Categories Level 
· Event Codes Level  

Note: The Event Categories and Event Code levels of Event Mapping are the most
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general, and the system will only check them if no other mapping exists.  

The default Event Maps are grouped based on common formats, such as SIA, RAD, or
OZVISION. Depending on the drivers installed, other formats may be included in the
initial system configuration. Users can add additional Event Maps to the system, or
modify the translation of existing Event Maps. 

Adding a New Event Map
Periodically, Transmitter Protocols receive new updates, and it becomes necessary to
add a new Event Map for such codes. 

Perform the following steps to add a new Event Map:

1. Navigate to the Maintenance menu and click Events, and then click "Event Maps".
Result: the Event Map form displays as shown in the following screenshot:

2. Select the appropriate Protocol Format from the "Protocol Format:" dropdown menu. 
Note: The default Event Maps are grouped based on common formats, such as SIA, RAD,

or OZVISION.
3. If the Event Map you are adding is for a specific Dealer, select the Dealer from the

"Dealer:" dropdown menu. 
4. Click "Edit". 
Result: A blank row displays at the end of the list. 
5. Enter a Message into the "Message" column. 
Note: your Message can be up to ten characters in length. Do not include spaces before

the Message text. Otherwise, the Signal Handler will not read the Event Map. 
6. Enter the Decode Qualifier into the appropriate column. 
Note: Unless otherwise specified by Manitou support, enter "0" for the Decode

Qualifier. 
7. Click in the right portion of the "Event Code" column.
Result: a dropdown menu icon displays as shown in the following screenshot:
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8. Click the arrow, and select the Event for which you are adding the Event Map.
9. If you want, enter a description for your new Event Map in the "Description:" field. 
10. Confirm that your information is correct, and click "Save". 
Result: your new Event Map now displays in the list.

Event Map Filter Options
The Event Maps screen contains the following two filtering functions with which a user
can filter the Event Maps list: 

· Protocol Format: allows the user to filter the list by incoming Protocol Format. The
items in this list are all Event Codes already in the Manitou system. 

· Dealer: allows the user to filter the list by a specific Dealer. 

Removing an Event Map
1. Navigate to the Maintenance menu and click Events, and then click "Event Maps".
Result: the Event Map form displays as shown in the following screenshot:

2. To access the Event Map you want to delete, select the desired Protocol Format from
the dropdown menu, or filter the list by Dealer. 
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3. Select the Event Map you want to remove from the Event Maps list.
4. Click to the left of the Message column, and highlight the Event Map you want to

delete. 
5. Click "Delete" on your keyboard.
Result: the system removes the Event Map you selected from the list. 
6. Click "Save". 

Country
The Country function allows a user to define country-specific address attributes in
Manitou. Such country-specific attributes include:

· fields for street, city, and Zip Codes 
· formats for telephone numbers, dates, and times 
· formats for postal addresses on printed pages
· formats for counties and states, and their associated abbreviations

Although the Country Setup may be configured during the Manitou installation process,
users may still find it necessary to add or edit listings. 

Modifying Format Details for an Existing Country
From the Country Setup screen, users can define how addresses display in the Customer
Record. For example, one country's address layout might include only a two-character
regional abbreviation (for e.g., like a two-digit state abbreviation in the U.S.).  Another
country's address layout might not allow for abbreviations.  Also, while the United
States uses a numeric Zip Code, other countries use a Postal Code that can include
letters and numbers.

Perform the following steps to edit the country attributes for a country already defined
in Manitou:

1. Navigate to the Maintenance menu, and click "Setup", and then click "Country".
Result: the "Country Setup" form displays as shown in the following screen shot:
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2. Select the existing country you want to edit from the "Country:" dropdown menu.
Result: the current format for your country's attributes displays in the "Country Setup
for View and Edit Modes" window.
3. Click "Edit". 
4. If you want the two setup windows to have identical layouts, select the "Sync Layouts

" checkbox located below the lower setup window. 
5. Click "Add Label/Textbox". 
Result: the following window displays:
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6. Select the type of new label and textbox you want to add.
Result: the new label and textbox you selected displays in the setup window as shown
in the following screenshot:

Note: you can now drag and drop the labels and textboxes you created anywhere within
the setup window.
7. If you want to copy the layout of the top window into the bottom window, click "Copy

Layout".
8. If you want to remove all the labels and textboxes from both windows, click "Clear

Layout".
9. Repeat steps 5 and 6 to add as many labels and textboxes as you need, and then drag

and drop them within the setup window.



Manitou CS  Supervisor Workstation User Guide | © Copyright 2017 Bold Technologies LTD

76

10. Once you have made all the changes you want, click "Save". 

Adding a New Country
Perform the following steps to add a country that does not yet exist in Manitou, and to
define its formatting:

1. Navigate to the Maintenance menu and click "Setup", and then click "Country".
Result: the "Country Setup" form displays as shown in the following screenshot:
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2. Click "New".
Result: the "Add Country" window displays as shown in the following screenshot:

3. Enter the numeric telephone country code for your new country in the "Country
Code:" field. 

Note: The telephone country code must be either two or three numbers. If you do not
know the telephone code for your country, look it up on the internet. 
4. Enter the country name in the "Country:" field.
5. Select the country with the format most like your new country from the "Based On:"

dropdown menu, and click "OK".
Result: the new country you are adding now displays as the currently selected country
in the "Country" dropdown menu.
Note: if you do not know which country's format is most similar to the new country you
are adding, click "Cancel" on the "Add Country" dropdown menu and then click "View".
Next, open the "Country:" dropdown menu and review existing layouts for the countries
already defined in Manitou. 
6. If you want to add a new label and textbox to your new country's formatting, follow

steps 3-8 of the instructions for "Modifying the Details for an Existing Country"
displayed above. 

7. Once you have made all the changes you want, click "Save". 
8. Result: the country you added now displays as a newly created country in the

"Country:" dropdown menu.

Editing an Existing Country's Mail Address Layout
Perform the following steps to modify an existing country's Mail Address Layout:

1. Navigate to the Maintenance menu, and click "Setup", and then click "Country".
Result: the "Country Setup" form displays as shown in the following screenshot:
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2. Select the "Mail Addr Layout" option from the Country Jump To: menu as shown in
the following screen shot:
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Result: the Mail Address Layout screen displays as shown in the following screenshot:

3. Select the existing Manitou country whose Mail Address Layout you want to edit from
the "Country:" dropdown menu.

Result: the country you want to edit now displays in the "Country:" dropdown menu.
4. If you want to edit the details of how your label displays on the page, modify the

values entered in the "Top:", "Left:", or "Width" fields in the "Label Location on Page"
section.

Result: the label location changes on the preview display.
5. If you want to edit which label fields display and the text that displays in those label

fields, modify entries in the "Label Contents" section.
Result: your modifications show in the preview display.
6. If you want to return to the label location or contents that displayed before you made

changes, click "Restore Defaults".
Result: the preview displays show the label location and contents as they existed prior
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to your modifications.
7. When you have made all the changes you want, click "Save".  

Adding or Modifying a State or Region
Perform the following steps to add or modify a state or region:

1. Navigate to the Maintenance menu, and click "Setup", and then click "Country".
Result: the "Country Setup" form displays as shown in the following screenshot:
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2. Select the "Regions/States" option from the Country Jump To: menu as shown in the
following screenshot:

Result: the Regions/States screen displays as shown in the following screenshot:

3. Click "Edit".
Result: a new row displays at the bottom of the list.
4. If you want to add a new region or state abbreviation, navigate to the newly created

row, and enter the region or state name and the abbreviation you want into their
appropriate columns.
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5. If you want to modify an existing entry, navigate to it, and make the necessary
changes.

6. Click "Save".
Result: either your new entry or your modified entry now displays in the list.

Adding or Modifying a City
Perform the following steps to add or modify a city:

1. Navigate to the Maintenance menu, and click "Setup", and then click "Country".
Result: the "Country Setup" form displays as shown in the following screenshot:
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2. Select the "Cities" option from the Country Jump To: menu as shown in the following
screen shot:
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Result: the following window displays:

3. Select the country in which you want to add a city from the "Country:" dropdown
menu.

Note: if the country you want does not display in the menu, follow the instructions for "
Adding a New Country".
4. Select the state or region in which you want to add a new city from the "State/

Region:" dropdown menu.
Note: if the state or region you want does not display in the menu, follow the
instructions for "Adding or Modifying a State or Region".
5. Click "Edit", and then click "Add".
Result: the "Add City" window displays as shown in the following screenshot:

6. Enter a city into the "Name:" field, and click "OK".
Result: the city you added now displays in the list for state or region in which you
created it.
7. Click "Save".

Adding a Post Code
Perform the following steps to add a post code:
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1. Navigate to the Maintenance menu and click "Setup", and then click "Country".
Result: the "Country Setup" form displays as shown in the following screenshot:

2. Select the "Post Codes" option from the Country Jump To: menu as shown in the
following screen shot:
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Result: the following screen displays:

3. Select the country in which you want to add a Post Code from the "Country:"
dropdown menu.

Note: if the country you want does not display in the menu, follow the instructions for "
Adding a New Country".
4. Select the state or region in which you want to add a Post Code from the "State/

Region:" dropdown menu.
Note: if the state or region you want does not display in the menu, follow the
instructions for "Adding or Modifying a State or Region".
5. Select a city from the "Cities:" list
Note: if the city you want does not display in the menu, follow the instructions for "
Adding or Modifying a City".
6. Click "Edit", and then click "Add".
Result: the "Add Post Code" window displays as shown in the following screenshot:

7. Enter the Post Code you want to add, and click "OK".
Result: the "Edit City Selections" window displays as shown in the following screenshot:
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8. Select the cities you want to associate with your new Post Code, and click "OK".
Result: the new Post Code you just added now displays in the list.
9. If you want to associate a specific street with an existing Post Code, select the Post

Code from the list, and enter a street into the "Street:" field.
10. Click "Save".

Configure Country Options
The Country Options Tab contains fields that allow for configuration of phone numbers,
date, and time formats and whether or not there is a UL Policy in this country.  At the
bottom of this tab, it may be indicated whether or not an abbreviation of the regions or
states may be used and whether or not new regions or states may be added during data
entry.

1. Navigate to the Maintenance menu and click "Setup", and then click "Country".
Result: the "Country Setup" form displays as shown in the following screenshot:
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2. Select "Country Options" from the Country Jump To: menu as shown in the following
screen shot:
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Result: the following window displays:

3. Select the country you want to modify from the "Country:" dropdown menu, and click
"Edit".

4. Edit the following fields to reflect the formats in the country you are modifying:

· Telephone Prefix: if you are calling outside national borders, you must enter a one,
two, or three digit code that represents the country you are calling. Enter your
country's telephone country code into this field.

· Telephone Picture: this field defines the standard phone number format for your
country. Enter your country's standard phone number format into this field.

· Date Picture: this field defines the standard format in which dates are displayed in
your country. Enter your country's standard Date format into this field.

· Date/Time Picture: this field defines your country's standard format for Date/Time
display. Enter your country's standard Date/Time format into this field.

· Time Picture: this field defines the standard format for your country's Time display.
Enter your country's standard Time format into this field. 
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· 12 Hour Time Format: this option allows you to select whether your country displays
time in the 12 hour, a.m./p.m. format or a 24 hour format. Check this option if your
country uses the 12 hour a.m./p.m. format.

· UL Policy Licensed: this option allows you to select whether your country is subject
to UL requirements. Check this option if your country is a UL member country.

· Show abbreviation field: this option allows you to define whether Manitou displays a
Region or State abbreviation code, and whether the abbreviation code displays in the
first or second column.

· Allow new regions/states on data entry form: this option allows you to define
whether or not Manitou blocks new Regions and States when a user tries to add one.

· Show warning if new post code entered on data entry form: this option allows you to
enable a pop up window display in the event someone enters an unknown post code
on the data entry form.

5. When you finish making the changes you want, click "Save". 

Locales
A Locale is a collection of parameters that affect how information is presented within a
particular group of users. Generally, users from different Locales can be distinguished
from each other on the basis of location and language. Locale settings can also
determine things such as number formats, date and time formats, and calendar systems.

Locales for each system will have been added and configured prior to Manitou
installation, but a user might sometimes need to modify Locale settings.  

Adding a New Locale
Perform the following steps to add a new Locale to the Locales form:

1. Navigate to the Maintenance menu and click "Setup", and then click "Locales".
Result: the "Locales" form displays as shown in the following screenshot:

2. Click "Edit", and then click "Add"
Result: the "Add Locale" window displays as shown in the following screenshot:
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3. Enter a code for the Locale you are adding in the "Locale:" field.
Note: the Locale code cannot exceed five characters in length.
4. Enter a description of your new Locale code in the "Description:" field, and click "OK".
Result: the Locale code you added now displays in the list. 

Removing an Existing Locale
Perform the following steps to remove an existing Locale:

1. Navigate to the Maintenance menu and click "Setup", and then click "Locales".
Result: the "Locales" form displays as shown in the following screenshot:

2. Select the Locale you want to remove from the list.
3. Click "Edit", and then click "Remove"
Result: the system removes the Locale you selected form the list.

Time Zones
Time Zones include date and time related parameters that determine how Manitou
measures time. Information regarding Daylight Savings is particularly important to
Manitou because whether or not people practice Daylight Savings varies from region to
region.

Adding and Configuring a New Time Zone
All of the Time Zones that display in the list have already been programmed into
Manitou. Please confirm that the Time Zone you want to add does not already exist
before you proceed with these instructions.
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Perform the following steps to add a new Time Zone:

1. Navigate to the Maintenance menu and click "Setup", and then click "Time Zones".
Result: the "Time Zone" form displays as shown in the following screenshot:

2. Click "Edit", and then click "Add".
Result: the "Add Time Zone" window displays as shown in the following screenshot:

3. Enter the name for your new Time Zone in the "Time Zone:" field
Note: the format for this field is: "GMT (+/-)00:00". GMT is an acronym for Greenwich
Mean Time, and this field represents the deviation from it.
4. Enter a description for your new Time Zone into the "Description:" field.
Note: the format for this field is: ND (if Time Zone does not have Daylight Savings)
major city or region within Time Zone. For example, if a user wanted to add a new Time
Zone for Israel, he would enter the description:   "ND Jerusalem".
5. Enter a GMT deviation in the "Offset from GMT" field.
6. Note: the user can enter a negative deviation. This number should match the number

you entered in the "Time Zone:" field.
7. Click "OK".
8. Result: your newly created Time Zone now displays on the list and as currently

selected item on the Time Zone form as shown in the following screenshot:
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9. If you do not want your new Time Zone to practice Daylight Saving, click "Save", and
do not continue with steps 7-14.

10. If you want your new Time Zone to practice Daylight Saving, select the "DS"
checkbox, and enter "60" in the "Adjust" column.

11. In the "Begin" column, enter either "First" or "Last" depending on the day you want
Daylight Saving to begin.

Note: these entries correspond to either the first time the selected day of the week
occurs during the month, or the last time.
12. Click at the right edge of the "DOW" column until a dropdown menu displays. Select

the day of the week on which you want Daylight Saving to begin.
13. Click at the right edge of the "Month" column until a dropdown menu displays. Select

the month in which you want Daylight Saving to begin.
14. In the "Time" column enter the time you want Daylight Saving to begin.
15. In the "On/After" column, enter the first day of the month on which Daylight Saving

can begin.
16. Complete the "End" columns in the same manner as you did the "Begin" columns.
17. In the "Effective Date" column, enter  "01/01/1900", and click "Save".
Note: Time Zone Daylight Saving Effective Dates are always "01/01/1900" with
exception of a few Time Zones that recently changed their Daylight Saving practices.
Review the following screenshot:
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People in the Eastern Time Zone for the U.S. and Canada changed their Daylight Saving
practices in 2007. Until that year, people began Daylight Savings in April and ended in
October. After 2007, people in the Eastern Time Zone begin in March and end in
November.

Configuration
The Configuration screen displays the configuration for various Manitou-related servers
and applications. 

Manitou Configuration will be defined on your system prior to installation, but users
may find it necessary to modify it themselves at a later time.

Adding a Server to Manitou
Perform the following steps to add a server to Manitou:

1. Navigate to the Maintenance menu, and click "Setup", then click "Configuration".
Result: the "Configuration" form displays as shown in the following screenshot:

2. Click "Edit".
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3. Select the server icon in the Navigation Window, and click "Add". 
Result: the "Add Server" window displays as shown in the following screenshot:

4. Enter the server name into the "Machine Name:" field.
5. Enter the IP addresses into the appropriate fields.
Note: if you do not already have it, obtain this information from the Central Station's IT
personnel.
6. If your new server needs to be linked to an existing device, select it from the "Existing

Device:" dropdown menu, and click "OK".
Result: your new server now displays in the list. 

Receivers
Before you can add a Receiver to the Manitou system, you must connect and configure at
least one FEP (Front End Processor).  FEPs receive signal data from Receivers and
forward it to Manitou. When an FEP or Receiver is physically connected to Manitou, you
must configure at least one Receiver Line Prefix. All Manitou systems require at least
one Receiver Line Prefix.

Receiver Line Prefixes allow Manitou to accomplish the following:

· collect signal data from multiple Customer Transmitters and group it in a logical
manner

· collect data from primary and secondary Receivers and FEPs
· provide a means of supporting duplicate Transmitter numbers within a system

Adding an FEP
Perform the following steps to add an FEP to Manitou:

1. Navigate to the Maintenance menu, and click "Setup", and then click "Receivers".
Result: the "Receivers" form displays as shown in the following screenshot:
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2. Click "Edit".
3. Click the "System" icon in the list, and then click "Add".
Result: the "Add FEP" window displays as shown in the following screenshot:

4. Enter a description into the appropriate field.
5. Select a starting number from the "Starting Number:" dropdown menu.
Note: the Starting Number is preselected based on the number of FEPs already
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configured. 
6. Select the number of FEPs you want to add from the dropdown menu, and click "OK".
Result: your new FEP now displays in the System list.

Adding a Receiver
A Central Station may have any number of Receivers based on the size of their business
and the number of accounts being managed.  Receivers are connected physically to the
network based on manufacturer specifications.  The Receiver is then connected either to
the FEP directly or to a Digibox which acts as a hub for multiple Receivers and relays the
signals to the FEP.

1. Navigate to the Maintenance menu, and click "Setup", and then click "Receivers".
Result: the "Receivers" form displays as shown in the following screenshot:

2. Click "Edit".
3. Click on an FEP icon from the FEP list, and then click "Add". 
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Result: the "Add Receiver" window displays as shown in the following screenshot:

4. Select a Receiver Type from the dropdown menu.  
5. Enter a description for your new Receiver into the "Description:" field.
6. Select a starting number from the "Starting Number:" dropdown menu.
Note: the Starting Number is preselected based on the number of Receivers already
configured. 
7. Select the number of Receivers you want to add from the dropdown menu, and click "

OK".
Result: your new Receiver now displays in the System list.

Adding and Grouping Receiver Lines
Each Receiver needs 2-8 Receiver Lines to receive signals (depending on type). Receiver
Line configuration refers to the physical connections on a Receiver. Receiver Line
Prefixes are assigned numbers used to identify a particular set of Customer accounts, or
a specific Dealer's Customers.

Perform the following steps to add and group Receiver Lines:  

1. Navigate to the Maintenance menu, and click "Setup", and then click "Receivers".
Result: the "Receivers" form displays as shown in the following screenshot:
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2. Click "Edit".
3. Select the Receiver to which you want to add a Line from the FEP list, and then click "

Add".
Result: the "Add Receiver Line Map" window displays as shown in the following
screenshot:
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4. Select a Receiver Line Prefix from the dropdown menu.
Note: ask your Central Station IT staff to assign you this number. 
5. Enter a description for the Receiver Line into the "Description:" field.
6. Enter a starting number into the "Starting Number:" field.
Note: the Starting Number is preselected based on the number of Receiver Line Prefixes
already assigned to other Receivers. 
7. Enter the number of lines you want to add in the "Number to Add:" field.
Note: this is determined by the number of Lines your new Receiver includes. 
8. Click "OK".
Result: the Receiver and the Lines associated with it now display in the FEP list, and the
system displays the "Receiver Line Maps" form.
9. If you want to designate a monitoring group, select it from the "Monitoring Group:"

dropdown menu.
10. If you want to designate an extended reporting delay, enter the number of seconds

you want the delay to last in the "Extended Reporting Delay:" field.
Note: the extended reporting delay is the time in seconds the Driver waits for a second
round of alarm information. When received, the system combines alarm information
received in the second round with information  received in the first round to form one
signal. An extended reporting delay is only relevant regarding older signaling protocols
(typically, protocols with a 3-4 digit account field and a 1 digit code field).
Note: the Manitou Supervisor Workstation allows you to modify the Line number of a
signal as reported by the Receiver. This allows you to group signals from different
Receivers together into a Line Group.
11. If you want to group signals together into a Line Group, select the "Map Line"

checkbox. In the "Map Line Number:" field, enter the number for the line to which you
want the current Line to map. For example, the screenshot above displays the Line
map settings for Line 2 on Receiver 11. If you want Line 2 to map to Line 1 (i.e., create
a Line Group on Line 1), enter "1" in the "Map Line Number:" field.

12. If you want the line to use DNIS for the Line, select the "Use DNIS" checkbox.
13. Click "Save".

Adding a Receiver Line Prefix
Receiver Line Prefixes provide Manitou with information about the origin of received
signals and the Customer accounts associated with them. Also, adding Receiver Line
Prefixes increases the number of incoming signals that can be handled by a single
Receiver. 

1. Navigate to the Maintenance menu, and click "Setup", and then click "Receivers".
Result: the "Receivers" form displays as shown in the following screenshot:
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2. Click "Edit".
3. Select the Receiver Line Prefixes icon from the FEP list, and click "Add".
Result: the "Add Receiver Line Prefix" window displays as shown in the following
screenshot:

4. Enter a description of your new Receiver Line Prefix into the "Description:" field.
Note: the "Receiver Line Prefix:" field displays prepopulated, and is determined by the
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number of Receiver Line Prefixes already entered into Manitou. 
5. Enter the number of Receiver Line Prefixes you want to add in the "Number to Add:"

field, and click "OK".
Result: the "Add Receiver Line Prefix" window closes and the system returns the user to
the "Receiver Line Prefixes" form. 

6. Trigger 1 and Trigger 2 fields may be left blank as they are not currently
implemented. 

7. Enter the maximum number of Customers to be associated with the receiver line into
the "Max Customers:" field. 

8. Enter the maximum number of Open/Close Customers to be associated with the
Receiver line into the "Max O/C Customers:" field, and click "Save". 

Transmitter ID Options (RLP and DNIS)
You have the ability to limit the number of characters read for when you receive an
account. And, you have the ability to pad or even limit the TXID.

· maxtxid={Number} – If you are not using the option under the Receiver , RLP or
DNIS options, then nothing is done with the TXID. If you choose this as the only RLP or
DNIS option, then Manitou will cut off the TXID and take the numbers to the right. For
example: MAXTXID = 4 and the TXID is 123456, the TXID will be parsed as 3456. If the
MAXTXID = 4 and the TXID that comes through is 123 then the TXID will parse as 123
since it is less than 4 digits.

· txtrimpos={left/right} – This affects which side Manitou trims from if the TXID is
longer than the maxtxid. It defaults to right if this is not set. If it is set to left, Manitou
takes from the left side.

· txpadchar={character} – If this is set, Manitou assumes that if a string is shorter than
the maxtxid, you want it padded. Manitou will take this character and pad it on the
left-hand side before the numbers. Whatever character you use, Manitou will put it
into uppercase.
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Note: If this is set to 0, Manitou treats it as if it is not set at all because the system
strips leading zeros everywhere else in the client.

· txpadpos={left/right} – If this is set /and/ a txpadchar is set, Manitou will put the
padding at the side of whatever is defined. If the customer has it set to right, Manitou
will put padding characters to the right-hand side of the TXID. Otherwise, they will go
to the left-hand side of the characters.

So, if you have only maxtxid=6 and txpadchar=A, when a signal comes in as:

1234 -> AA1234

1234567 -> 234567

If you have maxtxid=6, and txpadchar=A, and txtrimpos=left, and txpadpos=right, when
a signal comes in as:

1234 -> 1234AA

1234567 -> 123456

See the following screenshot as an example:

You set up the new Options on individual Receiver Line Map or DNIS Map.

To set up Options on a Receiver Line Map or DNIS MAP, do the following:

1. Open the Manitou Supervisor Workstation and click Maintenance | Setup |
Receivers.

2. Expand Receivers Line Maps or DNIS Maps and click the individual Receiver Line
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Map or DNIS Map to which you want to add the options.

Note: The option is comma delimited, for example, maxtixed=4,txtrimpos=left,
txpadchar=$.

Permissions
1. You want to change "System Reports" within the Supervisor Permissions Profile.
You go into Edit mode, select the Supervisor Profile and highlight System Reports:

2. By default the following permissions are set as follows:

3. You want "Supervisor Profile Defaults" and every item under it (Allow Override
Destination, Report Queue, etc.) to lose the ability to view the items. So you check the
"Replace permissions on all child objects..." option and then select the top "Visible"
checkbox which then removes the check boxes on all of its child objects:

4. When you drill down into System Reports you will see now that all of its child
items have lost the visibility setting as well:
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5. Next, you only want to change Visible capability for the Supervisor and Operator
Workstations at the top "System Report" level only, leaving all child objects without
this permission. Select "System Reports" again:

6. Then, in the Permissions table unselect the "Replace permissions on all child
objects..." option then select the top "Visible" checkbox. Now only this top level has
the Visible option enabled:

7. Upon drilling down, you will find that all of its child objects have retained their
setting:

SWS 1.6.1 and later gives you the option to revert settings to a higher level setting. It is
the "Use Defaults" setting, as follows:
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"Use Defaults" uses hierarchy and inheritance in two (2) was as follows:

1. When "Use Defaults" is selected in the first line of the Permissions table (for example
in the picture above this would be "Template Profile Defaults") it will revert to the
Profile level above itself - in this case it will revert to the Global Template Defaults.

2. Any items below the first line are considered child items, so clicking the "Use
Defaults" checkbox on any of these child items will make them inherit permission
from that top item. In the example above, Operator Workstation and all items below it
are child items of the {Template Profile Defaults} item.

Note: The Global Template is the highest level template so if you are editing the Global
Template, there is nothing higher to inherit so the "Use Defaults" checkbox is irrelevant.

Note: The "Replace permissions on all child objects..." checkbox will function as
described in the previous section.

Example
Open Permissions Profiles and perform the following:

1. Highlight "Maintenance" on the left and change the drop-down Profile menu to
"Administrator"
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2. Then click  at the top.

3. Note that the "Inherited From" column gets its settings from the Administrator Profile
(since this is the profile you have selected from the Profile drop-down menu):

If you were to unselect the visible column on the top {Administrator Profile Defaults}
line, all items that have the "Use Defaults" selected will lose the visible checkbox as well:

Additionally, if you were to then select the "Use Defaults" checkbox from just the top
"Administrator Profile..." line, every line below it would receive the same [Global
Template] settings as follows:
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On the other hand if you were to uncheck the "Use Defaults" column for any of the
objects, they would lose the inheritance from the parent object and retain their own
setting regardless of how their respective parent objects are configured going forward.

SWS 1.6.1 and later deals with user account and group permissions in a new way as
well. To view some of these differences click on the Maintenance Menu -> Users
Groups.

You will find that the "Permissions Profile" properties has been simplified, containing
only one setting for an Operator Profile:

Previous Manitou versions had an Operator and Supervisor Profile integrated into this
section.

Like User Groups, the Users form (Maintenance Menu -> Users) previously had
Operator and Supervisor Profile selection combo boxes. This has been reduced to a
single Permission Profile option and moved to "Security Restrictions" within the Users
form:
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By default, when creating a user, the group association will default to the "User Group's
Profile" setting. This means that the user will inherit all of the permissions settings as
seen in the prior Editing Permissions section. For instance, a user assigned to the
"Supervisor" User group will receive the "User Group's Profile" setting by default.
Following is an example of the Supervisor Permissions profile:

There are a couple of reasons one may want to create a user account that has a different
User Group and Permission Profile assignment.

1. This provides an extra layer of customization, giving Manitou users even more
flexibility with user rights assignments and permissions. 

2. There is an additional set of options that can be assigned to user groups
(Maximum logged on time, inactivity time, the Call Types they are allowed to receive,
etc.) that are not available in the Permissions Profiles settings. Following is an
example of the additional options available to the "Administrator" User Group:
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When trying to find a permission, it may be helpful to use the search field, as follows:

To perform a search, type a word such as "change" then either press Enter on your

keyboard or click the magnifying glass ( ) icon next to the search field. Then Manitou
will find all instances related to the word "change" and highlights them in yellow, as
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follows:
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Be sure to scroll down as there may be additional results, deeper in the list. The search
function will also find partial matches. For instance if you searched for the word "work"
it will also find words like "Network". 

To clear the search field and start again, simply click the X icon ( ) located next to the
magnifying glass icon. It may be helpful to know that you do not need to be in edit mode
to find search terms.

Operators
A Central Station may choose for Operators to only handle alarms, and therefore do not
need access to the Maintenance menu in the Client Workstation for data entry. Thus, the
Administrator in Supervisor Workstation will set the Permissions for an Operator to
disable all menu functions, including customer data entry, Reports, File menu options
and Tools to disabled or hidden. Under the Operations functions, all alarm handling
permissions would be enabled. 

Data Entry
Likewise, a Central Station may wish to enable specific users to only handle data entry,
such as entering new customer information or maintaining customer records. Once the
User Group is set up, the Administrator may choose to give access to only the
Maintenance menu and withhold access to any other menus in the Client Workstation,
such as alarm handling.

Trainee
Sometimes, a Central Station may choose to set up a "Trainee" User Group for new
Operators learning to use Manitou. The permissions for a Trainee may be limited to
customer maintenance, scheduling reports, and small tasks such as putting an account
out of service before learning to handle alarms. Therefore, restrictions may be put on
alarm handling, including canceling alarms from the alarm queue, pre-cancels, or alarm
tracking, but enabling options such as scheduling reports or editing customer records.
Additionally, Administrators may wish to first set the Trainee User Group to "View
Only," and create a View Only profile in Permissions. Administrators may then set all
functions to viewing only, where access may be visible, but not enabled for the Trainee.
This would allow the new Trainee to become familiar with Manitou without having the
ability to utilize any Manitou functions.

Permissions have been enhanced significantly in Manitou 1.6 affecting the entire suite:
Manitou Server, Manitou Clients and BoldNet. Following is a brief overview.

Note: The differences in 1.6 are enhanced and different enough from previous versions
of Manitou, that they warrant special attention. If not understood properly one could
encounter unexpected results and in a worst case scenario give way to safety or security
risks. So please take extra care when reading this section.

Terminology Note: The following hierarchal structure will be used to edit Permission
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Profiles:

The top-level nodes will be referred to as "Parents" where as the items below these top
nodes will be referred to as "Children". In the picture above, "Change Password" is a
Child of the Parent "Application". 

Child objects can also be parents. For instance, in the picture above, the "Portal Options"
object has a few child objects including "Customization Toolbar".

Note: These terms and concepts regarding hierarchy must be understood in order to
grasp the further intricacies of Manitou 1.6 permission settings.

Should a new User Group need to be created, the first step is to create a new Profile type
in Permissions. 

1. Open the Permissions form by first clicking on the Maintenance menu.

2. Select Setup.

3. Select Permissions. 

4. Click on the Template mode.
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5. Click on the Edit button to put the screen into Edit mode.

6. Click on the Types button located above the Permissions templates list. 

7. A Profile Types box will appear. Click Add to add a new Profile Type:
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8. Enter the new Profile name.

9. Click OK. The new profile type has been created. However, the new User Group
requires additional creation in the 

10. First, log out of the Supervisor Workstation and log back in for the new changes to
take place. This will enable the new Profile type to be listed in the User Groups
section. 

11. Click on the Maintenance menu.

12. Select User Groups. 

13. Click on the Edit button to put the screen into edit mode. 

14. Click Add. 

15. Enter the description of the new User Group.

16. Click OK.

17. Under the Profile Name drop-down menu, select the newly created profile. 

18. Enter the appropriate settings for the User Group. 

19. Click Save. 

After the User Groups and Profiles have been set up, the permissions for each User
Group must now be applied. 

1. Set the Permissions screen to Setup mode. 
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2. Click the Edit button to put the screen into Edit mode. 

3. Expand the Supervisor Workstation permissions tree by clicking on "Supervisor
Workstation Permissions" in the Templates list. 

4. Select the Profile type that should be adjusted, and expand the Profile type. For
example, under Supervisor Workstation Permissions, expand Administrator or
Operator. 

5. Under the Permission Details section of the screen, Permissions options will
appear. If the option appears in green, it may be edited. If the option appears in red,
it may not be edited.

6. Continue expanding the Permissions tree until the menu to be edited is found. 

7. Once the desired menu is found, locate the Access column in the Permissions
Details portion of the screen.

8. Click in the Access column of the appropriate menu function to bring up a
downward-pointing arrow.
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9. Click on the arrow to display the Access options:

10. Select from the following Access options:

· Visible/Enabled - This menu function will be visible to this User Group and may
be used by the User Group.

· Visible/Greyed Out - This menu function will be visible but not enabled (greyed
out) and cannot be used by the User Group.

· Hidden - This menu function is hidden and will not be displayed or enabled to the
User Group. 

11. Once the Access options have been set, click Save. 

Additionally, Manitou provides templates for setting up basic client and Supervisor
permissions. These templates can be exported and imported. The permissions
templates are normally imported upon the initial setup.  The removal of old templates
deletes all settings. When a new template is imported, all permissions will require
resetting the permission restrictions for all the User Groups.

1. Bring up the Permissions screen by first clicking on the Maintenance menu.

2. Select Setup.

3. Select Permissions. The screen will default load in Setup mode. 

4. Select Templates from the Mode settings. 
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5. Click the Edit button to put the screen into Edit mode. 

6. Click on the Import button located above the Templates list. A Load Template File list
will appear: 

7. Select either Profile_0_0.txt or Profile_0_1.txt. 

8. Click Open. The Template is now imported. 
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9. Click Save. 

1. Bring up the Permissions screen by first clicking on the Maintenance menu.

2. Select Setup.

3. Select Permissions. The screen will default load in Setup mode. 

4. Select Templates from the Mode settings. 

5. Click the Edit button to put the screen into Edit mode. 

6. Select the template to be removed from the templates list. 

7. Click the Remove button. A Remove Template box will appear: 

8. Users may opt to remove the template from either the Client (Operator)
Workstation or the Supervisor Workstation. Select either the Client Workstation or
the Supervisor Workstation. If the template must be removed from both
Workstations, repeat the removal process to remove the template from the second
Workstation. 
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9. Click OK. 

10. Click Save.

Access Control Card Formats
Different Access Control Card formats use a different kind of data structure. Manitou
automatically assigns a Format Number based on the number of Format types already
assigned.

Accessing the Access Control Card Formats Form
To reach the Access Control Formats form, navigate to the Maintenance menu, and click
"Setup, and then click "Access Control Card Formats".
Result: the "Access Control Card Formats" form displays as shown in the following
screenshot:

Description of Fields

· Format No: an identifying number assigned to the Format type. Manitou
automatically assigns this number based on the number of Format types already
assigned.

· Description: a description for the Card Format. Along with the Format number, this
description displays in the list.

· File Name: the file name is case sensitive and must not include the file path.

Adding a New Access Card Format

1. Navigate to the Maintenance menu, and then click "Setup", and then click "Access
Control Card Formats".

2. Click "Edit", and then click "Add".
Result: the "Add AC Format" window displays as shown in the following screenshot:
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Note: the Format No: field displays automatically populated based on previously
assigned Access Control Card Formats. Is there any reason a user should change
this?

3. Enter a brief description into the "Description:" field, and click "OK".
Result: the "Add AC Format" window closes and your new AC Format displays in the

list.
4. Enter the File Name into the "File Name:" field, and click "Save".

Application Types
The Application Types form displays the Manitou system configuration as regards active
applications. 

These applications will typically be defined and configured during the implementation
process. However, it may become necessary for a user to modify the configuration.

Adding a New Application to Manitou
1. Navigate to the Maintenance menu, and then click "Setup", and then click "Application

Types".
Result: the "Application Types" form displays as shown in the following screenshot:

2. Click "Edit", and then click "Add".
Result: the "Add Application Type" window displays as shown in the following

screenshot:
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3. Enter a description of the Application Type into the "Description:" field.
4. If you want Manitou to monitor your new application with Watchdog, select the

"Monitor with Watchdog" option. 
Note: Watchdog provides both audio and visual alerts that correspond to equipment
failures or Operator issues.
5. Select the Group that the Application Type falls under from the dropdown menu, and

click "OK". 
Result: the "Add Application Type" window closes, and the system returns the user to
the Application Types form.
6. Select the Application Type to which the new Type should connect from the

"Connects to Application Type:". 
7. If your new Application Type depends on another Type, select it from the "Depends

on:" dropdown menu.
8. If a Service name is required, enter it into the "Service name:" field. 
9. If the Application type outputs to Logger, select the "Outputs to Logger" checkbox.
10. Check the "Allow multiple instances per system" if the Application Type does so. 
11. Select an option from the "LED No." dropdown menu.
Note: The "LED No." dropdown menu includes the following three options: 1= Serious
System Warning, 2=System Warning, 3=Minor Warning. This selection determines the
minimum priority level Event to display as a Watchdog message.
12. Click "Save".

Applying Watchdog to Monitor an Existing Application
Watchdog messages display on the Status Bar just below the alarm status fields.  They
notify the Supervisor of signal processing and alarm progress activities within the
system.

1. Navigate to the Maintenance menu, and then click "Setup", and then click "
Application Types".
Result: the "Application Types" form displays as shown in the following screenshot:
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2. Select the application you want Watchdog to monitor. 
3. Click "Edit".
4. Select the “Monitor with Watchdog” checkbox.
5. Select an option from the "LED No." dropdown menu.
Note: The "LED No." dropdown menu includes the following three options: 1= Serious
System Warning, 2=System Warning, 3=Minor Warning. This selection determines the
minimum priority level Event to display as a Watchdog message. 
6. Click "Save".
Result: Watchdog will now monitor the application you selected and display
information regarding it under the alarm status fields.

Contact Point Types
The Contact Point Types form provides a list of currently configured phone, fax, email,
and pager descriptions that can display on forms containing Contact Point information.
Entries can be added, changed, or deleted as necessary. 
Note: Some Contact Point Types are defined as System Types and cannot be deleted.
However, the user can modify names, if necessary. 

Adding a New Contact Point Type

1. Navigate to the Maintenance menu, and select "Contact Point Types".
Result: the "Contact Point Types" form displays as shown in the following screenshot:
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2. Click "Edit", and then click "Add".
Result: the system automaitically prepopulates the "Description:" field with the next
sequential Contact Point Type.
3. Select the Contact Point Type you want to add from the "Attributes:" dropdown

menu. 
Note: your options are: Phone, Fax, Pager, Email Address, Web Address, and
Retransmission. 
4. If you want to enter a description other than the one automatically included, enter it

into the "Description:" field, and click "Save". 

Integration Configuration
The Integration Configuration tool is a way for you to add, edit, and delete configuration
files stored as BObject records which you use for audio, toolbars, user profiles,
programs, and so on.

Note: This is an overview of the Integration Configuration tool. For steps on using this
tool specifically for Bold NotifyMe, see the Bold NotifyMe Functional Overview located
at the Bold Support Portal.

To use the Integration Configuration tool, do the following:

1. In the Manitou Supervisor Workstation, add the tool, Integration Configuration.

Note: Bold NotifyMe and permissions for the menu item are installed when you
run database migration.



Integration Configuration 125

To add the tool, do the following:

a. Right-click the toolbar and select Customize from the shortcut menu.
b. Click the Tools tab, then select Maintenance from Categories.
c. Select Integration Configuration from Tools.
d. Using the drag-and-drop method, move the selected tool to Maintenance |

Setup.

2. Click Maintenance | Setup | Integration Migration.

3. In the Integration Configuration click Edit.

You’re now able to use the tool.

Configuration Type Dialog Box Fields

You use the Configuration Type dialog box to add configurations.

· Configuration Type – The data in the Type column in the BObject table, for
example, 11 would represent Integration Gateway Configuration.

· SubType – The SubType is a system configuration number in the BObject table,
for example, a “Sound Number.” The SubType depends on the configuration as to
whether or not it is needed. If it is not configured, then it is forced to zero and is
not editable.

· For Integration Gateway Configuration it will be a driver.

· For Modules it will be a vendor code.

· For Video it will be a video subtype.

· For Audio it will be an audio code.

· For Mapping it will be a map subtype.

· Driver Name – Defines which component Integration Gateway represents.

· Description – An explanation for the configuration.

Monitoring Groups
Manitou uses Monitoring Group designations to categorize and distribute signals to
specific Operator groups. At the time Manitou is installed, it has a default Monitoring
Group setting of 0. If no other Monitoring Groups are defined, no specific distribution of
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signals can occur. If the user adds additional Monitoring Groups, he can then route
specific Customer signal traffic to specific Operator Workstations. Therefore, the user
must connect Monitoring Groups to specific Workstations and not to specific Operators. 

Adding a Monitoring Group
Perform the following steps to add a Monitoring Group to Manitou:

1. Navigate to the Maintenance menu, and click "Setup", then click "Monitoring Groups
".

Result: the "Monitoring Groups" form displays as shown in the following screenshot:

2. Click "Edit", and then click "Add".
Result: your new Monitoring Group displays in the list and displays as the currently
selected item on the "Monitoring Group" form as shown in the following screenshot:
Note: When a new Monitoring Group is added, Manitou automatically assigns the next
sequential number for the new Monitoring Group.

3. Enter a name for your new Monitoring Group into the "Description:" field
4. Enter any comments you want to include into the "Comments:" field.
5. If you want, select the "Generate warning if Operator not logged onto this Monitoring
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Group" checkbox.
Note: Selecting this checkbox enables Manitou to display a Watchdog Message if an
Operator from this Monitoring Group is not logged into the system at the time a signal is
received.
6. If you want, select the "Do not overflow to Monitoring Group 0 if no Alarm Handler is

available for this group" checkbox.
Note: Selecting this checkbox restricts Manitou from sending signals to another
Monitoring Group in the event it receives a signal, and no Operator from your new
Monitoring Group is logged in to handle it.
7. Click "Save".

Adding a Workstation to an Existing Monitoring Group
Perform the following steps to add a new Workstation to an existing Monitoring Group:

1. Navigate to the Maintenance menu, and select "Workstations".
2. Click "Edit".
3. Select the Workstation you want to add to a Monitoring Group.
4. Click at the right edge of the "Mon. Group" field on the line the contains your selected

Workstation.
Result: a dropdown menu displays as shown in the following screenshot:

5. Select the Monitoring Group to which you want to add the Workstation, and click "
Save".

Note: you must also add the Workstation to the Customer Record in the OWS. 

Monitoring Types
Users can access the Monitoring Types form to add or edit monitoring services (for e.g.,
Transmitter tests, Video Monitoring, and Daily Signals). The Monitoring Types form
allows Central Stations to modulate every monitor service for billing and reporting
purposes from a single access point. 

Monitoring Types are grouped by the following five Monitoring Levels: Customer,
System, Sub-System, Transmitter and Area. Depending on the Monitoring Level and the
Attribute selected for the Monitoring Type, the fields available for Data Entry vary.
However, the following fields display on each Monitoring Type, regardless of the
Attributes selected:

· Description - the text the user enters into this field displays in the Monitoring Types
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Navigation Tree
· Customer Sub Type - the available options for this field are: Commercial, Dealer GH,

Dealer GH 009, Medical, Prueba G4S, Residential, and Video 
· Monitoring Level - the available options for this field are: Customer, System, Sub-

System, Transmitter, and Area. These display as Parent items in the Monitoring Types
Navigation Tree

· Billing Code - for this field, the user must first select the Accounting System (either
Sedona or Quickbooks), and then select the associated Billing Code from the list

· Heading Code - this field contains a billing code that corresponds with Dealer charges.
A Heading Code is also known as a Charge Code

· Add Code - this field contains a code representing a one-time charge for initializing a
service (for e.g., a setup fee) 

· Limit Code - this field contains a code representing a charged amount added for
exceeding the allowed service limit

· Limit Type - this field contains the units of measurement associated with the service
limit. This field offers only three options: Signals, Seconds, and Minutes

· Limit Quantity - this field contains the limit value (for e.g., the maximum number of
signals allowed or the maximum number of two-way minutes)

Adding a Monitoring Type 
Perform the following steps to add a Monitoring Type:

1. Navigate to the Maintenance menu, and select "Setup", and then select "Monitoring
Types".

Result: the "Monitoring Types" form displays as shown in the following screenshot:
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2. Click "Edit", and then click "Add".
Result: the "Add Monitoring Type" window displays as shown in the following
screenshot:

3. Select a Monitoring Level from the dropdown menu.
Note: Monitoring Types are grouped by the following five Monitoring Levels: Customer,
System, Sub-System, Transmitter and Area. Monitoring Levels display as Parent items in
the Monitoring Types Navigation Tree. If you are not sure which Monitoring Level best
applies to your new Monitoring Type, view the Navigation Tree's Child items to
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determine which existing Monitoring Types are most similar.
4. Select an Attribute from the dropdown menu.
Note: the Attributes available from the dropdown menu vary depending on the
Monitoring Level selected.
5. Enter a description into the appropriate field, and click "OK".
Result: the "Add Monitoring Type" window closes and the system returns the user to
the Monitoring Types form.
Note: Certain fields on this form become enabled or disabled based on the Monitoring
Type you added. For example, if you added a Video Enabled Attribute, you need to
define the number of cameras that will be used. In the same manner, if you added a
Transmitter Test, you will need to define the test unit and test interval.
6. Enter the appropriate data into the fields available for your new Monitoring Type.
Note: refer to the beginning of this document for a description of fields that display for

every Monitoring Type. 
7. Confirm that the information you entered is correct, and click "Save".

Output Device Types
The Output Device Type form defines the various types of Output Devices and their
associated protocols. The following Device Types are used by Manitou:

· Numeric Pager
· Alpha Pager
· SMS Phone
· Email
· Fax
· Printer (Raw output)
· Retransmission 

Adding a New Output Device Type to Manitou
Perform the following steps to add a new Output Device Type:

1. Navigate to the Maintenance menu, and click "Setup", and then click "Output Device
Types".

Result: the "Output Device Type" form displays as shown in the following screenshot:
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2. Click "Edit", and then click "Add".
Result: the "Add Output Device Type" window displays as shown in the following

screenshot:

3. Enter an Output Device Code into the appropriate field.
Note: the text you enter into this field displays as the Output Device Code name in the
list
4. Enter a description into the Description field, and click "OK". 
Result: the "Add Output Device Type" window closes, and the system returns the user
to the "Output Device Types" form.
5. Select an Attribute from the "Attribute:" dropdown menu.
Note: the six available Attribute options are: Phone, Fax, Pager, Email Address, Web
Address, and Retransmission. 
6. Select a Type from the "Type:" dropdown menu.
Note: the seven available Type options are as follows: Numeric Pager, Alpha Pager, SMS
Phone, Fax, Email, Printer (Raw output), and Retransmission.
7. Select a Protocol from the "Protocol:" dropdown menu.
Note: the six available Protocol options are: TAP, DTMF, SMS, Fax, Email, Text, and
Retransmission. 
8. Enter the number of signal rows to display in Manitou in the "Rows on display" field.
9. Enter the number of signal columns to display in Manitou in the "Columns on display"
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field.
10. Select the specific Script Message to display from the "Script Message:" dropdown

menu. 
Note: options in the "Script Message:" dropdown menu correlate to those created in the
"Script Messages" form of the Maintenance menu. 
11. If you want your new Output Device Type to display messages as wrapped text,

select the "Word wrap display" checkbox.
12. If you want your new Output Device Type to create a paged contact, select the

"Create Paged Contact" checkbox.
13. If you want to require a Service Code for your new Output Device Type, select the

"Service Code required" checkbox. 
14. Click "Save".

Service Provider Devices
The Service Provider Types function provides a definition of the hardware and the
settings related details for Output Device Types in Manitou. 

1. Navigate to the Maintenance menu, and click "Setup", and then select "Service
Provider Devices".

Result: the "Service Provider Devices" form displays as shown in the following
screenshot:

2. Click "Edit", and the click "Add".
Result: the "Add Service Provider Device" window displays as shown in the following
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screenshot:

3. Enter the name of the External Device into the appropriate field.
4. Enter a description for your External Device into the "Description:" field.
5. Select the Protocol from the "Protocol:" dropdown menu, and click "OK".
Result: the "Add Service Provider Device" closes and the system returns the user to the
Service Provider Devices form.
6. Enter an address for your new device into the "Address:" field.
Note: this address can be an IP address or a phone number, depending on the type of
Device you are adding.
7. Enter an ID into the appropriate field. 
8. If your new Device requires a dial-up connection, select the "Dial-up Service"

checkbox.
9. Enter the Port Settings into the appropriate field. 
10. Enter an Account Name and Password into the appropriate fields.
11. Click "Save".

Permit Types
A Permit Type defines the set of Unique Reference Numbers (URNs) for Police, Fire and
Medical Services. In Manitou, these Entities are known as Authorities. Once defined, the
URN types become part of the Manitou Customer record.

Currently, three Authority Types can be added and configured in the Permit Types
section:

· Police
· Fire
· Medical

Adding a Permit Type
1. Navigate to the Maintenance menu, and select "Permit Types"
Result: the "Permit Types" window displays as shown in the following screenshot:
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2. Click "Edit", and then click "Add".
Result: the "Add Permit Type" window displays as shown in the following screenshot:

3. Select the appropriate Country for your new Permit Type from the dropdown menu.
4. Select the Authority Type from the dropdown menu.
5. Select the Permit Type from the dropdown menu. 
Note: if your new Authority Type is Fire or Medical, your Permit Type is automatically
set to "General". If your Authority Type is Police, your Permit Type options are:
"Burglary", "PA", and "Line Fault". 
6. Click "OK".
Result: the "Add Permit Types" window closes and the system returns you to the Permit
Types form.
7. Click "Save". 

Receiver Types
The Receiver Types form defines the various types of Receivers that are used in
Manitou. Each time you add a new Receiver, you must update the information contained
in this form.

Adding a New Receiver Type
Perform the following steps to add a new Receiver Type in Manitou:

1. Navigate to the Maintenance menu, and click "Setup", and then click "Receiver Types
".

Result: the Receiver Types form displays as shown in the following screenshot:
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2. Click "Edit", and then click "Add".
Result: the "Add Receiver Type" window displays as shown in the following screenshot:

3. Enter a code into the "Code:" field.
Note: the code you enter displays as the first part of the Receiver name in the list.
4. Enter a name for your new Receiver Type into the "Name:" field, and click "OK".
Result: the "Add Receiver Type" window closes and the system returns you to the

"Receiver Types" form.
5. Enter any additional Attributes into the "Attributes:" field. 
6. Select the Receiver Driver from the "Driver:" dropdown menu
7. Enter the appropriate code into the "Options:" field, and click "Save". 

Reverse Channel Routes
Reverse Channel Routes allow Manitou to send signals to Transmitters for testing and
response purposes. This is most useful for accounts with video or Access Control
functions. 
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Adding a Reverse Channel Route 
Perform the following steps to add a Reverse Channel Route to Manitou:

1. Navigate to the Maintenance menu, and click "Setup", and then click "Reverse
Channel Routes".

Result: the "Reverse Channel Routes" form displays as shown in the following
screenshot:

2. Click "Edit", and then click "Add".
Result: the "Add Reverse Channel Route" window displays as shown in the following

screenshot:

3. Select a Protocol from the "Protocol:" dropdown menu.
4. Enter a description into the "Description" field, and click "OK".
Result: the "Add Reverse Channel Route" window closes and the system returns the
user to the "Reverse Channel Routes" form. 
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5. If there is a Dealer associated with this Reverse Channel Route, select the Dealer from
the dropdown menu.

6. Select the Receiver Line Prefix from the dropdown menu.
7. Select the FEP from the dropdown menu, and click "Save".
Note: the Receiver and Receiver Line fields are set to the defaults and cannot be
modified.

Subtypes
The Subtypes form allows a user to add new subcategories (called "Subtypes") to the
hierarchically-superior Manitou categories. Currently, the user can add a Subtype to any
of the following Manitou categories:

· Action Patterns
· Address Labels
· Address Types
· Agency Types
· Attention Table Types (for e.g., Invoice, Mailing, Reporting, etc.)
· Authority
· Client Application Types
· Customer Premises Types
· Dealer Types
· Keyholder Types
· Name Suffixes
· Person Titles
· Report Types
· Reverse Command Types
· UL Grades
· Workflow Component Categories

Adding a Subtype to Manitou
Perform the following steps to add a Subtype:

1. Navigate to the Maintenance menu, and click "Setup ", and then click "Subtypes".
Result: the "Subtypes" form displays as shown in the following screenshot:
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2. Click "Edit", and the click "Add".
Result: the "Add Subtype" window displays as shown in the following screenshot:
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3. Select a category under which you want to add a new Subtype.
4. Enter a description of your new Subtype into the "Description:" field, and click "OK".
Result: your new Subcategory displays in the list under the category you selected.

Restoring UL Defaults
UL is an abbreviation for Underwriter's Laboratories. The UL is a testing and
certification body for alarm software development, as well as for Central Station alarm
handling procedures. The UL has developed a list of categories and Subtypes that must
be included in alarm software if the software is to be UL certified. Manitou meets these
basic UL standards, but also allows users to add Subtypes in addition to the minimum
requirements for UL certification. Thus, a user may, at some point, want to restore
Manitou to only those Subtypes deemed necessary by the UL.

Perform the following steps to Restore UL Defaults:

1. Navigate to the Maintenance menu, and click "Setup ", and then click "Subtypes".
Result: the "Subtypes" form displays as shown in the following screenshot:
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2. Click "Edit".
3. Click "Restore UL Defaults".
Result: the following window displays:

4. If you are sure you want to remove all the Subtypes that have been created since
Manitou was originally installed, click "Yes".

Note: as the Restore UL Defaults confirmation window states, if you are currently using
non-UL Default Subtypes, you will have to reassign the functions to which the existing
Subtypes are connected back to the UL Defaults.
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Transmitter Protocol Types
A Transmitter is a device located at a Customer Premises that communicates with the
signal Receivers connected to Manitou. The specific Transmitter for each Customer is
indicated in the Customer Record, along with the Transmitter Protocol Type. 

Adding a Transmitter Protocol Type to Manitou
Perform the following steps to add a Transmitter Protocol Type:

1. Navigate to the Maintenance menu, and click "Setup", and then click "Transmitter
Protocol Types".

Result: the "Transmitter Protocol Types" form displays as shown in the following
screenshot: 

2. Click "Edit", and then click "Add".
Result: the "Add Transmitter Protocol Type" window displays as shown in the following
screenshot:
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3. Enter a Protocol Type into the appropriate field.
Note: text you enter into this field displays as the first part of the list item.
4. Enter a description into the appropriate field.
Note: text you enter into this field displays as the second part of the list item.
5. Select a Protocol Type from the "Type:" dropdown menu, and click "OK".
Note: your options for the "Type:" dropdown menu are: Event Type, Channel Based,

Modem2 Hex to SIA, and Modem2 Hex to Type. 
Result: the "Add Transmitter Protocol Type" closes and the system returns the user to

the "Transmitter Protocol Types" form.
6. If you want to enable a Signal Type field, select the "Enable Signal Type field"

checkbox.
7. If you want, enter a Condition field picture into the appropriate field. 
8. Select the other checkbox options as necessary, and click "Save". 

Workstation Groups
The Workstation Group form allows you to associate a Manitou Workstation with other
individual Workstations. 

Creating a New Workstation Group in Manitou
Perform the following steps to create a Workstation Group:

1. Navigate to the Maintenance menu, and click "Setup", and then click "Workstation
Groups".

Result: the "Workstation Groups" form displays as shown in the following screenshot:
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2. Click "Edit".
Result: a new line displays on the form and is denoted by as asterisk as shown in the
following screenshot:

3. Enter a description for your new Workstation Group, and click "Save".
Result: your new Workstation Group displays in the list as shown in the following
screenshot:

Adding an Individual Workstation to Your New Workstation Group
Now that you have created a new Workstation Group, you must add the individual
Workstations you want as members of the Workstation Group.

Perform the following steps to add individual Workstations to your new Workstation
Group: 

1. Navigate to the Maintenance menu, and click "Setup", and then click "Workstations".
Result: the "Workstations" form displays as shown in the following screenshot:
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2. Click "Edit". 
3. Select the Workstation you want to add to the Workstation group by click the line on

which it displays.
4. Click at the right edge of the "WS Grp" column of the line for the Workstation you

selected.
Result: the icon for a dropdown menu displays as shown in the following screenshot: 

5. Select the Workstation Group to which you want to add the individual Workstation.
Result: the Workstation Group you selected now displays in the "WS Grp" column.
6. Click "Save".

Class Codes
Class Codes and Group Codes are customizable, user-created options for grouping
certain signals or Resolutions together. For instance, a Central Station may wish to
assign all monitored banking companies to a large Class Code, but a particular Branch of
banks to one Group Code. 

Adding a New Class Code
Perform the following steps to add a new Class Code to Manitou:

1. Navigate to the Maintenance menu, and click "Class Codes".
Result: the Class Codes form displays as shown in the following window:
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2. Click "Edit, and then click "Add".
Result: the "Add Class Code" window displays as shown in the following screenshot:

3. Enter a Class Code into the "Class Code" field.
Note: this text displays as the first part of the Class Code name in the list.
4. Enter a description into the "Description" field.
Note: this text displays as the second part of the Class Code name in the list.
5. Click "OK".
Result: the "Add Class Code" window closes and the system returns the user to the Class
Codes form.
6. If you want to alert the user regarding this new Class Code, select the "Alert the user"

checkbox. 
7. Click "Save".

Group Codes
Manitou uses Group Codes to categorize and report on businesses that have multiple
Branches. For instance, a Central Station may wish to assign all monitored banking
companies to a large Class Code, but a particular Branch of banks to one Group Code. 

Adding a New Group Code to Manitou
Perform the following steps to add a new Group Code to Manitou:

1. Navigate to the Maintenance menu, and then click "Group Codes".
Result: the "Group Codes" form displays as shown in the following screenshot:
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2. Click "Edit", and then click "Add".
Result: the "Add Group Code" window displays as shown in the following screenshot:

3. Enter a Group Code into the appropriate field.
Note: this text displays as the first part of the Group Code name in the list.
4. Enter a description into the "Description:" field, and click "OK".
Result: the "Add Group Code" window closes and your new Group Code displays in the
list.
Note: this text displays as the second part of the Group Code name in the list.

Resolution Codes
Resolution Codes are user-created codes that are customized for particular alarm
situations. For example, an alarm may be received that has been set off as a result of a
thunderstorm. The Operator may wish to resolve the alarm by entering "WE" for
"Weather," where "WE" has been previously defined in the Resolution Codes section of
Supervisor Workstation as a false alarm. 

Adding a New Resolution Code to Manitou
Perform the following steps to add a resolution code:

1. Click Maintenance, and then "Resolution Codes".
Result: the Resolution Codes screen displays as shown in the following screenshot:
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2. Click "Edit", then "Add".
Result: the "Add Resolution Code" screen displays as shown in the following screenshot:

3. Enter the Group Number for which the Resolution Code should display in the "Group
No." field. 

4. Enter a unique two-letter Resolution Code into the Resolution Code field. 
Note: text you enter into this field displays as the first part of the Resolution Code name

in the list. 
5. Enter a description of the Resolution Code into the Description field.
Note: text you enter into this field displays as the second part of the Resolution Code

name in the list. 
6. If the Resolution Code is a for a false alarm, check the "False Alarm" checkbox, and

click "OK".
Result: the "Add Resolution Code" window closes and your new Resolution Code

displays as the currently selected item.
7. Click "Save". 
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Schedule Window Codes
Schedule Window Codes allow you to create and apply simple deviations to OWS
Schedule Windows. For example, let's say that a retail store opens at 9am and closes at
6pm. The posted business hours usually apply only to Customers who might visit the
store to do business. The hours do not usually apply to an employee who has to prepare
the bank deposit before the store opens at 9am, or to the janitorial staff who clean the
store after the 6pm closing. In order to avoid premises entries like these triggering
unintended alarms, a Supervisor can create Schedule Window Codes to approve such
variances.  

Adding a New Schedule Window Code
Perform the following steps to create a new  Schedule Window Code in the SWS:

1. Navigate to the Maintenance menu, and click "Schedule Window Codes".
Result: the "Schedule Window Codes" form displays as shown in the following
screenshot:

2. Click "Edit", and then click "Add".
Result: the "Add Window Code" screen displays as shown in the following screenshot:

3. Enter a code into the "Window Code:" field.
4. Enter a description into the "Description:" field and click "OK".
Result: the "Add Window Code" screen closes and the system returns the user to the
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"Schedule Window Codes" form.
Note: entries into the "Window Code:" and "Description:" fields display in the OWS "O/C

Schedules" form.
5. Select the number of minutes during which a pre-opening entry may occur in the

"Number of minutes before:" field.
6. Select the number of minutes during which a post-closing entry may occur in the

"Number of minutes after:" field.
7. Click "Save". 
Result: you can now apply your new Schedule Window Code in the OWS "O/C

Schedules" form.

Accounting Companies
Manitou can integrate with Sedona and Quickbooks Accounting Software products.
Manitou can be configured with these products so that updates in one program
automatically result in the same updates in the other program.

Adding and Configuring Accounting Software Products in Manitou
Perform the following steps to add and configure Accounting Software products in
Manitou:

1. Navigate to the Maintenance menu, and click "Accounting Companies".
2. Click "Edit", and then click "Add".
Result: the "Add Accounting Company" window displays as shown in the following
screenshot:

3. Enter the Company ID into the appropriate field.
4. Open the "Interface Type:" dropdown menu.
Result: the list of Interface Types displays as shown in the following screenshot:
Note: the following are available options in the "Interface Type:" dropdown menu:
· Not interfaced - there is no integration between Manitou and the Accounting

Company, and the two systems will not exchange any data. 
· Manitou CS to Accounting- the Accounting Company is integrated with Manitou and

the software is updated in the following direction: Manitou to Accounting (i.e., changes
made in Manitou result in the same changes made to the Accounting Software) 

· Accounting to Manitou CS: the Accounting Company is integrated with Manitou and
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the Accounting Software is updated in the following direction: Manitou to Accounting
(i.e., changes made in the Accounting Software result in the same changes made in
Manitou)

· Read only: changes made in either Manitou or the Accounting Software do not affect
the other program (although the Accounting Software can read information from the
Manitou database) 

5. Select an Interface Type from the "Interface Type:" dropdown menu. 
Result: if you select either the "Manitou CS to Accounting" or the "Accounting to
Manitou CS" options, the "Application:" field displays as shown in the following
screenshot: 

6. Select the Accounting Company from the "Name:" dropdown menu. 
Result: if the Accounting Company you want to add does not display in the "Name:" field
after you select an Application, Manitou has not been configured for integration with the
product and the Accounting Company cannot be added.
7. Click "OK".
Result: the system returns you to the "Accounting Company" form and displays the
Accounting Company you added as the currently selected item as shown in the following
screenshot:
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8.  Enter the DSN number into the "DSN" field.
Note: DSN is an acronym for Data Source Number. 
9. Enter the username the system will require to access Accounting Company

information into the "User:" field.
10. Enter the password the system will require to access Accounting Company

information into the "Password:" field.
11. Enter the Server on which the Accounting Company software resides into the

"Server" field.
12. If you want, select the "Update common fields" option. 
13. If you want, select the "Account ID required" option.
Note: selecting this option results in the user being prompted for credentials when
attempting to log in.
14. If you want, select the "Force Account ID to be unique" option. 
Note: selecting this option results in the system ensuring that entries in the "Name:" and
"Password:" field are unlike those of any other user.
15. If you want, select the "Force services to be one-to-one with recurring" option. 
16. If you want, select the "Push Customer Changes" option. 
17. Click "Save".
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Control Panels
The Control Panel form allows you to create and maintain a global list of Control Panels
in common use across the Manitou system. Once created, Control Panels are available
for use in the Customer and Dealer Records. 

· Panel Type – the manufacturer's model number  
· Description – the manufacturer and model number
· Default Transmitter Type – an optional field that specifies the type of transmitter

normally associated with a particular panel  

Properties fields
The Properties area is used to specify the maximum capacities for each particular panel
in regards to certain variables. These parameters can be overridden in the customer
record if required.

· Max Transmitters - specifies the maximum number of Transmitters associated with a
Control Panel

· Max Zones - specifies the maximum number of zones associated with a specific
Control Panel

· Max Areas - specifies the maximum number of areas associated with a specific Control
Panel

· Max Users - specifies the maximum number of users associated with a specific Control
Panel

Adding a New Control Panel
Perform the following steps to add a new a new Control Panel:

1. Navigate to the Maintenance menu and click "Setup", and then click "Control Panels
".

Result: the "Control Panels" form displays as shown in the following screenshot: 
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2. Click "Edit", and then click "Add".
Result: the "Add Panel Type" widow displays as shown in the following screen shot:

3. Enter the panel type into the appropriate field.
4. Enter a description into the appropriate field, and click "OK".
Result: your new Control Panel displays in the list and as the currently selected item on
the form as shown in the following screenshot:
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5. Select a Default Transmitter Type from the dropdown menu.
6. Click "Save".

Global Holidays
The Global Holidays function allows you to program the system with the dates of public
holidays for the current year. Manitou then uses this information for Open/Close
schedules, Keyholder lists, and other areas of the system where holiday information is
required. 

Adding a New Global Holiday
Perform the following steps to add a new Global Holiday to Manitou:

1. Navigate to the Maintenance menu, and select "Global Holidays".
Result: the Global Holidays form displays as shown in the following screenshot:
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2. If you want to see holidays for a different country, select the country from the
"Country:" dropdown menu.

3. If you want to see a description of a holiday shown on the calendar, hover your mouse
over it. 

Result: The description of the holiday displays as shown in the following screenshot:

4. Click "Edit".
5. Double-click the date for which you want to add a holiday.
Result: The "New Global Holiday" window displays as shown in the following
screenshot: 
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6. Enter a description for your new holiday into the "Description:" field, and click "OK".
Result: your new holiday now displays in the calendar of the Global Holidays form.

Editing an Existing Global Holiday
Perform the following steps to edit an existing Global Holiday:

1. Navigate to the Maintenance menu, and select "Global Holidays".
Result: the Global Holidays form displays as shown in the following screenshot:

2. Click "Edit".
3. Click and hold down your mouse button on the holiday for which you want to change

the date.
Result: a dotted-line rectangle displays around the date.
4. Drag your mouse to the new holiday date and release. 
Result: The new date you selected now displays as the holiday.
5. Click "Save".
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Modifying the Description for an Existing Holiday
Perform the following steps to change the description of an existing holiday:

1. Navigate to the Maintenance menu, and select "Global Holidays".
Result: the Global Holidays form displays as shown in the following screenshot:

2. Click "Edit".
3. Double-click the holiday for which you want to change the description. 
Result: the "Modify Global Holiday" window displays as shown in the following
screenshot:

4. Enter the new description for your holiday in the "Description:" field, and click "OK".
5. Click "Save". 

Deleting a Global Holiday
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Perform the following steps to delete an existing holiday:

1. Navigate to the Maintenance menu, and select "Global Holidays".
Result: the Global Holidays form displays as shown in the following screenshot:

2. Click "Edit".
3. Right-click the date of the holiday you want to Delete.
Result: a small options window displays as shown in the following screenshot: 

4. Click "Delete".
Result: a window displays and asks you to confirm.
5. Click "Yes", and then click "Save".
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Maintenance Issues
Viewing an Existing Maintenance Issue
Perform the following steps to view an existing Maintenance Issue in Manitou: 

1. Open Manitou.
Note: the steps in this section can be performed in either the Supervisor
Workstation or the Operator Workstation.

2. Navigate to the “Maintenance” menu, and select the “Maintenance Issues” form as
shown in the following screenshot:

Result: the “Maintenance Issues” form displays as shown in the following
screenshot:

3. Double-click the Maintenance Issue you want to view.
Result: the “View Maintenance Issue” window displays as shown in the following
screenshot:
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Note: information on the “View Maintenance Issue” form is not editable.
4. When you are finished viewing the Maintenance Issue, click “Close”.

Creating a New Maintenance Issue
Perform the following steps to create a new Maintenance Issue in Manitou:

1. Open Manitou.
Note: the steps in this section can be performed in either the Supervisor Workstation or the
Operator Workstation.

2. Navigate to the Maintenance menu, and select the “Maintenance Issues” option as shown in
the following screenshot:
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Result: the “Maintenance Issues” form displays as shown in the following screenshot:

3. Click “Create New” as shown in the following screenshot:

Result: the “New Maintenance Issue” window displays as shown in the following screenshot:
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4. Select an option from the “Contact type:” menu as shown in the following screenshot:

Result: if you selected any option other than “Company”, the “Contact ID:” menu displays as
shown in the following screenshot:

Note: if you selected the “Company” option, the “New Maintenance Issue” window now
displays with the company name as shown in the following screenshot:

5. If you selected an option from the “Contact type:” field that is anything other than
“Company”, enter a contact ID into the “Contact ID:” field, and then press “Enter”.
Result: the entity name now displays on the “New Maintenance Issue” window as shown in
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the following screenshot:

6. Select a technician from the “Technician:” dropdown menu as shown in the following
screenshot:

7. If you want, select the person who reported the Maintenance Issue from the “Person:”
dropdown menu.

8. Select the “Tech on Site” checkbox if the technician designated to perform the maintenance
is located where the maintenance is to be performed.

9. Define a priority level for the Maintenance Issue in the “Priority” field.
Note: 1 is the highest priority level and 10 is the lowest priority level.

10. Select a date and time in the “Appointment Date:” field.
11. Select a service type from the “Service Type:” dropdown menu.
12. Enter a description of your Maintenance Issue into the “Description:” field.

Result: the “Save Changes” button now displays enabled as shown in the following
screenshot:
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13. Click “Save Changes”.
Result: the Maintenance Issue you created displays in the list as shown in the following
screenshot:

Editing an Existing Maintenance Issue and Marking it as Resolved

Note: you can only edit Maintenance Issues that you created. 

Perform the following steps to edit an existing Maintenance Issue:

1. Open Manitou.
Note: the steps in this section can be performed in either the Supervisor Workstation or the
Operator Workstation.

2. Navigate to the Maintenance menu, and select the “Maintenance Issues” option as shown in
the following screenshot:
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Result: the “Maintenance Issues” form displays as shown in the following screenshot:

3. Select the Maintenance Issue you want to edit on the grid as shown in the following
screenshot:

4. Click “Edit Selected” as shown in the following screenshot:

Result: the “Edit Maintenance Issue” window displays as shown in the following screenshot:
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5. Modify existing text, or enter new text.
6. When you are finished editing the Maintenance Issue you selected, click “Save Changes”.

Result: the updated Maintenance Issue displays in the grid as shown in the following
screenshot:

7. If you enter text into the “New Notes:” area of the “Edit Maintenance Issue” form, the
“Resolved” checkbox displays enabled as shown in the following screenshot:
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8. When you are ready to close the Maintenance Issue, select the “Resolved” checkbox and
then click “Save Changes”.
Result: the Maintenance Issue now displays gray in the grid as shown in the following
screenshot:

Note: Maintenance Issues in the grid display gray once they have been marked as resolved
and saved. You can modify these settings in the Supervisor Workstation -> Tools -> Options
-> Color Options. You can also resolve an existing Maintenance Issue by selecting it from the
grid, and then selecting 
“Resolve Selected”. The “Resolve Selected” button automatically designates a Maintenance
Issue as resolved, and causes it to display gray in the grid. A user who resolves a
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Maintenance Issue through the “Resolve Selected” button does not get an opportunity to
enter additional notes. Once a Maintenance Issue has been resolved and saved, you cannot
edit it again unless you change its status. The “View Maintenance Issue” form displayed in
the following screenshot shows a Maintenance Issue that was resolved, saved, and then
reopened for viewing. Notice that it does not include a “Save Changes” button. It is not
editable.

Reopening a Maintenance Issue
You can change the status of a Maintenance Issue (and enable it for editing) by using the “Reopen
Selected” button.

Perform the following steps to reopen a closed Maintenance Issue:

1. Open Manitou.
Note: the steps in this section can be performed in either the Supervisor Workstation or the
Operator Workstation.

2. Navigate to the Maintenance menu, and then select the “Maintenance Issues” option as
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shown in the following screenshot:

Result: the “Maintenance Issues” form displays as shown in the following screenshot:

3. Select the Maintenance Issue that you previously saved and closed as shown in the following
screenshot:

4. Click “Reopen Selected” as shown in the following screenshot:

Result: the “Yes/No” window displays as shown in the following screenshot:
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5. Click “Yes”.
Result: the “Edit Maintenance Issues” window displays with the “Save Changes” button
indicating that it is now editable.
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Searching for Existing Maintenance Issues using Filters
Perform the following steps to apply a filter to search for existing Maintenance Issues:

1. Open Manitou.
Note: the steps in this section can be performed in either the Supervisor Workstation or the
Operator Workstation.

2. Navigate to the Maintenance menu, and select “Maintenance Issues” as shown in the
following screenshot:

Result: the “Maintenance Issues” form displays as shown in the following screenshot:

3. Scroll to the bottom of the form.
Result: the “Filter” tab displays as shown in the following screenshot:

4. Click “Filter”.
Result: the following Maintenance Issues Filter form displays as shown in the following
screenshot:
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5. Select a date option and range from the “Date” area of the form.
6. Select a contact type from the “Contact Types” area of the form.
7. In the “Resolution” area of the form, select whether the Maintenance Issue for which you

are looking has been resolved, remains unresolved, or can be in either completion status.
8. Select the Manitou user who created the Maintenance Issue from the “User” dropdown list

as shown in the following screenshot:

9. Select the technician associated with the Maintenance Issue you want to find in the
“Technicians” area of the form.

10. Select whether or not the Maintenance Issue for which you are searching was designated as
being on site. Your options for the menu are shown in the following screenshot: 
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11. Select a service type from the “Service Type:” dropdown menu as shown in the following
screenshot:

12. Select a priority level for the Maintenance Issue you want to find from the “Priority:”
dropdown menu as shown in the following screenshot:

13. When you are finished entering parameters, click “Search”.
Result: your search results display as shown in the following screenshot:

Note: in the search results above, the user searched for all Maintenance Issues associated
with technician “Nial MacDnald”. 

Adding a Service Type
Perform the following steps to add a Service Type in the Manitou Supervisor Workstation:

1. Open the Manitou Supervisor Workstation.
2. Navigate to the “Maintenance” menu, and then click “Setup” and “Subtypes” as shown in

the following screenshot:
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Result: the “Subtypes” window displays as shown in the following screenshot:
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3. Scroll down and select the “Maintenance Service Types” option as shown in the following
screenshot:

4. Click “Edit”, and then click “Add”.
Result: the “Add Subtype” window displays as shown in the following screenshot:
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5. Enter a description into the “Description” field, and then click “OK”.
6. The Maintenance Service Type you added now displays on the “Subtypes” form as shown in

the following screenshot:

7. Click “Save”.

Sending a Script Message for a New Maintenance Issue

Manitou has an option to create and send Script Messages to technicians when new or updated
Maintenance Issues are assigned to them.

After you complete the instructions in this document, the following conditions still must be met in
order for the system to send the notification email, as described:

· The technician to whom you want to send the email must be the designated technician
on the Maintenance Issue form.

· The technician to whom you want to send the email must have an email address listed in
the Monitoring Company Contact List.

· The Report Publisher must be running, and properly configured to send emails.
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Perform the following steps to send a script message to notify a technician about a new
Maintenance Issue via Script Message:

1. Open the Manitou Supervisor Workstation.
2. Navigate to the “Maintenance” menu, and select “Script Messages” as shown in the

following screenshot:

Result: the “Script Message” window displays as shown in the following screenshot:
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3. Click “Edit”, and then “Add”.
Result: the “Add Script Message” window displays as shown in the following screenshot:

4. Enter a description into the “Description:” field.
5. Select a locale for your script message from the “Language:” dropdown menu as shown in

the following screenshot:

6. Select the “Email” option from the “Type:” dropdown menu as shown in the following
screenshot:
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7. Enter the text you want to use for the script message into the “Script Text:” field.
8. Click “Save”.
9. Navigate to the “Tools” menu, and select “Options” as shown in the following screenshot:

Result: the following form displays:
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10. Expand the “General” node in the Navigation Tree as shown in the following screenshot:

11. Select the “Script Message for Maintenance Issue assignment” option. 
12. Click “Edit”.
13. Select the script message you recently added from the dropdown menu as shown in the

following screenshot:

14. Click “Save”.

Script Messages
The Script Messages function allows users to create messages that can be saved and sent
to Customers via email or fax. Once created, Script Messages are available for use with
Action Pattern items. 

Manitou can also add current alarm information to Script Messages. In this way, for
example, a Manitou user can easily provide a Keyholder with the specific details of an
alarm at the time of initial contact. 

Adding a New Script Message
1. Navigate to the Maintenance menu, and select "Script Messages".
Result: the "Script Message" form displays as shown in the following screenshot:
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2. Click "Edit", and then click "Add".
Result: the "Add Script Message" window displays as shown in the following
screenshot:

3. Enter a description for your new Script Message into the "Description:" field.
4. Select the language for your new Script Message from the "Language:" dropdown

menu.
5. Select a delivery method for your new Script Message from the "Type:" dropdown

menu, and click "OK".
Result: your new Script Message now displays on the Navigation Tree, and as the
currently selected message on the "Script Message" form.
Note: if you are unsure about how your new message will be sent to the customer, select
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"Generic".
6. Enter text for your new Script Message into the "Script Text:" field.
Note: Script Codes are insertable fields that symbolize a specific alarm detail. When you
insert a Script Code into your message, you are telling Manitou to include the specific
alarm detail symbolized by the code into the message. For example, the Script Code
"{AC}" symbolizes Customer City/Town. If a specific Customer lives in Seattle, and a
Manitou user inserts the "{AC}" Script Code into an email message regarding an alarm at
the Customer's residence, Manitou sends the email with "Seattle" in place of the inserted
"{AC}" Script Code.
7. If you want to insert a Script Code into your new Script Message, select the Script

Code and click "Add".
Result: the system inserts the Script Code you selected into the "Script Text:" window.
8. When you finish entering text and adding Script Codes into the "Script Text:" window,

click "Demo".
Result: the system displays your new Script Message with any inserted Script Codes
translated according the specific recipient's account details as shown in the following
screenshot:

9. Click "Save".

Using an Existing Script Message
1. Navigate to the Maintenance menu, and select "Script Messages".
Result: the "Script Message" form displays as shown in the following screenshot:
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Note: Script Messages are organized according to Locale.
2. Select the existing Script Message you want from the Navigation Tree.
Result: the message text displays in the "Script Text" area of the window, and a list of
codes displays in the "Script Codes:" area of the window as shown in the following
screenshot:

3. Click "Demo".
Result: the "Script Text Demo:" field displays with the Script Codes fields completed for
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a hypothetical recipient. When you send a Script Message to a real recipient, Manitou
uses its database to replace the Script Code fields with the recipient's relevant
information.

Web Membership
A Web Membership account allows you to access features in BoldNet. 

Creating a New BoldNet User
Perform the following steps to add a new member to BoldNet:

1. Navigate to the Maintenance menu, and select "Web Membership".
Result: the "Web Membership" form displays as shown in the following screenshot:

2. Click "Edit", and "Create New".
Result: the "Web Membership User" window displays as shown in the following
screenshot:
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3. Enter the user's account information, and click "OK".
Result: the new user's information now displays on the Web Membership list.

Using the Restricted IP Addresses Tab
At times, a user may need to restrict the IP Address of another user to prevent him from
accessing BoldNet. 

1. Navigate to the Maintenance menu, and select "Web Membership".
Result: the "Web Membership" form displays as shown in the following screenshot:
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2. Click the "Restricted IP Address" Tab located just above the "Status" area at the
bottom of your screen.

Result: the "Restricted IP Addresses" Tab displays.

3. Click "Edit", and then click "Create New".
Result: the "Restricted IP Address" window displays:

4. Enter the IP Address you want to block, and click "OK". 
Result: the restricted IP Address now displays on the "Restricted IP Address" tab as
shown in following screenshot:

Note: you can unblock a Restricted IP Address by selecting the appropriate row, and
clicking "Remove Selected."

Using the Web Membership Filter Tab
1. Navigate to the Maintenance menu, and select "Web Membership".
Result: the "Web Membership" form displays as shown in the following screenshot:
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2. Click the "User Filter" Tab located just above the "Status" area at the bottom of your
screen.

Result: the "User Filter" Tab displays.

Note: you can use the "User Filter" Tab to search based on User Name, Web Access IDs,
or E-mail addresses. You can also search for Web Membership based on the status of
being Locked Out, Not Locked Out, or Both.
3. Once the search parameters have been entered, click "Search".  
Result: your filtered search results display on the "Web Membership" form.

Audit Trail
The Audit Trail keeps a detailed log of all data entry changes made in Manitou. A
Supervisor can access and track user changes by accessing the Audit Trail form.

Accessing Audit Trail Records on the Audit Trail Form
Perform the following steps to access the Audit Trail form:

1. Navigate to the Maintenance menu, and click "Audit Trail".
Result: the Audit Trail form displays as shown in the screenshot below:
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2. Expand entries in the Navigation Tree to access specific Audit Trail records as shown
in the following screenshot:

Result: the Audit Trail record displays.

Field Descriptions for the Audit Trail Form:
· User ID – this column contains the Manitou User ID of the person who edited the

account
· Change Type – this column describes the type of change made to the account
· Category – this column indicates the type of form that was added, changed, or

deleted
· Item – this column shows the specific account or Entity added, changed , or

deleted
· Field – this column shows the specific field added, changed, or deleted. The

following screenshot shows that the Customer's address, and even more
specifically, that his street listing was changed in Manitou:

· Old Value and New Value – these two columns display the data contained in the
field prior to a change, and the data as it displays following an update

· Review ID and Review Date – these two columns show the date that changes were
reviewed, and the ID of the person who authorized the change 

· Comment – this column displays any extra information provided by the
authorizing person regarding the changed account
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Note: the status of system changes are indicated by the color in which the log line
displays. Yellow indicates an unreviewed change, and green indicates an approved
change. Red indicates a change that was reviewed, but not approved. Please note,
however, that a rejection does not automatically undo a change. To undo a change, you
must manually return to the account and reverse any changes made.

Reviewing Changes in Manitou
An SWS user with proper access can log into Manitou and review changes made by other
Manitou users. 

Perform the following steps to review changes made in Manitou:

1. Navigate to the Maintenance menu, and click "Audit Trail".
Result: the Audit Trail form displays.

2. From the "Audit Trail Review" Navigation Tree, select the Entity for whom you want
to review changes.

Result: changes made for the Entity display on the "Audit Trail Details" window as
shown in the following screenshot:

3. Select the log line for the change you want to review, and right-click it.
Result: a window displays as shown in the following screenshot:

4. Select either "Mark as Approved" or "Mark as Unapproved".
Result: your changes now display in the last three columns of the log line.
Note: you only have one opportunity to mark an item as approved or unapproved.
Marking an item as unapproved does not change the data back to its original form. You
must return and manually reverse any changes made.
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Using the Audit Trail Search Filter
The Audit Trail search form is similar to other search forms in the SWS. Users can filter
out searches by Review Code, the source of the change (such as an Operator or the
Manitou User ID), the date of the change, the contact or contact type, or the date of the
change or review.

Note: Users can only select dates in the Filter by the Review Date fields if the "Filter by
Review Date" checkbox is selected. 

Once you have set search parameters, click "Search". The search results display in the
main Audit Trail review form.

Forms in the Reports Menu
System Reports

You must define parameters before running Manitou Reports. Because every Manitou
Report is different, please refer to the documents below for instructions on the specific
Report you want to run. 

After you have set your Manitou Report parameters, you must define your Distribution
list to indicate the format in which Manitou should send your Report, and the recipients
to whom it should be sent. The instructions in this document apply to the following
Report types:

· Activity Reports
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· Custom Reports
· Maintenance Reports
· Master File Reports
· System Reports

Because the instructions for Distributing your Report are the same for all these Report
types, Report Distribution instructions are contained in this document only. Refer to the
instructions for your specific Report, and then refer to this document for Distribution
instructions.

Adding Recipients to your Report Distribution List
Perform the following steps to define your Report Distribution List:

1. After you have entered all your Report parameters on the Reports Tab, click "Next" in
the bottom-right corner of the Report form.

Result: "Distribution" Tab displays as shown in the following screenshot:



Manitou CS  Supervisor Workstation User Guide | © Copyright 2017 Bold Technologies LTD

192

2. If you want Manitou to distribute your Report to a specific person, enter the
recipient's name in the "Override recipient's name:" field.

3. Select a format in which to distribute your Report from the "Override destination
type:" dropdown menu.

Note: your options from the "Override destination type:" menu are "Fax", "E-mail", and
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"Printer".
Result: if you selected email, a dropdown menu called "Email" displays. Select "PDF",
"RTF" or "Text" as the attachment type. If you selected the fax option, the field to enter
the fax number now displays as formatted when you click in the field. Enter the
recipient's fax number (including area code).
4. Enter either a fax number or an email address for your Report recipient in the

"Override destination address (Fax/Email):" field.
5. Click "Add to list".
Result: the Report recipient you added now displays in the right window area as shown
in the following screenshot:
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6. If you want to select an Entity as a recipient for your Report, you must define the
parameters in the "Contact list destination:" area of the Distribution Tab. 

7. If you want to define a destination printer, select it from the "Default printer:"
dropdown menu.

8. Select an Entity from the "Contact list type:" dropdown menu.
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Note: your options from the "Contact list type:" dropdown menu are "Company",
"Customer", "Dealer", "Branch", "Agency", and "Authority".
Result: the Contact List Type you selected now displays in the bottom-most field.
9. Click the lookup icon to the right of the bottom-most field.
Result: the "Find" window displays for the Entity you selected as shown in the following
screenshot:

10. Enter search parameters to find the Entity you want to add as a recipient for your
Report, and click "Search".

Result: your search results display as shown in the following screenshot:
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11. Select the Entity associated with your recipient, and click "Load".
Result: the "Find" Entity window closes, and the system returns you to the
"Distribution" Tab. The Entity you selected now displays in the bottom-most field and in
the left window as shown in the following screenshot:
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12. To add the Entity to your recipient list, select it, and click the right-facing single
arrow.

Result: the Entity you added now displays in the right window recipient list as shown in
the following screenshot:
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13. If you want, select the "Show suppressed contacts" checkbox. 
14. If you want to preview your Report prior to distribution, select the "Hold for

preview" checkbox.
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15. When you have finished adding Report recipients, click "Finish" in the bottom-right
corner of the form.

Result: the "Information" window displays as shown in the following screenshot:

Accessing the Advanced Window
Some Report forms include an "Advanced" button as shown in the following screenshot:

Clicking the "Advanced" button results in the display of an Advanced Settings window
similar to the Alarm Cause Summary Advanced Settings window displayed in the
following screenshot:
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These Advanced Settings windows correspond to the "Customer user defined fields"
form in the Tools menu, under Options, and Account Creation/Maintenance.

System Administrators can use the "Customer user defined fields" form to customize the
display and functionality for the Advanced Settings window.

Activity Reports
Alarm Cause Summary

The Alarm Cause Summary Report details the causes of alarms generated during a
designated time period. Specifically, the Alarm Cause Summary Report displays the
Event Categories, Resolution Codes, and the number of genuine and false alarms
generated. 

Generating an Alarm Cause Summary Report
Perform the following steps to generate an Alarm Cause Summary Report:

1. Navigate to the Reports menu, and select "System Reports".
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Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Activity" Navigation Tree Node.
Result: the Activity section of the Navigation Tree expands as displayed in the following
screenshot:

3. Double-click the "Alarm Cause Summary" Navigation Tree Node.
Result: the "Alarm Cause Summary" Report form displays as shown in the following
screenshot:
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4. If you want, apply any of the following parameters to your Alarm Cause Summary
Report: 
· Customer ID
· Customer Name
· Dealer ID
· Authority ID
· Branch ID
· Group
· Class

5. To run an Alarm Cause Summary Report, select a beginning value from the "From:"
field and an ending value from the "To:" field. The system will report on all items in
the selected category that fit between the beginning and ending value. 

6. If you want, select options in the "Group by" area of the screen to group your Report
results by the following categories:
· Customer ID
· Customer Name
· Dealer
· Branch
· Authority
· Event Category
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Note: if you select "Event Category" for example, all of the Burglary Alarms will display
together on the Alarm Cause Summary Report.
7. If you want to define the Alarm Types that will display on your Report, select "False",

"Genuine", or "Both" from the "Alarm Type" area of the form.
8. If you want to define a Dispatch status for alarms that will display on your Report,

select "Dispatched", "Not Dispatched", or "All" from the "Dispatched" area of the form.
9. If you want to define which Authority Types were required for the alarms on your

Report, select "Police", "Fire", or "Medical" from the "Authority types required" area
of the form.

10. If you want the Alarm Summary Report you generate to display only NACOSS Events,
select the "NACOSS Events Only" checkbox. 

11. Click "Options".
Result: the "Alarm Cause Summary Options" window displays as shown in the following
screenshot:

12. All items on the "Alarm Cause Summary Options" window display as preselected.
Deselect the Event Codes, Resolution Codes, Event Categories, Customer Types, and
Monitoring Statuses that you want to exclude from your Alarm Cause Summary
Report, and click "OK".



Manitou CS  Supervisor Workstation User Guide | © Copyright 2017 Bold Technologies LTD

204

Result: the Alarm Cause Summary Options window closes, and the system returns you
to the Alarm Cause Summary form.
13. Once you have entered all the parameters for your Report, click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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14. For instructions on distributing your Report, refer to the "System Reports"
document. 

The Advanced Button
Some Report forms include an Advanced Settings button. Clicking this button results in
the display of an Advanced Settings window. Use the "Customer user defined fields"
form in the Tools menu, under Options, and Account Creation/Maintenance to
customize Report fields on Advanced Settings windows. 

For instructions on how to access and use the form, refer to the "System Reports"
document. 

Alarm Detail

The Alarm Detail report contains the alarm activity details for a single or several
Customer records. When this report is run with the defaults, the report groups by
Customer and lists each alarm in sequential order.

Generating an Alarm Detail Report
Perform the following steps to generate an Alarm Detail Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Activity" Navigation Tree Node.
Result: the Activity section of the Navigation Tree expands as displayed in the following
screenshot:
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3. Double-click the "Alarm Detail" Navigation Tree Node.
Result: the Alarm Detail Report form displays as shown in the following screenshot:
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4. If you want, apply any of the following parameters to an Alarm Detail Report: 
· Customer ID
· Customer Name
· Dealer ID
· Branch ID
· Alarm Number
· Group 
· Class
· Zip/Post 
· Date

5. To run an Alarm Detail Report, select a beginning value from the "From:" field and an
ending value from the "To:" field. The system will report on all items in the selected
category that fit between the beginning and ending value. 

6. If you want, select options in the "Dispatched" and "Output format" areas of the
screen to further narrow your Report parameters.

7. Click "Options".
Result: the "Alarm Detail Options" window displays as shown in the following
screenshot:
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12. Deselect the Event Codes, Resolution Codes, Event Categories, Customer Types, UL
Grades, and Monitoring Statuses that you want to exclude from your Alarm Detail
Report.

13. The "Customer" option in the "Group by" area of the form displays as preselected. If
you want to group your Report by Dealer or Branch, select that option instead.

14. The "Customer ID" option in the "Order by" area of the form displays as preselected.
If you want to order your Report by Customer Name, select that option instead.

15. Click "OK".
Result: the Alarm Cause Summary Options window closes, and the system returns you
to the Alarm Cause Summary form.
16. Once you have entered all the parameters for your Report, click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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17. For instructions on distributing your Report, refer to the "System Reports"
document. 

Note: the Alarm Detail report satisfies all requirements of UL 1981 Paragraph 19.8,
items a through p, which lists the requirements of an on-demand alarm report for
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non-certificated systems. See Section 7.02 - UL Alarm Ticket for more information. This
report satisfies one of the documentation and reporting requirements of UL 1981.
Please see Appendix section 7.02 - UL Required Reports for more information. 

The Advanced Button
Some Report forms include an Advanced Settings button. Clicking this button results in
the display of an Advanced Settings window. Use the "Customer user defined fields"
form in the Tools menu, under Options, and Account Creation/Maintenance to
customize Report fields on Advanced Settings windows. 

For instructions on how to access and use the form, refer to the "System Reports"
document. 

Alarm Detail by Alarm Number

The Alarm Detail by Alarm Number Report runs a Report by Alarm Number. The Alarm
Number is a unique number that combines the Customer Record Serial Number and the
Alarm Sequence Number assigned by Manitou when the alarm arrived.

When this Report is run with the default options, the Report displays grouped by
Customer and lists each alarm in sequential order.

Generating an Alarm Detail by Alarm Number Report
Perform the following steps to generate an Alarm Detail by Alarm Number Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Activity" Navigation Tree Node.
Result: the Activity section of the Navigation Tree expands as displayed in the following
screenshot:
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3. Double-click the "Alarm Detail by Alarm Number" Navigation Tree Node.
Result: the Alarm Detail by Alarm Number Report form displays as shown in the
following screenshot:

4. To run an Alarm Detail by Alarm Number Report, enter a beginning value in the
"From:" field and an ending value from the "To:" field. The system will report on all
items in the selected category that fit between the 

beginning and ending value. 
Note: The Alarm Number digits to the left of the hyphen are the Contract Serial Number.
They must be identical in the "From:" and "To:" fields.
5. Once you have entered all the parameters for your Report, click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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6. For instructions on distributing your Report, refer to the "System Reports"
document. 
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Alarm Grading

The Alarm Grading report rates various types of signals into categories and lists how
many were in and out of compliance upon you viewing them within a specified time
period for that type.
Fields and Options

· Report Description - A label for the report.
· Priority - The alarm priority level for which you want to run the report.
· Date - Select this check box to specify a date range.
· From/To - Use these fields to enter a date/time range for the report.
· Include Details - Select this check box to include details for all alarms over that

section's tolerance in the report. Selecting this option only adds alarms that exceed
the tolerance to the Details section.

· High Priority - For example, duress, hold-up, defaulted to 1 minute.
· Asset Threatening - For example, intruder, defaulted to 3 minutes.
· Subsistence Alarms - For example, battery low, defaulted to 20 minutes.
· Low Priority - For example, late-to-close, mains fail, defaulted to 60 minutes.
· Group Labels - You can use these text boxes to rename section labels in the

report.
· Monitoring Status - You can select which accounts should be included in the

report.

In the Options dialog for this report, there are lists for each of the categories, allowing
you to choose which Event Codes go into each report.
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This report is measuring time available to time first viewed.

When this report is run, it finds all the events within the time period specified, and for
each category, lists the tolerance for that category, the total number of events for that
category, how many and the percentage of events were viewed under the time
tolerance, and how many and the percentage of events that were viewed over the time
tolerance.

Alarm Resolution

The Alarm Resolution Report displays the alarms received by Manitou and the manner
in which they were resolved. The Report also displays the number of genuine and false
Alarms and the number of Authority dispatch responses for each.

Generating an Alarm Resolution Report
Perform the following steps to generate an Alarm Resolution Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Activity" Navigation Tree Node.
Result: the Activity section of the Navigation Tree expands as displayed in the following
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screenshot:

3. Double-click the "Alarm Resolution" Navigation Tree Node.
Result: the Alarm Resolution Report form displays as shown in the following
screenshot:
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4. If you want, apply any of the following parameters to your Alarm Resolution Report: 
· Customer ID
· Customer Name
· Dealer ID
· Branch ID
· Group
· Authority ID
· Date
· Time

5. To run an Alarm Resolution Report, select a beginning value from the "From:" field
and an ending value from the "To:" field. The system will report on all items in the
selected category that fit between the beginning and ending value. 

6. The options in the "Resolution Codes:" and "Monitoring status" areas of the screen
display as preselected. Deselect the options you want to exclude from your Alarm
Resolution Report.

7. Click "Options".
Result: the "Alarm Resolution Option Settings" window displays as shown in the
following screenshot:
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8. Items in the "Customer types to include:", "Event Codes:", and "Event Categories:"
areas of the screen display preselected. Deselect the options you want to exclude
from your Alarm Resolution Report.

9.  The "Both" option in the "Include:" area of the window displays as preselected. If you
want your Report to only display genuine or false alarms, select that option instead.

10. The "Detail with summary totals" option in the "Summary:" area of the window
displays as preselected. If you want your Report to display either "Detail only" or
"Summary totals only", select that option instead.

11. If you want to limit your Report by Authority response type, select an option for an
Authority response that either required police, fire, or medical. If you want to exclude
alarms that required an Authority response by police, fire, or medical, select that
option.

12. If you want to group items in your Report by Dealer or Branch, select that option
from the "Group by:" area of the window.

13. The "Customer ID" option in the "Order by:" area of the window displays as
preselected. If you want to order your Report by "Customer Name", "Resolution
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Code", or "Authority ID", select that option instead.
14. Click "OK".
Result: the Alarm Cause Summary Options window closes, and the system returns you
to the Alarm Cause Summary form.
15. Once you have entered all the parameters for your Report, click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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16. For instructions on distributing your Report, refer to the "System Reports"
document. 

The Advanced Button
Some Report forms include an Advanced Settings button. Clicking this button results in
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the display of an Advanced Settings window. Use the "Customer user defined fields"
form in the Tools menu, under Options, and Account Creation/Maintenance to
customize Report fields on Advanced Settings windows. 

For instructions on how to access and use the form, refer to the "System Reports"
document. 

Alarm Response

The Alarm Response Report displays alarm response times for Manitou Operators.

Generating an Alarm Response Report
Perform the following steps to generate an Alarm Response Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Activity" Navigation Tree Node.
Result: the Activity section of the Navigation Tree expands as displayed in the following
screenshot:
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3. Double-click the "Alarm Response" Navigation Tree Node.
Result: the Alarm Response Report form displays as shown in the following screenshot:

4. If you want, apply any of the following parameters to your Alarm Response Report: 
· Customer ID
· Customer Name
· Dealer ID
· Branch ID
· Group
· Class
· User ID
· Date
· Time

5. To run an Alarm Response Report, select a beginning value from the "From:" field and
an ending value from the "To:" field. The system will report on all items in the
selected category that fit between the beginning and ending values. 

6. If you want, enter a number in the "Minimum Response (seconds)" field to define the
minimum response time you want to include in your Report.

7. If you want, select the "Include details" checkbox to maximize the amount of
information displayed in your Report.

8. If you want, select the "Only include actioned alarms in averages" checkbox to exclude
alarms for which no action was taken.
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9. Select either "Date" or "Operator" from the "Group by" area of the screen to
determine how your Report information should be grouped.

10. Select either "First View to First Action" or "Available to First Action" to determine
how the alarm response time should be measured.

11. Items in the "Monitoring status" area of the form display as preselected. Deselect the
items you want to exclude from your Report.

12. Click "Options".
Result: the "Alarm Response Options Settings" window displays as shown in the
following screenshot:

 
13. Items in the "Event Codes" and "Event Categories" areas of the widow display as

preselected. Deselect the items you want to exclude from your Report, and click "OK".
Result: the "Alarm Response Options Settings" window closes and the system returns
the user to the Alarm Response form.
14. Once you have entered all the parameters for your Report, click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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15. For instructions on distributing your Report, refer to the "System Reports"
document. 

The Advanced Button
Some Report forms include an Advanced Settings button. Clicking this button results in
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the display of an Advanced Settings window. Use the "Customer user defined fields"
form in the Tools menu, under Options, and Account Creation/Maintenance to
customize Report fields on Advanced Settings windows. 

For instructions on how to access and use the form, refer to the "System Reports"
document. 

Customer Activity

The Customer Activity Report is the most detailed Report available for obtaining
Customer account activity information.  The Customer Activity Report includes
information on most Customer activities including opening, closing, out of service, and
comments. It excludes instances where someone accessed the Customer record only for
viewing or editing. The Customer Activity Report displays results by Contract Number,
and then by the Alarm Report Number.

Generating a Customer Activity Report
Perform the following steps to generate a Customer Activity Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Activity" Navigation Tree Node.
Result: the Activity section of the Navigation Tree expands as displayed in the following
screenshot:
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3. Double-click the "Customer Activity" Navigation Tree Node.
Result: the Customer Activity Report form displays as shown in the following
screenshot:
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4. If you want, apply any of the following parameters to your Customer Activity Report: 
· Customer ID
· Customer Name
· Dealer ID
· Branch ID
· Group
· Class
· Zip/Post
· User ID
· Area
· User No/Card No
· Date
· Time

5. To run a Customer Activity Report, select a beginning value from the "From:" field
and an ending value from the "To:" field. The system will report on all items in the
selected category that fit between the beginning and ending values. 

6. Select one of the options in the "Activity Type" area of your screen to determine the
types of Customer activity that will be included in your Report.

7. Select one of the options in the "Dispatched" area of your screen to determine
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whether the Alarms included in your Report should be limited to those for which an
Authority was dispatched.

8. Click "Options". 
Result: the "Customer Activity Options" window displays as  shown in the following
screenshot:

9. Deselect Event Codes, Event Categories, Customer types, Resolution Codes, Log
record types, and Monitoring statuses that you want to exclude from your Customer
Activity Report.

10. The "Suppress operator Id" and "Include comments not associated with an event"
items display as preselected. If you want to include the "Mail format", "Page breaks",
and "Include customers with no activity" options, select those items.

11. The "Normal" option in the "Output format" area of the window displays as
preselected. If you want to select another "Output format" item, select that item
instead.
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12. The "Customer" option in the "Group by" area of the window displays as preselected.
If you want to group your Report by "Dealer", "Branch", or "User ID", select that
option instead.

13. The "Customer ID" option in the "Order by" area of the window displays as
preselected. If you want to order your Report by "Customer Name", select that option
instead.

14. Click "OK".
Result: the "Customer Activity Options" window closes, and the system returns the user
to the Customer Activity form.
15. Once you have entered all the parameters for your Report, click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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16. For instructions on distributing your Report, refer to the "System Reports"
document. 

The Advanced Button
Some Report forms include an Advanced Settings button. Clicking this button results in
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the display of an Advanced Settings window. Use the "Customer user defined fields"
form in the Tools menu, under Options, and Account Creation/Maintenance to
customize Report fields on Advanced Settings windows. 

For instructions on how to access and use the form, refer to the "System Reports"
document. 

Daily Signals

The Daily Signals Report is similar to the Customer Activity Report with the exception of
the manner in which the results display.  While the Customer Activity Report displays
results by the Contract number and then by the Alarm Report number, the Daily Signals
Report displays results by date only. 

Generating a Daily Signals Report
Perform the following steps to generate a Daily Signals Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Activity" Navigation Tree Node.
Result: the Activity section of the Navigation Tree expands as displayed in the following
screenshot:
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3. Double-click the "Daily Signals" Navigation Tree Node.
Result: the "Daily Signals Report" form displays as shown in the following screenshot:
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4. If you want, apply any of the following parameters to your Customer Activity Report: 
· Customer ID
· Customer Name
· Dealer ID
· Branch ID
· Group
· Class

5. To run a Daily Signals Report, enter a beginning value in the "From:" field and an
ending value in the "To:" field. The system will report on all items in the selected
category that fit between the beginning and ending values. 

6. If you want, select the "Include Customer Name" checkbox to display a Customer
Name with every signal in your Report.

7. The "Include details" checkbox displays as preselected, deselect the checkbox if you
want to limit the amount of information that displays in your Report.

8. If you want to filter by contacted types, select the "Filter by Contacted Types"
checkbox option.

9. If you want to include page breaks in between Customers, select the "Page breaks"
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checkbox option.
10. Items in the "Log record types:" area of the window display as preselected. If you

want to exclude any of the listed log record types from your Report, deselect that
item.

11. Items in the "Monitoring status" area of the form display as preselected. If you want
to exclude any of the listed monitoring statuses from your Report, deselect that item.

12. The "Normal" format displays as preselected in the "Output format" area of the
window. If you want your Report to display in a "Long" or "Detail" format, select that
option instead.

13. The "Date" option displays as preselected in the "Group by" area of the window. If
you want to your Report to group by "Dealer" or "Branch", select that option instead.

14. The "Each Day" option displays as preselected in the "Summary" area of the window.
If you want no summary to display, or want  your summary to display as a "Grand
Total Only", select that option instead.

15. Click "Options".
Result: the "Daily Signals Options" window displays as shown in the following
screenshot:

16. All items in the "Event Codes:", "Event Categories:", "Contacted types:", and
"Customer types:" areas of the window display as preselected. Deselect the items that
you want to exclude from your Daily Signals Report.

17. Select any items in the "Resolution Codes:"  area of the window that you specifically
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want to include in you Daily Signals Report, and click "OK".
Result: the "Daily Signals Options" window closes and the system returns the user to
the Daily Signals form.
18. Once you have entered all the parameters for your Report, click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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19. For instructions on distributing your Report, refer to the "System Reports"
document. 

The Advanced Button
Some Report forms include an Advanced Settings button. Clicking this button results in
the display of an Advanced Settings window. Use the "Customer user defined fields"
form in the Tools menu, under Options, and Account Creation/Maintenance to
customize Report fields on Advanced Settings windows. 

For instructions on how to access and use the form, refer to the "System Reports"
document. 

Handled Signals by Operator

The Handled Signals by Operator Report is a useful management tool to view the
number of alarms Operators are handling. 

Generating a Handled Signals by Operator Report
Perform the following steps to generate a Handled Signals by Operator Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Activity" Navigation Tree Node.
Result: the Activity section of the Navigation Tree expands as displayed in the following
screenshot:
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3. Double-click the "Handled Signals by Operator" Navigation Tree Node.
Result: the "Handled Signals by Operator" form displays as shown in the following
screenshot:

4. If you want, apply any of the following parameters to your Handled Signals by
Operator Report: 
· Customer ID



System Reports 237

· Customer Name
· Dealer ID
· Branch ID
· Group
· Class
· User ID

5. To run a Handled Signals by Operator Report, enter a beginning value in the "From:"
field and an ending value in the "To:" field. The system will report on all items in the
selected category that fit between the beginning and ending values. 

6. The Date fields display as preselected. If you do not want to include a date and time
range in your Report, deselect the "Date" checkbox. Otherwise, enter a date and time
range into the "From:" and "To:" fields.

7. Items in the "Monitoring status" area of the form display as preselected. If you want
to exclude signals with any of the listed statuses from your Report, deselect the
checkbox for the status type you want to exclude.

8. Once you have entered all the parameters for your Report, click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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9. For instructions on distributing your Report, refer to the "System Reports" document.
 

The Advanced Button
Some Report forms include an Advanced Settings button. Clicking this button results in
the display of an Advanced Settings window. Use the "Customer user defined fields"
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form in the Tools menu, under Options, and Account Creation/Maintenance to
customize Report fields on Advanced Settings windows. 

For instructions on how to access and use the form, refer to the "System Reports"
document. 

Last Signal Date

The Last Signal Date Report allows a user to run a Report that displays the last date
Manitou received a signal from a Customer. 

Generating a Last Signal Date Report
Perform the following steps to generate a Last Signal Date Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Activity" Navigation Tree Node.
Result: the Activity section of the Navigation Tree expands as displayed in the following
screenshot:
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3. Double-click the "Last Signal Date" Navigation Tree Node.
Result: the "Last Signal Date" form displays as shown in the following screenshot:

4. If you want, apply any of the following parameters to your Last Signal Date Report: 
· Customer ID
· Customer Name
· Dealer ID
· Branch ID
· Group
· Class

5. To run a Last Signal Date Report, enter a beginning value in the "From:" field and an
ending value in the "To:" field. The system will report on all items in the selected
category that fit between the beginning and ending values. 

6. The Date field displays as preselected. If you do not want to designate a specific date
for your Report, deselect the "Date" checkbox. Otherwise, enter the date for which
you want to run the Report.

7. Items in the "Monitoring status" area of the form display as preselected. If you want
to exclude signals with any of the listed statuses from your Report, deselect the
checkboxes for the status types you want to exclude.

8. Items in the "Customer types:" area of the form display as preselected. If you want to
exclude any of the listed Customer types from your Report, deselect the checkboxes
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for the Customer types you want to exclude.
9. If you want to group the signals in your Report by "Dealer" or "Branch", select the

grouping you want from the "Group by" area of the form.
10. Once you have entered all the parameters for your Report, click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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11. For instructions on distributing your Report, refer to the "System Reports"
document.  

The Advanced Button
Some Report forms include an Advanced Settings button. Clicking this button results in
the display of an Advanced Settings window. Use the "Customer user defined fields"
form in the Tools menu, under Options, and Account Creation/Maintenance to
customize Report fields on Advanced Settings windows. 

For instructions on how to access and use the form, refer to the "System Reports"
document. 

Signal Count by Customer

The Signal Count by Customer Report details the number of signals, ignored signals, and
alarms received for each Customer. An ignored signal is one that was ignored by
Manitou (for e.g., when utilizing a programming feature such as Entry/Exit delay). 

Generating a Signal Count by Customer Report
Perform the following steps to generate a Signal Count by Customer Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Activity" Navigation Tree Node.
Result: the Activity section of the Navigation Tree expands as displayed in the following
screenshot:



System Reports 243

3. Double-click the "Signal Count by Customer" Navigation Tree Node.
Result: the "Signal Count by Customer" form displays as shown in the following
screenshot:

4. If you want, apply any of the following parameters to your Signal Count by Customer
Report: 
· Customer ID
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· Customer Name
· Dealer ID
· Branch ID
· Group
· Class

5. To run a Signal Count by Customer Report, enter a beginning value in the "From:"
field and an ending value in the "To:" field. The system will report on all items in the
selected category that fit between the beginning and ending values. 

6. The Date fields display as preselected. If you do not want to designate a specific date
and time range for your Report, deselect the "Date" checkbox. Otherwise, enter the
date and time range for which you want to run the Report.

7. Items in the "Monitoring status" area of the form display as preselected. If you want
to exclude signals with any of the listed statuses from your Report, deselect the
checkboxes for the status types you want to exclude.

8. If you want to define the minimum number of signals for a Customer to include in
your Report, select that minimum number in the "Minimum no. of signals/customer"
field.

Note: if you select a number bigger than the number of signals your Customer received
during the date and time range you designated, Manitou will exclude these Customer
signals from your Report.
9. Click "Options".
Result: the "Signal Count by Customer Options" window displays as shown in the
following screenshot:
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10. Deselect the Event Codes, Event Categories, and Log Record Types that you want to
exclude from your Signal Count by Customer Report.

11. If you want to group your Report results by Customer, Dealer, or Branch, select the
option you want from the "Group by" area of the window.

12. If you want to order your Report results by Customer ID or Customer Name, select
that option from the "Order by" area of the window, and click "OK".

Result: the Signal Count by Customer Options window closes, and the system returns
you to the Signal Count by Customer form.
13. Once you have entered all the parameters for your Report, click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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14. For instructions on distributing your Report, refer to the "System Reports"
document.  

The Advanced Button
Some Report forms include an Advanced Settings button. Clicking this button results in
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the display of an Advanced Settings window. Use the "Customer user defined fields"
form in the Tools menu, under Options, and Account Creation/Maintenance to
customize Report fields on Advanced Settings windows. 

For instructions on how to access and use the form, refer to the "System Reports"
document. 

UL Response

The UL Response Report typically is for Alarm Investigators, these will be persons of an
Agency. The person subtype that represents “runner” (for which the report will be
looking for) is set as one of the two options. The other option is the minimum alarm
priority level that requires a UL Runner.

“D-N-A” on a report stands for “Did Not Arrive.” This means that the alarm should have
had a runner (investigator), but sent none to Manitou. Therefore, “***” for the Average
will be shown when there is one or more D-N-A’s since that average cannot be
calculated.

Notes:

· You can set the Priority from 1 – 9 with 1 being the highest priority.
· You need to add an Agency to the customer that has at least one person of type

“runner”.

To set up this report option, do the following:

1. Open the Manitou Supervisor Workstation and click, Tools | Options | Reports.

There are two associated options. The first one that needs to be set is Person
Subtype that Represents an Agency Investigator (Runner). This subtype
number will need to correspond to a Keyholder Type.

2. Click Maintenance | Setup | Subtypes | Keyholder Types in the Manitou
Supervisor Workstation.

This is the Subtype that you need to associate with a contact on the Agency.
When you contact this person or entity to Dispatch, On Location, Clear, it will
correspond to the times in the report.

3. To set the Priority as noted in the first bullet (“Notes” above), you need to set that
in the Manitou Supervisor Workstation as well. Click Tools | Options | Reports |
Minimum Alarm Priority for UL Response Report.
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By putting 9 (the lowest priority) then all alarms priority level 1 – 9 will be
included in the report.

Generating a UL Response Report

To configure and run the UL Response Report, do the following:

1. Click Reports | System Reports | Activity | UL Response.

2. Enter/select parameters as needed.

Note: The Date checkbox is preselected. If you do not want to designate a
specific date and time range for your Report, clear the Date checkbox.
Otherwise, enter the date and time range for which you want to run the
Report.

3. If you want, select the Include Details checkbox to maximize the amount of
information displayed in your Report.

4. Click Options. The UL Response Options Settings window appears.

5. Select/clear options as needed and then click OK. You return to the UL Response
form.

6. Click Next. The Distribution tab appears. For instructions on distributing your
Report, refer to System Reports. 

The Advanced Button
Some report forms include an Advanced settings button. Clicking this button results
in the display of an Advanced Settings window. Use the Customer User Defined
Fields form (click Tools | Options | Account/Creation Maintenance) to customize
report fields on Advanced Settings windows. 

For instructions on how to access and use the form, refer to System Reports. 
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Unrestored Signals

The Unrestored Signals Report is typically run to verify if alarms received a restore
signal, or if the account requires maintenance in order to clear out closed, but
unrestored, alarms. The Report lists all alarms that are in Restore Required status, but
have not yet been restored. 

Generating an Unrestored Signals Report
Perform the following steps to generate an Unrestored Signals Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:
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2. Click the "Activity" Navigation Tree Node.
Result: the Activity section of the Navigation Tree expands as displayed in the following
screenshot:

3. Double-click the "Unrestored Signals" Navigation Tree Node.
Result: the "Unrestored Signals" form displays as shown in the following screenshot:



System Reports 251

4. If you want, apply any of the following parameters to your Unrestored Signals
Report: 
· Customer ID
· Customer Name
· Dealer ID
· Branch ID
· Group
· Class

5. To run an Unrestored Signals Report, enter a beginning value in the "From:" field and
an ending value in the "To:" field. The system will report on all items in the selected
category that fit between the beginning and ending values. 

6. The Date fields display as preselected. If you do not want to designate a specific date
and time range for your Report, deselect the "Date" checkbox. Otherwise, enter the
date and time range for which you want to run the Report.

7. If you want to group the signals in your Report by Customer, Dealer, or Branch, select
the grouping you want from the "Group by" area of the form.

8. If you want to order your Report items by Date, Customer ID, or Customer Name,
select the order you want from the "Order by" area of the form.

9. If you want to define the minimum number of minutes the signal has remained
unrestored, select that minimum number in the "Minimum number of minutes
unrestored:" field.

Note: ten minutes is the default minimum number of minutes the signal has remained
unrestored. If you select a number bigger than the number of minutes a signal has
remained unrestored, that signal will not display in your Report.
10. Click "Options".
Result: the "Unrestored Signals Options" window displays as shown in the following
screenshot:
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11. Deselect the Event Codes, Event Categories, and Monitoring Statuses that you want
to exclude from your Unrestored Signals Report, and click "OK".

Result: the Unrestored Signals Options window closes, and the system returns you to
the Unrestored Signals form.
12. Once you have entered all the parameters for your Report, click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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13. For instructions on distributing your Report, refer to the "System Reports"
document.  

The Advanced Button
Some Report forms include an Advanced Settings button. Clicking this button results in
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the display of an Advanced Settings window. Use the "Customer user defined fields"
form in the Tools menu, under Options, and Account Creation/Maintenance to
customize Report fields on Advanced Settings windows. 

For instructions on how to access and use the form, refer to the "System Reports"
document. 

User History

The User History Report displays Operator login and logoff information. 

Generating a User History Report
Perform the following steps to generate a User History Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Activity" Navigation Tree Node.
Result: the Activity section of the Navigation Tree expands as displayed in the following
screenshot:
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3. Double-click the "User History" Navigation Tree Node.
Result: the "User History" form displays as shown in the following screenshot:

5. The Date fields display as preselected. If you do not want to designate a specific date
and time range for your Report, deselect the "Date" checkbox. Otherwise, enter the
date and time range for which you want to run the Report.

6. The Operator checkboxes display as preselected. Deselect the checkboxes for
Operators you want to exclude from your Report.

7. If you want your Report to include all the history for an Operator for the date and
time range you designated, select "All" from the "Include:" area of the form. If you
want to include logon or logoff information only, select the "Logon" or "Logoff"
checkboxes, instead.
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8. Once you have entered all the parameters for your Report, click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:

9.  For instructions on distributing your Report, refer to the "System Reports"
document.  
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Custom Reports
Dealer Billing Deferred Revenue

The Dealer Billing Deferred Revenue can be tracked once enhanced billing is licensed.
The Dealer Billing Deferred Revenue Report displays deferred revenue adjustments. The
deferred revenue adjustments then must be manually entered into the accounting
software. 

Generating a Dealer Billing Deferred Revenue Report
Perform the following steps to generate a Dealer Billing Deferred Revenue Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Custom" Navigation Tree Node.
Result: the Custom section of the Navigation Tree expands as displayed in the following
screenshot:
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3. Double-click the "Dealer Billing Deferred Revenue" Navigation Tree Node.
Result: the Dealer Billing Deferred Revenue Report form displays as shown in the
following screenshot:
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4. To run a Dealer Billing Deferred Revenue Report, select a beginning Dealer ID value
from the "From:" field and an ending value from the "To:" field. The system will report
on all items that fit between the beginning and ending value. 

5. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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6.  For instructions on distributing your Report, refer to the "System Reports"
document. 
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Dealer Billing Generate

Generating a Dealer Billing Generate Report

Note: the Customer Signal Count Generator Report must be run before the Dealer Billing
Generate Report in order to generate activity-based charges.

Perform the following steps to generate a Dealer Billing Generate Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Custom" Navigation Tree Node.
Result: the Custom section of the Navigation Tree expands as displayed in the following
screenshot:
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3. Double-click the "Dealer Billing Generate" Navigation Tree Node.
Result: the Dealer Billing Generate Report form displays as shown in the following
screenshot:
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4. To run a Dealer Billing Generate Report, select a beginning Dealer ID value from the
"From:" field and an ending value from the "To:" field. The system will report on all
items that fit between the beginning and ending value. 

5. If you want, select the "Prorate Date Limit" checkbox and select a proration end date
from the dropdown menu. 

6. Note: selecting the Prorate Date Limit option ensures that any recurring monthly
charges provided for less than a full month will not be prorated after the date you
indicate.

7. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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8.  For instructions on distributing your Report, refer to the "System Reports"
document. 
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Dealer Billing Post

Once you have run the Dealer Billing Preview Report, running the Dealer Billing Post
Report is the last step required to post the Dealer billing to the accounting system.

Generating a Dealer Billing Post Report
Perform the following steps to generate a Dealer Billing Post Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Custom" Navigation Tree Node.
Result: the Custom section of the Navigation Tree expands as displayed in the following
screenshot:



Manitou CS  Supervisor Workstation User Guide | © Copyright 2017 Bold Technologies LTD

266

3. Double-click the "Dealer Billing Post" Navigation Tree Node.
Result: the Dealer Billing Post Report form displays as shown in the following
screenshot:
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4. The "Invoice Date" checkbox displays as preselected. Select the invoice date from the
dropdown menu, and click "Next". 

Note: selecting an invoice date will post the Dealer billing to that exact date in the
accounting software. 
Result: the Distribution Tab displays as shown in the following screenshot:
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5. For instructions on distributing your Report, refer to the "System Reports" document.
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Dealer Billing Preview

The Dealer Billing Preview Report lists all transactions that are ready to be posted to the
accounting system for Dealer billing. The Dealer Billing Preview Report can be run as
many times as needed. It should be the last report run before running the Dealer Billing
Post Report. 

Generating a Dealer Billing Preview Report
Perform the following steps to generate a Dealer Billing Preview Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Custom" Navigation Tree Node.
Result: the Custom section of the Navigation Tree expands as displayed in the following
screenshot:
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3. Double-click the "Dealer Billing Preview" Navigation Tree Node.
Result: the Dealer Billing Preview Report form displays as shown in the following
screenshot:
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4. If you want, apply any of the following parameters to your Dealer Billing Preview
Report: 
· Dealer ID
· Customer ID
· Customer Name

5. To run a Dealer Billing Preview Report, enter a beginning value in the "From:" field
and an ending value in the "To:" field. The system will report on all items in the
selected category that fit between the beginning and ending values.

6. If you want to order your Report by Customer, Charge Type, or Billing Code, select
that option from the "Order by" area of the form.

7. If you want to designate that your Report be generated in a compact or mailable
format, or that there be a page break inserted between Dealers, select that option
from the "Order by" area of the form.

8. The "Details" checkbox in the "Dealer" area of the form displays as preselected. If you
want, select the "Charge Type Summary" and "Billing Code Summary" checkboxes.

9. The "Total Amount" checkbox in the "Grand Totals" area of the form displays as
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preselected. If you want, select the "Charge Type Summary" and "Billing Code
Summary" checkboxes.

10. Once you have entered all the parameters for your Report, click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:

11. For instructions on distributing your Report, refer to the "System Reports"
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document.  

Dealer Excess Billing

Generating a Dealer Excess Billing Report
Perform the following steps to generate a Dealer Excess Billing Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Custom" Navigation Tree Node.
Result: the Custom section of the Navigation Tree expands as displayed in the following
screenshot:
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3. Double-click the "Dealer Excess Billing" Navigation Tree Node.
Result: the Dealer Billing Post Report form displays as shown in the following
screenshot:
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4. To run a Dealer Excess Billing Report, enter a beginning value in the "From:" field and
an ending value in the "To:" field. The system will report on all items for the Dealer ID
that fit between the beginning and ending values. 

5. If you want, select the "Include Non-Overage Customers" checkbox, and click "Next".
Result: the Distribution Tab displays as shown in the following screenshot:
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6. For instructions on distributing your Report, refer to the "System Reports" document.
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Dealer Signal Count

Generating a Dealer Signal Count Report
Perform the following steps to generate a Dealer Signal Count Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Custom" Navigation Tree Node.
Result: the Custom section of the Navigation Tree expands as displayed in the following
screenshot:
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3. Double-click the "Dealer Signal Count" Navigation Tree Node.
Result: the Dealer Signal Count Report form displays as shown in the following
screenshot:
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4. To run a Dealer Signal Count Report, enter a beginning value in the "From:" field and
an ending value in the "To:" field. The system will report on all items for the Dealer ID
that fit between the beginning and ending values. 

5. Click "Next".
Result: the Distribution Tab displays as shown in the following screenshot:
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6. For instructions on distributing your Report, refer to the "System Reports" document.
 

Customer Signal Count Generator

Run the Customer Signal Count Generator Report before the Dealer Billing Generate
Report in order to generate activity-based charges. 
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Generating a Customer Signal Count Generator Report
Perform the following steps to generate a Customer Signal Count Generator Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Custom" Navigation Tree Node.
Result: the Custom section of the Navigation Tree expands as displayed in the following
screenshot:
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3. Double-click the "Customer Signal Count Generator" Navigation Tree Node.
Result: the Customer Signal Count Generator Report form displays as shown in the
following screenshot:
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4. To run a Customer Signal Count Generator Report, enter a beginning value in the
"From:" field and an ending value in the "To:" field. The system will report on all
items for the date and time range that fit between the beginning and ending values. 

Note: the "Date" checkbox displays as preselected.
5. Click "Next".
Result: the Distribution Tab displays as shown in the following screenshot:
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6. For instructions on distributing your Report, refer to the "System Reports" document.
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Maintenance Reports
Access Control Card Lookup

The Access Control Card Lookup report provides a list of specific Access Control Cards
detailed in one Report. This list may be useful as a scheduled Report for Customers who
utilize Access Control to view when employees have accessed the building. 

Generating an Access Control Card Lookup Report
Perform the following steps to generate an Access Control Card Lookup Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Maintenance" Navigation Tree Node.
Result: the Maintenance section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Access Control Card Lookup".
Result: the Access Control Card Lookup form displays as shown in the following
screenshot:

4. If you want, apply any of the following parameters to your Access Control Card
Lookup Report: 
· Customer ID
· Customer Name
· Dealer ID
· Branch ID
· Group
· Class

5. To run an Access Control Card Lookup Report, enter a beginning value in the "From:"
field and an ending value in the "To:" field. The system will report on all items in the
selected category that fit between the beginning and ending values. 

6. If you want to designate a Last Access date and time range for your Report, select the
"Last Access" checkbox, and enter the date and time range. 

7. Items in the "Monitoring status" area of the form display as preselected. If you want
to exclude any of the listed statuses from your Report, deselect the checkboxes for the
status types you want to exclude.

8. If you want to group the signals in your Report by "Dealer" or "Branch", select the
grouping you want from the "Group by" area of the form.

9. "Customer ID" displays as preselected in the "Order by:" area of the form. If you want
to order your Report by Customer Name, select the "Customer Name" option instead.
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10. Once you have entered all the parameters for your Report, click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:

11. For instructions on distributing your Report, refer to the "System Reports"
document.  
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The Advanced Button
Some Report forms include an Advanced Settings button. Clicking this button results in
the display of an Advanced Settings window. Use the "Customer user defined fields"
form in the Tools menu, under Options, and Account Creation/Maintenance to
customize Report fields on Advanced Settings windows. 

For instructions on how to access and use the form, refer to the "System Reports"
document. 

Access Control Cards/Pins

Run an Access Control Cards/Pins Report if you want to view a detailed list of
employees at a site with Access Control Cards or Pin Numbers. The Access Control
Cards/Pins Report includes the Transmitter ID, the Card ID, the name of the person
entrusted with the Card, the Card ID, and the Card Type. 

Generating an Access Control Cards/Pins Report
Perform the following steps to generate an Access Control Cards/Pins Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Maintenance" Navigation Tree Node.
Result: the Maintenance section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click the "Access Control Cards/Pins" icon.
Result: the Access Control Cards/Pins form displays as shown in the following
screenshot:

4. If you want, apply any of the following parameters to your Access Control Cards/Pins
Report: 
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· Customer ID
· Customer Name
· Dealer ID
· Branch ID
· Group
· Class

5. To run an Access Control Cards/Pins Report, enter a beginning value in the "From:"
field and an ending value in the "To:" field. The system will report on all items in the
selected category that fit between the beginning and ending values. 

6. If you want to designate a Last Access date and time range for your Report, select the
"Last Access" checkbox, and enter the date and time range. 

7. If you want to maximize the amount of information that displays in your Report,
select the "Include Details" checkbox.

8. Items in the "Monitoring status" area of the form display as preselected. If you want
to exclude any of the listed statuses from your Report, deselect the checkboxes for the
status types you want to exclude.

9. If you want to group the signals in your Report by "Dealer" or "Branch", select that
grouping option from the "Group by" area of the form.

10. "Customer ID" displays as preselected in the "Order by:" area of the form. If you want
to order your Report by "Customer Name" instead of "Customer ID", select the
"Customer Name" option.

11.  Once you have entered all the parameters for your Report, click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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12. For instructions on distributing your Report, refer to the "System Reports"
document.  

The Advanced Button
Some Report forms include an Advanced Settings button. Clicking this button results in
the display of an Advanced Settings window. Use the "Customer user defined fields"
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form in the Tools menu, under Options, and Account Creation/Maintenance to
customize Report fields on Advanced Settings windows. 

For instructions on how to access and use the form, refer to the "System Reports"
document. 

ASAP Validate

Customers can subscribe to the Automated Secure Alarm Protocol (ASAP) service. ASAP
validations occur when Manitou confirms that it has the same Customer address
information as the Public Safety Access Point (PSAP). The ASAP Validate Report displays
errors and validation attempts for all ASAP communications.

Generating an ASAP Validate Report

Note: we strongly recommend contacting your PSAP before running this Report. 

Perform the following steps to generate an ASAP Validate Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Maintenance" Navigation Tree Node.
Result: the Maintenance section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "ASAP Validate".
Result: the "ASAP Validate" form displays as shown in the following screenshot:
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4. If you want, apply any of the following parameters to your ASAP Validate Report: 
· Customer ID
· Dealer ID
· Branch ID
· Authority ID

5. To run an ASAP Validate Report, enter a beginning value in the "From:" field and an
ending value in the "To:" field. The system will report on all items in the selected
category that fit between the beginning and ending values. 

6. The "Errors Only" option in the "Include Option" area of the form displays as
preselected. If you want your Report to display all ASAP validation attempts rather
than just errors, select the "All Validation Attempts" option.

7. Once you have entered all the parameters for your Report, click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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8. For instructions on distributing your Report, refer to the "System Reports" document.
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Audit Trail

Generating an Audit Trail Report
Perform the following steps to generate an Audit Trail Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Maintenance" Navigation Tree Node.
Result: the Maintenance section of the Navigation Tree expands as displayed in the
following screenshot:

3. Double-click "Audit Trail".
Result: the "Audit Trail" form displays as shown in the following screenshot:



System Reports 297

4. If you want, apply any of the following parameters to your Audit Trail Report: 
· User ID
· Reviewer ID
· Contact Type
· Dealer ID
· Branch ID
· Customer ID
· Global Keyholder ID
· Agency ID
· Authority ID

5. To run an Audit Trail Report, enter a beginning value in the "From:" field and an
ending value in the "To:" field. The system will report on all items in the selected
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category that fit between the beginning and ending values. 
6. The "Event Date" option displays as preselected. Enter an Event date and time range

for the Event in the "To:" and "From:" fields.
7. If you want, select the "Review Date" checkbox and enter a Review Date and time

range in the "To:" and "From:" fields.
8. Click "Options".
Result: the "Audit Trail Options..." window displays as shown in the following
screenshot:

9.  Deselect items in the "Source", "Change Type", "Review Code", and "Category" areas
of the window that you want to exclude from your Audit Trail Options Report, and
click "OK".

Result: the Audit Trail Options window closes, and the system returns you to the Audit
Trail form.
10. Once you have entered all the parameters for your Report, click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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11. For instructions on distributing your Report, refer to the "System Reports"
document.  
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Billing Reconciliation

Generating a Billing Reconciliation Report
Perform the following steps to generate a Billing Reconciliation Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Maintenance" Navigation Tree Node.
Result: the Maintenance section of the Navigation Tree expands as displayed in the
following screenshot:

3. Double-click "Billing Reconciliation".
Result: the "Billing Reconciliation" form displays as shown in the following screenshot:
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4. If you want, apply any of the following parameters to your Billing Reconciliation
Report: 
· Dealer ID
· Branch ID
· Customer ID
· Customer Name

5. To run a Billing Reconciliation Report, enter a beginning value in the "From:" field
and an ending value in the "To:" field. The system will report on all items in the
selected category that fit between the beginning and ending values. 

6. If you want your Report to include a reverse check of billing discrepancies from your
accounting software to Manitou, select the "Include reverse check from accounting to
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Manitou CS" checkbox option.
7. If you want your Report to include accounts with inactive billing, select the "Include

Inactive" checkbox option.
8. If you want your Report to include errors only, select the "Errors Only" checkbox

option.
9. Once you have entered all the parameters for your Report, click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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10. For instructions on distributing your Report, refer to the "System Reports"
document.  
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Customer Add/Delete

Generating a Customer Add/Delete Report
Perform the following steps to generate a Customer Add/Delete Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Maintenance" Navigation Tree Node.
Result: the Maintenance section of the Navigation Tree expands as displayed in the
following screenshot:

3. Double-click "Customer Add/Delete".
Result: the "Customer Add/Delete" form displays as shown in the following screenshot:
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4. If you want, apply either of the following parameters to your Customer Add/Delete
Report: 
· Dealer ID
· Branch ID

5. To run a Customer Add/Delete Report, enter a beginning value in the "From:" field
and an ending value in the "To:" field. The system will report on all items in the
selected category that fit between the beginning and ending values. 

6. The "Include details" checkbox displays as preselected. If you want to limit the
amount of information that displays in your Report, deselect the "Include details"
checkbox option.

7. If you want, select the "Current Customer Name" checkbox option. 
8. The "All" checkbox in the "Include:" area of the window displays as preselected. If you

want you want to limit your Report to only "Adds" or "Deletes", select that option
instead.

9. The "By Date" checkbox in the "Summary:" area of the window displays as
preselected. If you want your Report results to be summarized "By Dealer" or "By
Branch", select that option instead.

10. Once you have entered all the parameters for your Report, click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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11. For instructions on distributing your Report, refer to the "System Reports"
document.  
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Customers with Transmitter Type

Generating a Customer with Transmitter Type Report
Perform the following steps to generate a Customer with Transmitter Type Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Maintenance" Navigation Tree Node.
Result: the Maintenance section of the Navigation Tree expands as displayed in the
following screenshot:

3. Double-click "Customers with Transmitter Type".
Result: the "Customers with Tx Type" form displays as shown in the following
screenshot:
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4. If you want, apply any of the following parameters to your Customers with
Transmitter Type Report: 
· Transmitter Type
· Customer ID
· Customer Name
· Dealer ID
· Branch ID
· Group
· Class

5. To run a Customers with Transmitter Type Report, enter a beginning value in the
"From:" field and an ending value in the "To:" field. The system will report on all
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items in the selected category that fit between the beginning and ending values. 
6. All the items in the "Rec Line Prefix" and "Monitoring status" areas of the window

display as preselected. If you want to limit which of these items to include in your
Report, deselect the items you want to exclude.

7. Click "Options".
Result: the "Customers With Tx Type Options" window displays as shown in the
following screenshot:

8. If you want to group items in your Report by "Dealer" or "Branch", select that item
from the "Group by" area of the window.

9. The "Customer ID" option displays as preselected in the "Order by" area of the
window. If you want to order your Report by "Customer Name", select that option
instead.

10. Click "OK".
Result: the "Options" window closes and the system returns you to the "Customers with
Tx Type" form.
11. Once you have entered all the parameters for your Report, click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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12. For instructions on distributing your Report, refer to the "System Reports"
document.  

The Advanced Button
Some Report forms include an Advanced Settings button. Clicking this button results in
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the display of an Advanced Settings window. Use the "Customer user defined fields"
form in the Tools menu, under Options, and Account Creation/Maintenance to
customize Report fields on Advanced Settings windows. 

For instructions on how to access and use the form, refer to the "System Reports"
document. 

Maintenance Issues

Generating a Maintenance Issues Report
Perform the following steps to generate a Maintenance Issues Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Maintenance" Navigation Tree Node.
Result: the Maintenance section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Maintenance Issues".
Result: the "Maintenance Issues" form displays as shown in the following screenshot:

4. If you want, apply any of the following parameters to your Maintenance Issues
Report: 

· Customer ID
· Name
· Dealer ID
· Branch ID
· Group
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· Class

5. To run a Maintenance Issues Report, enter a beginning value in the "From:" field and
an ending value in the "To:" field. The system will report on all items in the selected
category that fit between the beginning and ending values.

6. If you want to run your Report by log date, select the "Log Date" checkbox and enter a
date and time range.

7. If you want to run your Report by last action date, select the "Last Action Date"
checkbox and enter a date and time range.

8. If you want to run your Report by the date on which the issue was resolved, select the
"Resolved Date" checkbox and enter a date and time range.

9. If you want to run your Report by the technician appointment date, select the
"Appointment Date" checkbox and enter a date and time range.

10.If you want to maximize the amount of information that displays in your Report,
select the "Include maintenance log" checkbox.

11. Items in the "Types to include:", "Resolution:", "User ID:", "On Site:", "Priority:",
"Service Type:", and "Technician:" areas of the form display as preselected. If you
want, deselect the items you want to exclude from your Report.

12. Only the "New" and "Unresolved" checkboxes display as preselected in the
"Resolution:" area of the form. If you want, select the "Resolved" checkbox to include
resolved issues, as well. 

13. Click "Options".
Result: the "Maintenance Issues Options" window displays as shown in the following
screenshot:

13. All the options in the "Monitoring status" area of the window display as preselected.
Deselect any items you want to exclude from your Report.

14. The "Contact ID" option in the "Order by" area of the window displays preselected. If
you want to order your Report by "Contact Name", select that

option instead.
15. Click "OK".
Result: the "Options" window closes and the system returns you to the "Maintenance
Issues" form.
16. Once you have entered all the parameters for your Report, click the "Next" button
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located in the bottom-right corner of the form. 
Result: the Distribution Tab displays as shown in the following screenshot:

17. For instructions on distributing your Report, refer to the "System Reports"
document.  
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The Advanced Button
Some Report forms include an Advanced Settings button. Clicking this button results in
the display of an Advanced Settings window. Use the "Customer user defined fields"
form in the Tools menu, under Options, and Account Creation/Maintenance to
customize Report fields on Advanced Settings windows. 
For instructions on how to access and use the form, refer to the "System Reports"
document. 

Permit Exception

A Permit Exception occurs when an Authority requires a permit and the Customer
cannot produce it. 

Generating a Permit Exception Report
Perform the following steps to generate a Permit Exception Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Maintenance" Navigation Tree Node.
Result: the Maintenance section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Permit Exception".
Result: the "Permit Exception" form displays as shown in the following screenshot:
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4. If you want, apply any of the following parameters to your Permit Exception Report: 
· Customer ID
· Customer Name
· Dealer ID
· Branch ID
· Group
· Class
· Authority ID

5. To run a Permit Exception Report, enter a beginning value in the "From:" field and an
ending value in the "To:" field. The system will report on all items in the selected
category that fit between the beginning and ending values.

6. If you want to run your Report by status date, select the "Status Date" checkbox and
enter a date and time range.

7. Items in the "Authority types to include:" area of the form display as preselected. If
you want, deselect the items you want to exclude from your Report.

8. The "Customer ID" option displays as preselected in the "Order by" area of the form. If
you want to order your Report by "Customer Name", "Dealer ID", "Dealer Name", or
"Branch", select that option instead.

9. Only the "Pending" and "Active" checkboxes display as preselected in the "Monitoring
status" area of the form. If you want, select the "Inactive" checkbox to include that
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status, as well. 
10. Click "Options".
Result: the "Permit Exceptions Options" window displays as shown in the following
screenshot:

11. The "Customer" option displays as preselected in the "Group by" area of the window.
If you want to order your Report by "Dealer" or "Branch", select that option instead.

12. The "Customer ID" option displays as preselected in the "Order by" area of the
window. If you would rather order your Report by "Customer Name", select that
option instead. 

13. Click "OK".
Result: the "Permit Exception Options" window closes and the system returns you to
the "Permit Exceptions" form.
14. Once you have entered all the parameters for your Report, click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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15. For instructions on distributing your Report, refer to the "System Reports"
document. 
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Permit Expiration

The Permit Expiration Report lists all expired Police, Fire, and Medical permits.  Once a
permit expires, Authorities may not respond if the permit is not properly renewed.
Because each Central Station has different policies regarding permit usage, your Central
Station must decide if this Report is necessary for you.

Generating a Permit Expiration Report
Perform the following steps to generate a Permit Expiration Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Maintenance" Navigation Tree Node.
Result: the Maintenance section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Permit Expiration".
Result: the "Permit Expiration" form displays as shown in the following screenshot:

4. If you want, apply any of the following parameters to your Permit Expiration Report: 
· Customer ID
· Customer Name
· Dealer ID
· Branch ID
· Group
· Class
· Authority ID

5. To run a Permit Expiration Report, enter a beginning value in the "From:" field and an
ending value in the "To:" field. The system will report on all items in the selected
category that fit between the beginning and ending values.

6. If you want to run your Report by expiration date, select the "Expiration date"
checkbox and enter a date and time range.

7. Items in the "Authority types to include:" area of the form display as preselected. If
you want, deselect the items you want to exclude from your Report.

8. Items in the "Customer types to include:" area of the form display as preselected. If
you want, deselect the items you want to exclude from your Report.

9. Click "Options".
Result: the "Permit Expiration Options" window displays as shown in the following
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screenshot:

10. If you want to group your Report by "Dealer", "Branch", or "Authority type", select
that option in the "Group by" area of the form.

11. The "Expiration date" option in the "Order by:" area of the form displays as
preselected. If you want to order your Report by "Customer ID" or "Customer name",
select that option instead.

12. All the options in the "Monitoring status" area of the form display as preselected. If
you want, deselect the items you want to exclude from your Report.

13. Click "OK".
Result: the "Permit Expiration Options" window closes and the system returns you to
the "Permit Expiration" form.
14. Once you have entered all the parameters for your Report, click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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15. For instructions on distributing your Report, refer to the "System Reports"
document.  

The Advanced Button
Some Report forms include an Advanced Settings button. Clicking this button results in
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the display of an Advanced Settings window. Use the "Customer user defined fields"
form in the Tools menu, under Options, and Account Creation/Maintenance to
customize Report fields on Advanced Settings windows. 

For instructions on how to access and use the form, refer to the "System Reports"
document. 

Where Used On Contact List

The Where Used on Contact List Report produces a list of the Customer, Dealer, Branch,
Authority, and Agency, records where the selected Entity displays on the Contact List. 

Generating a Where Used on Contact List Report
Perform the following steps to generate a Where Used on Contact List Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Maintenance" Navigation Tree Node.
Result: the Maintenance section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Where Used on Contact List".
Result: the "Where Used on Contact List" form displays as shown in the following
screenshot:
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4. Select a contact type from the "Contact type" dropdown menu.
5. Enter a contact ID in the "Contact ID" field, and click "Next".
Result: the Distribution Tab displays as shown in the following screenshot:



System Reports 327

6. For instructions on distributing your Report, refer to the "System Reports" document.
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Master File Reports
Access Control Card Formats

Generating an Access Control Card Formats Report
Perform the following steps to generate an Access Control Card Formats Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Access Control Card Formats".
Result: the "Access Control Card Formats" form displays as shown in the following
screenshot:



Manitou CS  Supervisor Workstation User Guide | © Copyright 2017 Bold Technologies LTD

330

 
4. Enter format numbers in the "Format Number" fields. To run an Access Control Card

Formats Report, enter a beginning value in the "From:" field and an ending value in
the "To:" field. The system will report on all items that fit between the beginning and
ending values. 

Note: if no format number is entered, the Report lists all Access Control Card formats. 
5. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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6. For instructions on distributing your Report, refer to the "System Reports" document.
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Accounting Companies

The Accounting Companies Report lists all Accounting Companies linked to Manitou, the
direction it is linked (for instance, Accounting to Manitou), as well as the DSN, username
password and server associated with the particular accounting company. 

Generating an Accounting Companies Report
Perform the following steps to generate an Accounting Companies Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Accounting Companies".
Result: the "Accounting Companies" form displays as shown in the following
screenshot:
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4. Enter a Company ID in the "Company ID" field. To run an Accounting Company

Report, enter a beginning value in the "From:" field and an ending value in the "To:"
field. The system will report on all items that fit between the beginning and ending
values. 

5. Items in the "Accounting Company Type" area of the form display as preselected. If
you want, deselect the items you want to exclude from your Report.

6. Items in the "Direction of Interface In List" area of the form display as preselected. If
you want, deselect the items you want to exclude from your Report.

7. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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8. For instructions on distributing your Report, refer to the "System Reports" document.
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Agency Master File

The Agency Master File Report displays details for Manitou Agencies. Users can select
specific Agencies and customize the level of detail that displays in the Report.

Generating an Agency Master File Report
Perform the following steps to generate an Agency Master File Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Agency Master File".
Result: the "Agency Master File" form displays as shown in the following screenshot:
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4. If you want, apply any of the following parameters to your Agency Master File
Report: 
· Agency ID
· Agency Name
· City
· Region

5. To run an Agency Master File Report, enter a beginning value in the "From:" field and
an ending value in the "To:" field. The system will report on all items that fit between
the beginning and ending values. 

6. If you want, select the "Mail format" checkbox. 
7. If you want to prevent passwords from displaying in your Report, select the

"Suppress passwords" checkbox.
8. If you want your Report to display page breaks between Agency listings, select the

"Page breaks" checkbox.
9. Click "Options".
Result: the "Agency Master File Options" window displays as shown in the following
screenshot:
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10. Items in the "Sub-reports:" area of the window display as preselected. If you want,
deselect the items you want to exclude from your Report.

11. Items in the "Contact List type:" area of the window display as preselected. If you
want, deselect the items you want to exclude from your Report.

12. Items in the "Agency types:" area of the window display as preselected.  If you want,
deselect the items you want to exclude from your Report.

13. Click "OK".
Result: the "Agency Master File Options" window closes and the system returns the
user to the "Agency Master File" form.
14. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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15. For instructions on distributing your Report, refer to the "System Reports"
document.  
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Application Types

The Application Types Report details the same information that displays on the
Application Types form in the Supervisor Workstation. The Application Types Report
does not require any user-entered criteria.

Generating an Application Types Report
Perform the following steps to generate an Application Types Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Application Types".
Result: the "Application Types" form displays as shown in the following screenshot:

 
4.  Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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5.  For instructions on distributing your Report, refer to the "System Reports"
document.  
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Audio

Generating an Audio Report
Perform the following steps to generate an Audio Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Audio".
Result: the "Audio" form displays as shown in the following screenshot:
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4. To run an Audio Report, enter a beginning value in the "From:" field and an ending
value in the "To:" field. The system will report on all items that fit between the
beginning and ending values. 

5. The "Include Audio Type Details" checkbox displays as preselected. If you want to
restrict the amount of information that displays in your Report, deselect the
checkbox.

6.  Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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7.  For instructions on distributing your Report, refer to the "System Reports"
document.  

Authority Master File

The Authority Master File Report displays details for Manitou Authorities. Users can
select specific Authorities and customize the level of detail that displays in the Report.
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Generating an Authority Master File Report
Perform the following steps to generate an Authority Master File Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Authority Master File".
Result: the "Authority Master File" form displays as shown in the following screenshot:
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4. If you want, apply any of the following parameters to your Authority Master File
Report: 
· Authority ID
· Authority Name
· City
· Region

5. To run an Authority Master File Report, enter a beginning value in the "From:" field
and an ending value in the "To:" field. The system will report on all items that fit
between the beginning and ending values. 

6. If you want to prevent passwords from displaying in your Report, select the
"Suppress passwords" checkbox.

7. If you want your Report to display page breaks between Authority listings, select the
"Page breaks" checkbox.

8. Click "Options".
Result: the "Authority Master File Options" window displays as shown in the following
screenshot:
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9. Items in the "Sub-reports:" area of the window display as preselected. If you want,
deselect the items you want to exclude from your Report.

10. Items in the "Contact List type:" area of the window display as preselected. If you
want, deselect the items you want to exclude from your Report.

11. Items in the "Authority types:" area of the window display as preselected.  If you
want, deselect the items you want to exclude from your Report.

12. Click "OK".
Result: the "Authority Master File Options" window closes and the system returns the
user to the "Authority Master File" form.
13. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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14. For instructions on distributing your Report, refer to the "System Reports"
document.  
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Branch Master File

The Branch Master File Report displays details for Manitou Branches. Users can select
specific Branches and customize the level of detail that displays in the Report. 

Generating a Branch Master File Report
Perform the following steps to generate a Branch Master File Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Branch Master File".
Result: the "Branch Master File" form displays as shown in the following screenshot:
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4. If you want, apply any of the following parameters to your Branch Master File
Report: 
· Branch ID
· Branch Name
· City
· Region

5. To run an Branch Master File Report, enter a beginning value in the "From:" field and
an ending value in the "To:" field. The system will report on all items that fit between
the beginning and ending values. 

6. If you want to prevent passwords from displaying in your Report, select the
"Suppress passwords" checkbox.

7. If you want your Report to display page breaks between Branch listings, select the
"Page breaks" checkbox.

8. Click "Options".
Result: the "Branch Master File Options" window displays as shown in the following
screenshot:
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9. Items in the "Sub-reports:" area of the window display as preselected. If you want,
deselect the items you want to exclude from your Report.

10. Items in the "Contact List type:" area of the window display as preselected. If you
want, deselect the items you want to exclude from your Report.

11. Click "OK".
Result: the "Authority Master File Options" window closes and the system returns the
user to the "Authority Master File" form.
12. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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13. For instructions on distributing your Report, refer to the "System Reports"
document.  
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Cities

Generating a Cities Report
Perform the following steps to generate a Cities Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Cities".
Result: the "Cities" form displays as shown in the following screenshot:
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4. If you want, apply either of the following parameters to your Cities Report: 
· Region
· City

Note: we suggest that you narrow the amount of information in your Report by entering
a Region into your Report parameters. For databases with cities for every region,
running the Report with the default options could impact the Report Server’s ability to
run other Reports.

5. To run a City Report, enter a beginning value in the "From:" field and an ending value
in the "To:" field. The system will report on all items that fit between the beginning
and ending values. 

6. Items in the "Country" area of the form display as preselected. If you want, deselect
the items you want to exclude from your Report.

7.  Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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8.  For instructions on distributing your Report, refer to the "System Reports"
document. 
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Class Codes

The Class Codes Report lists the Class Codes currently available within the Manitou
Database. Class Codes are used to categorize Manitou accounts. Class Codes are similar
to Group Codes, with the exception that Dealer billing is specific to Class Codes.

Generating a Class Codes Report
Perform the following steps to generate an Class Codes Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Class Codes".
Result: the "Class Codes" form displays as shown in the following screenshot:



Manitou CS  Supervisor Workstation User Guide | © Copyright 2017 Bold Technologies LTD

364

4. To run an Class Codes Report, enter a beginning value in the "From:" field and an
ending value in the "To:" field. The system will report on all items that fit between the
beginning and ending values. 

5.  Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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6.  For instructions on distributing your Report, refer to the "System Reports"
document.  

Contact Point Types

The Contact Point Types Report lists the different Contact Point Types available within
the Manitou system. Contact Points include telephone numbers, emails addresses, SMS
numbers, pager and fax numbers, and web addresses. The Contact Point Types Report
does not require any user-entered criteria.

Generating a Contact Point Types Report
Perform the following steps to generate a Contact Point Types Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:



Manitou CS  Supervisor Workstation User Guide | © Copyright 2017 Bold Technologies LTD

366

3. Double-click "Contact Point Types".
Result: the "Contact Point Types" form displays as shown in the following screenshot:

 
4.  Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:



System Reports 367

5.  For instructions on distributing your Report, refer to the "System Reports"
document. 
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Control Panels

The Control Panels Report displays details for Manitou Control Panels. 

Generating a Control Panels Report
Perform the following steps to generate a Control Panels Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Control Panels".
Result: the "Control Panels" form displays as shown in the following screenshot:

 



Manitou CS  Supervisor Workstation User Guide | © Copyright 2017 Bold Technologies LTD

370

4. To run a Control Panel Report, enter a beginning value in the "From:" field and an
ending value in the "To:" field. The system will report on all items that fit between the
beginning and ending values. 

5. The "Detail view" checkbox displays as preselected. If you want to limit the amount of
information that displays in your Report, deselect the checkbox.

6. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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7.  For instructions on distributing your Report, refer to the "System Reports"
document.  
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Countries

The Countries Report displays details for Countries available in the Supervisor
Workstation. The Countries Report displays Country-specific telephone, time, and
mailing address formatting information.

Generating a Countries Report
Perform the following steps to generate a Countries Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Countries".
Result: the "Countries" form displays as shown in the following screenshot:
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4. Items in the "Country" area of the form display as preselected. If you want to exclude

information from your Report for any of the listed Countries , deselect the item.
5. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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6.  For instructions on distributing your Report, refer to the "System Reports"
document.  
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Customer Master File

The Customer Master File Report displays details of Customer data contained in the
Customer form. 

Generating a Customer Master File Report
Perform the following steps to generate a Customer Master File Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Customer Master File".
Result: the "Customer Master File" form displays as shown in the following screenshot:
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4. If you want, apply any of the following parameters to your Customer Master File
Report: 
· Customer ID
· Customer Name
· Dealer ID
· Branch ID
· Group
· Class

5. To run a Customer Master File Report, enter a beginning value in the "From:" field
and an ending value in the "To:" field. The system will report on all items that fit
between the beginning and ending values. 

6. If you want to run your Report by the "Commission date", select the item and enter a
date and time range.

7. If you want to run your Report by the "Create date", select the item and enter a date
and time range.

8. If you want to run your Report by the "Last update date", select the item and enter a
date and time range.

9. If you want, select the "Marked for reprint" checkbox. 
10. If you want, select the "Reset reprint flag after publishing to printer" checkbox.
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11. If you want, select the "Suppress passwords" checkbox.
12. If you want, select the "Suppress AR No." checkbox.
13. If you want, select the "Mail format" checkbox.
14. The "Page breaks" checkbox displays as preselected. If you do not want the system to

insert page breaks between Customers in your Report, deselect the item.
15. Items in the "Monitoring status" area of the form display as preselected. If you want

to exclude any of the statuses from your Report.
16. Click "Options".
Result: the "Customer Master File Options" window displays as shown in the following
screenshot:

17. Items in the "Sub-reports to include:" area of the window display as preselected. If
you want, deselect the items you want to exclude from your Report.

18. Items in the "Contact list types:" area of the window display as preselected. If you
want, deselect the items you want to exclude from your Report.

19. The "Customer" option in the "Group by" area of the window displays as preselected.
 If you want to group items in your Report by "Dealer" or "Branch", select that option
instead.

20. The "Customer ID" option in the "Order by" area of the window displays as
preselected. If you want to order items in you Report by "Customer Name", select that
option instead.

21. Click "OK".
Result: the "Customer Master File Options" window closes and the system returns the
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user to the "Customer Master File" form.
22. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:

23. For instructions on distributing your Report, refer to the "System Reports"
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document.  

The Advanced Button
Some Report forms include an Advanced Settings button. Clicking this button results in
the display of an Advanced Settings window. Use the "Customer user defined fields"
form in the Tools menu, under Options, and Account Creation/Maintenance to
customize Report fields on Advanced Settings windows. 

For instructions on how to access and use the form, refer to the "System Reports"
document. 

Dealer Master File

The Dealer Master File Report displays Dealer data contained in the Dealer form.
 
Generating a Dealer Master File Report
Perform the following steps to generate a Dealer Master File Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Dealer Master File".
Result: the "Dealer Master File" form displays as shown in the following screenshot:
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4. If you want, apply any of the following parameters to your Dealer Master File Report: 
· Dealer ID
· Dealer Name
· City
· Region

5. To run a Dealer Master File Report, enter a beginning value in the "From:" field and
an ending value in the "To:" field. The system will report on all items that fit between
the beginning and ending values. 

6. If you want, select the "Mail format" checkbox.
7. If you want, select the "Suppress passwords" checkbox. 
8. If you want, select the "Page breaks" checkbox.
9.  Click "Options".
Result: the "Dealer Master File Options" window displays as shown in the following
screenshot:
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10. Items in the "Sub-reports:" area of the window display as preselected. If you want,
deselect the items you want to exclude from your Report.

11. Items in the "Contact List type:" area of the window display as preselected. If you
want, deselect the items you want to exclude from your Report.

12. Click "OK".
Result: the "Dealer Master File Options" window closes and the system returns the user
to the "Dealer Master File" form.
13. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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14. For instructions on distributing your Report, refer to the "System Reports"
document.  
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DNIS Maps

DNIS stands for Dialed Number Identification Service. The DNIS Report displays current
Manitou DNIS Maps. 

Generating a DNIS Maps Report
Perform the following steps to generate a DNIS Maps Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "DNIS Maps".
Result: the "DNIS Maps" form displays as shown in the following screenshot:
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4. If you want, apply either of the following parameters to your DNIS Maps Report: 
· Monitoring Group
· Dealer ID

5. To run a DNIS Maps Report, enter a beginning value in the "From:" field and an
ending value in the "To:" field. The system will report on all items that fit between the
beginning and ending values. 

6. Items in the "Rec. Line Prefix:" area of the form display as preselected. Deselect any
items you want to exclude from your Report.

7. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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8.  For instructions on distributing your Report, refer to the "System Reports"
document.  
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Event Categories

The Events Categories Report displays details about the Event Categories currently in
use in Manitou. You can exclude Monitoring Groups to narrow the results that display in
your Report.

Generating an Event Categories Report
Perform the following steps to generate an Event Categories Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Event Categories".
Result: the "Event Categories" form displays as shown in the following screenshot:
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4. Items in the "Monitoring Groups" area of the form display as preselected. Deselect
any Monitoring Groups you want to exclude from your Report.

5. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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6.  For instructions on distributing your Report, refer to the "System Reports"
document.  
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Event Codes

The Event Codes Report displays Event Code details. 

Generating an Event Codes Report
Perform the following steps to generate an Event Codes Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Event Codes".
Result: the "Event Codes" form displays as shown in the following screenshot:
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4. Items in the "Event Categories" area of the form display as preselected. Deselect any
items you want to exclude from your Report.

5. Items in the "Default Action Patterns" area of the form display as preselected.
Deselect any items you want to exclude from your Report.

6. The "All" option in the "Is event alarm?" area of the form displays as preselected. If
you want to limit the types of Events that display in your Report, select another item
instead.

7. The "Summary" option in the "Include" area of the form displays as preselected. If you
want more details to display in your Report, select the "Detailed" option instead.

8. The "Event Category" option in the "Order By" area of the form displays as
preselected. If you want to order your Report by "Event Code", "Default Action",
"Priority", "Is event alarm", "Soft command client processing", or "Soft command
signal processing", select that item instead.

9. Click "Options".
Result: the "Event Codes Options" window displays as shown in the following
screenshot:
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10. Items in the "Soft Command Client Processing" area of the form display as
preselected. Deselect any items you want to exclude from your Report.

11. Items in the "Soft Command Signal Processing" area of the form display as
preselected. Deselect any items you want to exclude from your Report.

12. The "Any" option displays as preselected in the "Show" area below the "Soft
Command Client Processing" list. If you want your Report to display all instances of
the selected Event Codes, select "All" instead.

13. The "Any" option displays as preselected in the "Show" area below the "Soft
Command Signal Processing" list. If you want your Report to display all instances of
the selected Event Codes, select "All" instead.

14. Click "OK".
Result: the "Event Codes Options" window closes and the system returns you to the
"Event Codes" form.
15. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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16. For instructions on distributing your Report, refer to the "System Reports"
document.  
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Event Maps

The Event Maps Report details how signals arrive into Manitou and how the system
translates them.

Generating an Event Maps Report
Perform the following steps to generate an Event Maps Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Event Maps".
Result: the "Event Maps" form displays as shown in the following screenshot:
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4. To run an Event Maps Report, enter a beginning value in the"Dealer ID" "From:" field
and an ending value in the "To:" field. The system will report on all items that fit
between the beginning and ending values. 

5. Items in the "Protocol Type:" area of the form display as preselected. Deselect any
items you want to exclude from your Report.

6. The "Protocol" option displays as preselected in the "Group By:" area of the form. If
you want to group your Report by "Installer", select that option instead. 

7.  Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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8.  For instructions on distributing your Report, refer to the "System Reports"
document.  



System Reports 403

Global Holidays

The Global Holidays Report displays the Global Holidays currently in Manitou and
orders them by Country. 

Generating a Global Holidays Report
Perform the following steps to generate a Global Holidays Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Global Holidays".
Result: the "Global Holidays" form displays as shown in the following screenshot:
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4. Items in the "Country" area of the form display as preselected. Deselect the items you
want to exclude from your Report.

5. The "Month, Day" option in the "Format:" area of the form displays as preselected. If
you want holidays to display in "Day, Month" format, select that option instead.

6.  Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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7.  For instructions on distributing your Report, refer to the "System Reports"
document.  
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Global Keyholder Master File

The Global Keyholder Master File Report lists Keyholders with Contact IDs tied to their
information.  

Generating a Global Keyholder Master File Report
Perform the following steps to generate a Global Keyholder Master File Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Global Keyholder Master File".
Result: the "Global Keyholder Master File" form displays as shown in the following
screenshot:
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4. If you want, apply any of the following parameters to your Global Keyholder Master
File Report: 
· Keyholder ID
· Keyholder Name
· City
· Region
· Password

5. To run a Global Keyholder Master File Report, enter a beginning value in the "From:"
field and an ending value in the "To:" field. The system will report on all items that fit
between the beginning and ending values. 

6. If you want, select the "Mail format" checkbox. 
7. If you want to prevent passwords from displaying in your Report, select the

"Suppress passwords" checkbox.
8. If you want your Report to display page breaks between Global Keyholder listings,

select the "Page breaks" checkbox.
9. Click "Options".
Result: the "Global Keyholder Master File Options" window displays as shown in the
following screenshot:
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10. Items in the "Sub-reports:" area of the window display as preselected. If you want,
deselect the items you want to exclude from your Report.

11. Items in the "Keyholder type:" area of the window display as preselected. If you
want, deselect the items you want to exclude from your Report.

12. Click "OK".
Result: the "Global Keyholder Master File Options" window closes and the system
returns the user to the "Global Keyholder Master File" form.
13. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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14. For instructions on distributing your Report, refer to the "System Reports"
document.  
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Group Codes

The Group Codes Report details Group Codes in Manitou. Group Codes are used to
categorize Customer accounts. Group Codes are similar to Class Codes, with the
exception that Dealer billing is specific to Class Codes.

Generating a Group Codes Report
Perform the following steps to generate an Group Codes Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Group Codes".
Result: the "Group Codes" form displays as shown in the following screenshot:
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4. To run a Group Codes Report, enter a beginning value in the "From:" field and an
ending value in the "To:" field. The system will report on all items that fit between the
beginning and ending values. 

5.  Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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6.  For instructions on distributing your Report, refer to the "System Reports"
document.  

Locales

The Locales Report lists the languages currently in use in Manitou. This Report does not
require you to enter any Report parameters. 

Generating a Locales Report
Perform the following steps to generate a Locales Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Locales".
Result: the "Locales" form displays as shown in the following screenshot:
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4.  Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:

5.  For instructions on distributing your Report, refer to the "System Reports"
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document.  

Monitoring Company Master File

The Monitoring Company Master File Report displays details of the Monitoring
Company record. 

Generating a Monitoring Company Master File Report
Perform the following steps to generate a Monitoring Company Master File Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Monitoring Company Master File".
Result: the "Monitoring Company Master File" form displays as shown in the following
screenshot:
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4. If you want, apply any of the following parameters to your Monitoring Company
Master File Report: 
· Company ID
· Company Name
· City
· Region

5. To run a Monitoring Company Master File Report, enter a beginning value in the
"From:" field and an ending value in the "To:" field. The system will report on all
items that fit between the beginning and ending values. 

6. If you want to prevent passwords from displaying in your Report, select the
"Suppress passwords" checkbox.

7. If you want your Report to display page breaks between Monitoring Company
listings, select the "Page breaks" checkbox.

8. Click "Options".
Result: the "Company Master File Advanced Options" window displays as shown in the
following screenshot:
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9. Items in the "Sub-reports:" area of the window display as preselected. If you want,
deselect the items you want to exclude from your Report.

10. The "Person" checkbox in the "Contact List type:" area of the window displays as
preselected. If you want, deselect the item to exclude it from your Report.

11. Click "OK".
Result: the "Company Master File Advanced Options" window closes and the system
returns the user to the "Monitoring Company Master File" form.
12. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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13. For instructions on distributing your Report, refer to the "System Reports"
document.  
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Monitoring Groups

The Monitoring Groups Report displays a list of all current Monitoring Groups. This
Report does not require you to enter any Report parameters. 

Generating a Monitoring Groups Report
Perform the following steps to generate a Monitoring Groups Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Monitoring Groups".
Result: the "Monitoring Groups"  form displays as shown in the following screenshot:
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4.  Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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5.  For instructions on distributing your Report, refer to the "System Reports"
document.  
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Monitoring Types

The Monitoring Types Report displays a list of current Monitoring Types in Manitou. 

Generating a Monitoring Types Report
Perform the following steps to generate a Monitoring Types Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Monitoring Types".
Result: the "Monitoring Types" form displays as shown in the following screenshot:
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4. Items in the "Customer Types" area of the form display as preselected. If you want,
deselect any items you want to exclude from your Report.

5. Items in the "Monitoring Level and Attributes" area of the form display as
preselected. If you want, deselect any items you want to exclude from your Report.

6. If you want to include billing detail in your Report, select the "Include Billing Detail"
checkbox.

7. If you want to include limit quantities in your Report, select the "Include Limit
Quantities" checkbox. 

8. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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9.  For instructions on distributing your Report, refer to the "System Reports"
document.  
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Output Device Types

The Output Device Types Report displays a list of all Output Devices Types currently
configured in Manitou. 

Generating an Output Device Types Report
Perform the following steps to generate an Output Device Types Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Output Device Types".
Result: the "Output Device Types" form displays as shown in the following screenshot:
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4. Items in the "Attributes" area of the form display as preselected. If you want, deselect
any items you want to exclude from your Report.

5. Items in the "Protocol" area of the form display as preselected. If you want, deselect
any items you want to exclude from your Report.

6. Items in the "Type" area of the form display as preselected. If you want, deselect any
items you want to exclude from your Report.

7. If you want to group your Report by "Attribute", "Type", or "Protocol", select the item
in the "Group by:" area of the form.

8. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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9.  For instructions on distributing your Report, refer to the "System Reports"
document. 
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Permit Types

The Permit Types Report provides a list all Authority permits. 

Generating a Permit Types Report
Perform the following steps to generate a Permit Types Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Permit Types".
Result: the "Permit Types" form displays as shown in the following screenshot:
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4. Items in the "Country" area of the form display as preselected. If you want, deselect
any items you want to exclude from your Report.

5. Items in the "Permit Type" area of the form display as preselected. If you want,
deselect any items you want to exclude from your Report.

6. Items in the "Authority Type" area of the form display as preselected. If you want,
deselect any items you want to exclude from your Report.

7. The "Country" option in the "Group by:" area of the form displays as preselected. If
you want to group your Report by "Authority Type" or "Permit Type", select that
option instead.

8. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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9.  For instructions on distributing your Report, refer to the "System Reports"
document.  
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Post Codes

The Post Codes Report lists all Post Codes in Manitou for a Country, Region, or City. 

Generating a Post Codes Report
Perform the following steps to generate a Post Codes Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Post Codes".
Result: the "Post Codes" form displays as shown in the following screenshot:
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4. If you want, apply any of the following parameters to your Post Codes Report: 
· Region
· City
· Post Code

5. To run a Post Codes Report, enter a beginning value in the "From:" field and an
ending value in the "To:" field. The system will report on all items that fit between the
beginning and ending values. 

6. Items in the "Country" area of the form display as preselected. If you want, deselect
the Country you want to exclude from your Report.

7. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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8.  For instructions on distributing your Report, refer to the "System Reports"
document. 
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Receiver Line Prefixes

The Receiver Line Prefixes report lists all Receiver Line Prefixes currently configured in
Manitou.

Generating a Receiver Line Prefixes Report
Perform the following steps to generate a Receiver Line Prefixes Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Receiver Line Prefixes".
Result: the "Receiver Line Prefixes" form displays as shown in the following screenshot:
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4.  Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:

5.  For instructions on distributing your Report, refer to the "System Reports"
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document.  

Receiver Types

The Receiver Types report provides a list of all Receiver Types currently configured in
Manitou. 

Generating a Receiver Types Report
Perform the following steps to generate a Receiver Types Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:



System Reports 447

3. Double-click "Receiver Types".
Result: the "Receiver Types" form displays as shown in the following screenshot:
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4.  Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:

5.  For instructions on distributing your Report, refer to the "System Reports"
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document.  

Receivers

The Receivers Report displays a list of configuration criteria for each Receiver Type and
FEP. The Report includes the Receiver Number, Code, Receiver Description, Type, Port,
Settings, Default Line Prefix, Default Monitoring Group, Line Prefix, and Transmitter ID. 

Generating a Receivers Report
Perform the following steps to generate a Receivers Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:



Manitou CS  Supervisor Workstation User Guide | © Copyright 2017 Bold Technologies LTD

450

3. Double-click "Receivers".
Result: the "Receivers" form displays as shown in the following screenshot:
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4. To run a Receivers Report, enter a beginning value in the "From:" field and an ending
value in the "To:" field. The system will report on all items that fit between the
beginning and ending values.

5. Items in the "FEPs:" area of the form display as preselected. If you want, deselect any
items you want to exclude from your Report.

6. Items in the "Receiver code:" area of the form display as preselected. If you want,
deselect any items you want to exclude from your Report.

7. If you want your Report to display a Receiver Line Map, select the "Show receiver line
map" checkbox.

8. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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9.  For instructions on distributing your Report, refer to the "System Reports"
document.  
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Regions

The Regions Report displays a list of all the Regions and abbreviations currently in
Manitou. 

Generating a Regions Report
Perform the following steps to generate a Regions Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Regions".
Result: the "Regions" form displays as shown in the following screenshot:
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4. To run a Regions Report, enter a beginning value in the "Region" "From:" field and an
ending value in the "To:" field. The system will report on all items that fit between the
beginning and ending values.

5. Items in the "Country" area of the form display as preselected. If you want, deselect
any Country you want to exclude from your Report.

6. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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7.  For instructions on distributing your Report, refer to the "System Reports"
document. 
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Resolution Codes

The Resolution Codes Report lists all Resolution Codes for a particular Country or
Group. The Report details the two-letter Resolution Code, a description of the Code, and
the Alarm condition. 

Generating a Resolution Codes Report
Perform the following steps to generate a Resolution Codes Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Resolution Codes".
Result: the "Resolution Codes" form displays as shown in the following screenshot:
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4. Items in the "Country" area of the form display as preselected. If you want, deselect
any Country you want to exclude from your Report.

5. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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6.  For instructions on distributing your Report, refer to the "System Reports"
document.  
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Reverse Channel Routes

The Reverse Channel Routes Report displays all Protocols currently configured in
Manitou. The Report also includes a description of the Protocol, Application Type,
Receiver Line Prefix, , the FEP Number, Receiver Number, Line Number, Receiver Code,
and whether the Reverse Channel is associated with a Dealer.

Generating a Reverse Channel Routes Report
Perform the following steps to generate a Reverse Channel Routes Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Reverse Channel Routes".
Result: the "Reverse Channel Routes" form displays as shown in the following
screenshot:
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4. To run a Reverse Channel Routes Report, enter a beginning value in the"Dealer ID"
"From:" field and an ending value in the "To:" field. The system will report on all
items that fit between the beginning and ending values. 

5. Items in the "Receiver Line Prefix" area of the form display as preselected. If you
want, deselect any items you want to exclude from your Report.

6. Items in the "Application Type" area of the form display as preselected. If you want,
deselect any items you want to exclude from your Report.

7. Items in the "Protocol" area of the form display as preselected. If you want, deselect
any items you want to exclude from your Report.

8. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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9.  For instructions on distributing your Report, refer to the "System Reports"
document.  
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Script Messages

The Script Messages Report displays all Script Messages currently in Manitou.
 
Generating a Script Messages Report
Perform the following steps to generate a Script Messages Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Script Messages".
Result: the "Script Messages" form displays as shown in the following screenshot:
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4. Items in the "Locale" area of the form display as preselected. Deselect the items you
want to exclude from your Report.

5. Items in the "Script Message Type" area of the form display as preselected. Deselect
the items you want to exclude from your Report.

6.  Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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7.  For instructions on distributing your Report, refer to the "System Reports"
document.  
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Service Provider Device Types

The Service Provider Device Types Report displays all the Service Provider Types in
Manitou. 

Generating a Service Provider Device Types Report
Perform the following steps to generate a Service Provider Device Types Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:



Manitou CS  Supervisor Workstation User Guide | © Copyright 2017 Bold Technologies LTD

470

3. Double-click "Service Provider Device Types".
Result: the "Service Provider Device Types" form displays as shown in the following
screenshot:



System Reports 471

4. Items in the "Protocol" area of the form display as preselected. Deselect the items you
want to exclude from your Report.

5.  Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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6.  For instructions on distributing your Report, refer to the "System Reports"
document. 
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Subtypes

The Subtypes Report displays all the Subtypes currently configured in Manitou. 

Generating a Subtypes Report
Perform the following steps to generate a Subtypes Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Subtypes".
Result: the "Subtypes" form displays as shown in the following screenshot:
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4. Items in the "Type:" area of the form display as preselected. Deselect the items you
want to exclude from your Report.

5.  Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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6.  For instructions on distributing your Report, refer to the "System Reports"
document.  
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Temporary Comments

The Temporary Comments Report displays all the Temporary Comments associated
with a Customer's record. Users can run the Report to view important comments, such
as a Customer vacationing during a specific time period, or other special instructions
regarding an account. 

Generating a Temporary Comments Report
Perform the following steps to generate a Temporary Comments Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Temporary Comments".
Result: the "Temporary Comments" form displays as shown in the following screenshot:
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4. If you want, apply any of the following parameters to your Temporary Comments
Report: 

· Customer ID
· Name
· Dealer ID
· Branch ID
· Group
· Class

5. To run a Temporary Comments Report, enter a beginning value in the "From:" field
and an ending value in the "To:" field. The system will report on all items that fit
between the beginning and ending values. 

6. If you want, select the "Follow up" checkbox and enter a date and time range. 
7. The "Include comment details" checkbox displays as preselected. Deselect the item, if

you want to limit the amount of information that displays in your Report.
8. The "Non-expired" option in the "Date range:" area of the form displays as

preselected. If you want, select either the "Selected dates" or "Expired" option
instead.

9. The "Valid To Date" option in the "Order by:" area of the form displays as preselected.
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If you want, select either the "Contact ID" or "Name" option instead.
10. The "Customer" option in the "Contract type:" area of the form displays as

preselected. If you want, select the "Company", "Dealer", "Branch", "Agency", or
"Authority" option instead.

11. Items in the "Monitoring status" area of the form display as preselected. Deselect any
items you want to exclude from your Report.

12. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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13. For instructions on distributing your Report, refer to the "System Reports"
document.  

The Advanced Button
Some Report forms include an Advanced Settings button. Clicking this button results in
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the display of an Advanced Settings window. Use the "Customer user defined fields"
form in the Tools menu, under Options, and Account Creation/Maintenance to
customize Report fields on Advanced Settings windows. 

For instructions on how to access and use the form, refer to the "System Reports"
document. 

Time Zones

The Time Zones Report displays all the Time Zones currently in Manitou. This Report
does not require you to enter any Report parameters.
 
Generating a Time Zones Report
Perform the following steps to generate a Time Zones Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Time Zones".
Result: the "Time Zones" form displays as shown in the following screenshot:



Manitou CS  Supervisor Workstation User Guide | © Copyright 2017 Bold Technologies LTD

484

4.  Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:

5.  For instructions on distributing your Report, refer to the "System Reports"
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document. 

Transmitter Protocol Formats

The Transmitter Protocol Format Report displays all the Transmitter Protocol Formats
currently configured in Manitou. The Report includes the Transmitter and Signal Types,
as well as other Area and Zone details.

Generating a Transmitter Protocol Formats Report
Perform the following steps to generate a Transmitter Protocol Formats Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Transmitter Protocol Formats".
Result: the "Transmitter Protocol Formats" form displays as shown in the following
screenshot:
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4. To run a Transmitter Protocol Formats Report, enter a beginning value in the
"Protocol Type" "From:" field and an ending value in the "To:" field. The system will
report on all items that fit between the beginning and ending values.

5. Items in the "Type:" area of the form display as preselected. If you want, deselect any
items you want to exclude from your Report.

6. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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7.  For instructions on distributing your Report, refer to the "System Reports"
document. 
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Transmitter Types

The Transmitter Types Report displays all Transmitter Types currently in Manitou. 

Generating a Transmitter Types Report
Perform the following steps to generate a Transmitter Types Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Transmitter Types".
Result: the "Transmitter Types" form displays as shown in the following screenshot:
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4. To run a Transmitter Type Report, enter a beginning value in the "Transmitter Types"
"From:" field and an ending value in the "To:" field. The system will report on all
items that fit between the beginning and ending values.

5. If you want your Report to include programming details, select the "Include
programming" checkbox.

6. Items in the "Reverse Command Protocol" area of the form display as preselected. If
you want, deselect any items you want to exclude from your Report.

7. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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8.  For instructions on distributing your Report, refer to the "System Reports"
document.  
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User Groups

The User Groups Report displays details about all Manitou User Groups. 

Generating a User Groups Report
Perform the following steps to generate a User Groups Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "User Groups".
Result: the "User Groups" form displays as shown in the following screenshot:



System Reports 495

4. If you want, apply either of the following parameters to your User Groups Report: 
· Dealer ID
· Branch ID

5. To run a User Groups Report, enter a beginning value in the "From:" field and an
ending value in the "To:" field. The system will report on all items that fit between the
beginning and ending values.

6. Items in the "User Group" area of the form display as preselected. If you want,
deselect any items you want to exclude from your Report.

7. If you want to group items in your Report by "Dealer" or "Branch", select the item in
the "Group By" area of the form.

8. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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9.  For instructions on distributing your Report, refer to the "System Reports"
document.  
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Users

The User Report displays details about all Users currently in Manitou. The Report
includes details on User ID, Name, Contact Point, Locale, Country, Profile, Password
Changes, Alarm Queue accessibility, and Accounting access.

Generating a User Report
Perform the following steps to generate a User Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Users".
Result: the "Users" form displays as shown in the following screenshot:
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4. If you want, apply either of the following parameters to your User Groups Report: 
· Dealer ID
· Branch ID

5. To run a Users Report, enter a beginning value in the "From:" field and an ending
value in the "To:" field. The system will report on all items that fit between the
beginning and ending values.

6. Items in the "User Group" area of the form display as deselected. If you want, select
any items you want to include in your Report.

7. Items in the "Locale" area of the form display as deselected. If you want, select any
items you want to include in your Report.

8. If you want to group items in your Report by "Locale", "Dealer" or "Branch", select the
item in the "Group By" area of the form.

9. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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10. For instructions on distributing your Report, refer to the "System Reports"
document.  
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Window Codes

The Window Codes Report displays all Schedule Window Codes currently in Manitou. 

Generating a Window Codes Report
Perform the following steps to generate a Window Codes Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Window Codes".
Result: the "Window Codes" form displays as shown in the following screenshot:

4. To run a Window Codes Report, enter a beginning value in the "Window Code"
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"From:" field and an ending value in the "To:" field. The system will report on all
items that fit between the beginning and ending values. 

5.  Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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6.  For instructions on distributing your Report, refer to the "System Reports"
document.  

Workstation Groups

The Workstation Groups Report displays all Workstation Groups currently in Manitou. 
This Report does not require you to enter any Report parameters.  

Generating a Workstation Groups Report
Perform the following steps to generate a Workstation Groups Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Workstation Groups".
Result: the "Workstation Groups" form displays as shown in the following screenshot:
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4.  Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:

5.  For instructions on distributing your Report, refer to the "System Reports"
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document.  

Workstations

The Workstations Report displays all Workstations currently in Manitou. The Report
includes details on specific Workstations, such as which Workstations are associated
with a Manitou client, the Security Level, when the Workstation was last active, the
Monitoring Group, Attributes, Locale, and Time Zone. 

Generating a Workstations Report
Perform the following steps to generate a Workstations Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "Master File" Navigation Tree Node.
Result: the Master File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Workstations".
Result: the "Workstations" form displays as shown in the following screenshot:
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4. Items in the "Client Type" area of the form display as preselected. If you want,
deselect any items you want to exclude from your Report.

5. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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6.  For instructions on distributing your Report, refer to the "System Reports"
document.  
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System Reports
You must define parameters before running Manitou Reports. Because every Manitou
Report is different, please refer to the specific Report document for instructions on
running the Report you want. 

After you have set your Manitou Report parameters, you must define your Distribution
list to indicate the format in which Manitou should send your Report, and the recipients
to whom it should be sent. The instructions in this document apply to the following
Report types:

· Activity Reports
· Custom Reports
· Maintenance Reports
· Master File Reports
· System Reports

Because the instructions for Distributing your Report are the same for all these Report
types, Report Distribution instructions are contained in this document only. Refer to the
instructions for your specific Report, and then refer to this document for Distribution
instructions.

Adding Recipients to your Report Distribution List
Perform the following steps to define your Report Distribution List:

1. After you have entered all your Report parameters on the Reports Tab, click "Next" in
the bottom-right corner of the Report form.

Result: "Distribution" Tab displays as shown in the following screenshot:
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2. If you want Manitou to distribute your Report to a specific person, enter the
recipient's name in the "Override recipient's name:" field.

3. Select a format in which to distribute your Report from the "Override destination
type:" dropdown menu.

Note: your options from the "Override destination type:" menu are "Fax", "E-mail", and
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"Printer".
Result: if you selected email, a dropdown menu called "Email attachment type:"
displays. Select "PDF", "RTF" or "Text" as the attachment type. If you selected the fax
option, the field to enter the fax number now displays as formatted when you click in the
"Override fax number:" field. Enter the recipient's fax number (including the area code).
4. Enter either a fax number or an email address for your Report recipient in the

"Override destination address (Fax/Email):" field.
5. Click "Add to list".
Result: the Report recipient you added now displays in the right window area as shown
in the following screenshot:
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6. If you want to select an entity as a recipient for your Report, you must define the
parameters in the "Contact list destination:" area of the Distribution Tab. 

7. If you want to define a destination printer, select it from the "Default printer:"
dropdown menu.

8. Select an entity from the "Contact list type:" dropdown menu.
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Note: your options from the "Contact list type:" dropdown menu are "Company",
"Customer", "Dealer", "Branch", "Agency", and "Authority".
Result: the Contact List Type you selected now displays in the bottom-most field.
9. Click the lookup icon to the right of the bottom-most field.
Result: the "Find" window displays for the entity you selected as shown in the following
screenshot:

10. Enter search parameters to find the entity you want to add as a recipient for your
Report, and click "Search".

Result: your search results display as shown in the following screenshot:
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11. Select the entity associated with your recipient, and click "Load".
Result: the "Find" window closes, and the system returns you to the "Distribution" Tab.
The entity you selected now displays in the bottom-most field and in the left window as
shown in the following screenshot:
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12. To add the entity to your recipient list, select it, and click the right-facing single
arrow.

Result: the entity you added now displays in the right window recipient list as shown in
the following screenshot:
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13. If you want, select the "Show suppressed contacts" checkbox. 
14. If you want to preview your Report prior to distribution, select the "Hold for

preview" checkbox.
15. When you have finished adding Report recipients, click "Finish" in the bottom-right
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corner of the form.
Result: the "Information" window displays as shown in the following screenshot:

Accessing the Advanced Window
Some Report forms include an "Advanced" button as shown in the following screenshot:

Clicking the "Advanced" button results in the display of an Advanced Settings window
similar to the Alarm Cause Summary Advanced Settings window displayed in the
following screenshot:

These Advanced Settings windows correspond to the "Customer user defined fields"
form in the Tools menu, under Options, and Account Creation/Maintenance.
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System Administrators can use the "Customer user defined fields" form to customize the
display and functionality for the Advanced Settings window.

Customer Count

Generating a Customer Count Report
Perform the following steps to generate a Customer Count Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:
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2. Click the "System File" Navigation Tree Node.
Result: the System File section of the Navigation Tree expands as displayed in the
following screenshot:

3. Double-click "Customer Count".
Result: the "Customer Count" form displays as shown in the following screenshot:
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4. If you want, apply any of the following parameters to your Customer Count Report: 
· Customer ID
· Customer Name
· Dealer ID
· Branch ID
· Group
· Class Wildcard
· Class

5. To run a Customer Count Report, enter a beginning value in the "From:" field and an
ending value in the "To:" field. The system will report on all items that fit between the
beginning and ending values. 

6. If you want, select the "Use wildcard for class" checkbox. 
7. If you want, select the "Start Date" checkbox and enter a date and time range.
8. If you want to maximize the amount of information to display in your Report, select

the "Include details" checkbox.
9. Items in the "Monitoring status" area of the form display as preselected. If you want,

deselect the items you want to exclude from your Report.
10. If you want to group items in your Report by a specific subject, select the item from



System Reports 523

the "Group By" area of the form.
11. The "Customer Name" option displays as preselected in the "Order By" area of the

form. If you want to order your Report by Customer ID, select that item instead. 
12. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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13. For instructions on distributing your Report, refer to the "System Reports"
document.  

The Advanced Button
Some Report forms include an Advanced Settings button. Clicking this button results in
the display of an Advanced Settings window. Use the "Customer user defined fields"
form in the Tools menu, under Options, and Account Creation/Maintenance to
customize Report fields on Advanced Settings windows. 

For instructions on how to access and use the form, refer to the "System Reports"
document. 

Customer Services

Generating a Customer Services Report
Perform the following steps to generate a Customer Services Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "System File" Navigation Tree Node.
Result: the System File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Customer Services".
Result: the "Customer Services" form displays as shown in the following screenshot:
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4. If you want, apply any of the following parameters to your Customer Services Report: 
· Customer ID
· Customer Name
· Dealer ID
· Branch ID
· Group
· Class

5. To run a Customer Services Report, enter a beginning value in the "From:" field and
an ending value in the "To:" field. The system will report on all items that fit between
the beginning and ending values. 

6. If you want, select the "Date" checkbox and enter a date and time range.
7. If you want to limit your Report to chargeable services, select the "Include chargeable

services only" checkbox.
8. The "Customer" option in the "Group by" area of the form displays as preselected. If

you want, select the "Dealer" or "Branch" checkbox instead.
9. The "Customer ID" option in the "Order by" area of the form displays as preselected. If

you want, select the "Customer Name" checkbox instead.
10. The "Both" option in the "Summary totals:" area of the form displays as preselected.
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If you want the summary totals that display in your Report to total "By service" or "By
charge code", select that option instead.

11. Click "Options".
Result: the "Customer Services Options" window displays as shown in the following
screenshot:

12. Items in the "Monitoring status" area of the window display as preselected. If you
want, deselect the items you want to exclude from your Report.

13. Click "OK". 
Result: the "Customer Services Options" window closes and the system returns the user
to the "Customer Services" form.
14. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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15. For instructions on distributing your Report, refer to the "System Reports"
document.  

The Advanced Button
Some Report forms include an Advanced Settings button. Clicking this button results in
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the display of an Advanced Settings window. Use the "Customer user defined fields"
form in the Tools menu, under Options, and Account Creation/Maintenance to
customize Report fields on Advanced Settings windows. 

For instructions on how to access and use the form, refer to the "System Reports"
document. 

Customer Status

Generating a Customer Status Report
Perform the following steps to generate a Customer Status Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "System File" Navigation Tree Node.
Result: the System File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Customer Status".
Result: the "Customer Status" form displays as shown in the following screenshot:
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4. If you want, apply any of the following parameters to your Customer Status Report: 
· Customer ID
· Customer Name
· Dealer ID
· Branch ID
· Group
· Class
· Time Zone

5. To run a Customer Status Report, enter a beginning value in the "From:" field and an
ending value in the "To:" field. The system will report on all items that fit between the
beginning and ending values. 

6. The "Include on test" option displays as preselected. If you want to exclude Customer
accounts that are On Test, deselect the checkbox.

7. The "Include area status" option displays as preselected. If you want to exclude the
status of specific areas from your Report, deselect the checkbox.

8. The "Include monitoring status" option displays as preselected. If you want to exclude
monitoring statuses from your Report, deselect the checkbox.

9. If you want your Report to display Dealer IDs, select the "Include dealer ID" checkbox.
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10. If you want your Report to include Monitoring Groups, select the "Include
monitoring group" checkbox.

11. Items in the "Area status" portion of the form display as preselected. If you want,
deselect the items you want to exclude from your Report.

12. Items in the "Monitoring status" area of the form display as preselected. If you want,
deselect the items you want to exclude from your Report.

13. Items in the "UL Grade" area of the form display as preselected. If you want, deselect
the items you want to exclude from your Report.

14. Click "Options".
Result: the "Customer Status Options" window displays as shown in the following
screenshot:

15. The "Customer" option in the"Group by" area of the window displays as preselected.
If you want, select the "Dealer" or "Branch" option instead.

16. The "Customer ID" option in the "Order by" area of the window displays as
preselected. If you want, select the "Customer Name" option instead. 

17. Click "OK". 
Result: the "Customer Status Options" window closes and the system returns the user
to the "Customer Status" form.
18. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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19. For instructions on distributing your Report, refer to the "System Reports"
document.  

The Advanced Button
Some Report forms include an Advanced Settings button. Clicking this button results in



Manitou CS  Supervisor Workstation User Guide | © Copyright 2017 Bold Technologies LTD

534

the display of an Advanced Settings window. Use the "Customer user defined fields"
form in the Tools menu, under Options, and Account Creation/Maintenance to
customize Report fields on Advanced Settings windows. 

For instructions on how to access and use the form, refer to the "System Reports"
document. 

Customer Status Change

Generating a Customer Status Change Report
Perform the following steps to generate a Customer Status Change Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "System File" Navigation Tree Node.
Result: the System File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Customer Status Change".
Result: the "Customer Status Change" form displays as shown in the following
screenshot:
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4. If you want, apply any of the following parameters to your Customer Status Change
Report: 
· Dealer ID
· Branch ID
· Class

5. To run a Customer Status Change Report, enter a beginning value in the "From:" field
and an ending value in the "To:" field. The system will report on all items that fit
between the beginning and ending values. 

6. If you want to run your Report by date, select the "Date" checkbox and enter a date
and time range.

7. Items in the "Operator"  area of the form display as preselected. If you want, deselect
the Operators you want to exclude from your Report.

8. Items in the "Include:" area of the form display as preselected. If you want to limit the
types of Customer accounts that display in your Report to "Activated", "Inactivated",
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or "Deactivated, select that option.
9. The "Status" option in the "Group by:" area of the form displays as preselected. If you

want to group your Report by "Dealer" or "Branch" select that item instead.
10. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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11. For instructions on distributing your Report, refer to the "System Reports"
document.  

Dealer Billing

Generating a Dealer Billing Report
Perform the following steps to generate a Dealer Billing Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "System File" Navigation Tree Node.
Result: the System File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Dealer Billing".
Result: the "Dealer Billing" form displays as shown in the following screenshot:



Manitou CS  Supervisor Workstation User Guide | © Copyright 2017 Bold Technologies LTD

540

5. To run a Dealer Billing Report, enter a beginning value in the "From:" field and an
ending value in the "To:" field. The system will report on all items that fit between the
beginning and ending values. 

6. If you want, select the "Mail format" checkbox. 
7. If you want to maximize the amount of information that displays in your Report,

select the "Include details" checkbox.
8. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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9.  For instructions on distributing your Report, refer to the "System Reports"
document.  
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False Alarm Summary

Generating a False Alarm Summary Report
Perform the following steps to generate a False Alarm Summary Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "System File" Navigation Tree Node.
Result: the System File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "False Alarm Summary".
Result: the "False Alarm Summary" form displays as shown in the following screenshot:



Manitou CS  Supervisor Workstation User Guide | © Copyright 2017 Bold Technologies LTD

544

4. If you want, apply any of the following parameters to your False Alarm Report: 
· Dealer ID
· Branch ID
· Authority ID

5. To run a False Alarm Report, enter a beginning value in the "From:" field and an
ending value in the "To:" field. The system will report on all items that fit between the
beginning and ending values. 

6. The "Date" checkbox displays as preselected. If you want to run your Report by date,
enter the date and time parameters.

7. If you want to group your Report by "Dealer" or "Branch", select that option in the
"Group By:" area of the form.

8. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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9.  For instructions on distributing your Report, refer to the "System Reports"
document.  
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On Test

Generating an On Test Report
Perform the following steps to generate an On Test Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "System File" Navigation Tree Node.
Result: the System File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "On Test".
Result: the "On Test" form displays as shown in the following screenshot:
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4. If you want, apply any of the following parameters to your On Test Report: 
· Customer ID
· Customer Name
· Dealer ID
· Branch ID
· Group
· Class
· Time Zone

5. To run an On Test Report, enter a beginning value in the "From:" field and an ending
value in the "To:" field. The system will report on all items that fit between the
beginning and ending values. 

6. Items in the "Monitoring status" area of the form display as preselected. Deselect any
items that you want to exclude from your Report.

7. The "Customer" option in the "Group by" area of the form displays as preselected. If
you want to group your Report by "Dealer" or "Branch", select that option instead.

8. The "Customer ID" option in the "Order by" area of the form displays as preselected. If
you want to order your Report by "Customer Name", select that option instead.

9. Click "Next". 
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Result: the Distribution Tab displays as shown in the following screenshot:

10. For instructions on distributing your Report, refer to the "System Reports"
document.  
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The Advanced Button
Some Report forms include an Advanced Settings button. Clicking this button results in
the display of an Advanced Settings window. Use the "Customer user defined fields"
form in the Tools menu, under Options, and Account Creation/Maintenance to
customize Report fields on Advanced Settings windows. 

For instructions on how to access and use the form, refer to the "System Reports"
document. 

Operator Time Cards

Generating an Operator Time Cards Report
Perform the following steps to generate an Operator Time Cards Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "System File" Navigation Tree Node.
Result: the System File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Operator Time Cards".
Result: the "Operator Time Cards" form displays as shown in the following screenshot:
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4. To run a Report by "User ID", enter a beginning value in the "From:" field and an
ending value in the "To:" field. The system will report on all items that fit between the
beginning and ending values. 

5. The "Date" checkbox displays as preselected. If you want to run your Report by date,
enter the date and time parameters.

6. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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7.  For instructions on distributing your Report, refer to the "System Reports"
document.  
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Raw Data Log

Generating a Raw Data Log Report
Perform the following steps to generate a Raw Data Log Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "System File" Navigation Tree Node.
Result: the System File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Raw Data Log".
Result: the "Raw Data Log" form displays as shown in the following screenshot:
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4. If you want, apply either of the following parameters to your Raw Data Log Report: 
· Receiver Line Prefix
· Transmitter ID

5. The "Date" checkbox displays as preselected. If you want to run your Report by date,
enter the date and time parameters.

6. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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7.  For instructions on distributing your Report, refer to the "System Reports"
document.  
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Receiver Line Loading

The Receiver Line Loading Report displays all Receiver Lines and the Customers
assigned to each. 

Generating a Receiver Line Loading Report
Perform the following steps to generate a Receiver Line Loading Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "System File" Navigation Tree Node.
Result: the System File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Receiver Line Loading".
Result: the "Receiver Line Loading" form displays as shown in the following screenshot:
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4. Items in the "Receiver line prefixes:" area of the form display as preselected. Deselect
any items you want to exclude from your Report.

5. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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6.  For instructions on distributing your Report, refer to the "System Reports"
document.  
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System Connection Status

Generating a System Connection Status Report
Perform the following steps to generate a Connection Status Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "System File" Navigation Tree Node.
Result: the System File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "System Connection Status".
Result: the "System Connection Status" form displays as shown in the following
screenshot:
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4. If you want, apply any of the following parameters to your System Connection Status
Report: 

· Customer ID
· Customer Name
· Dealer ID
· Branch ID
· Authority ID
· Group
· Class

5. To run a System Connection Status Report, enter a beginning value in the "From:"
field and an ending value in the "To:" field. The system will report on all items that fit
between the beginning and ending values. 

6. If you want to run a Report by the "Enable date", select the checkbox and enter a date
and time range.

7. If you want to run a Report by the "Terminate date", select the checkbox and enter a
date and time range.

8. The "Enabled" option in the "Include:" field displays as preselected. If you want your
Report to include only "Terminated" accounts, select that option instead. 
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9. The "Customer ID" option in the "Order by:" area of the form displays as preselected.
If you want to order your Report by "Customer name" or "Date", select that option
instead.

10. If you want to group your Report by "Dealer" or "Branch", select that item in the
"Group by:" area of the form.

11. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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12. For instructions on distributing your Report, refer to the "System Reports"
document.  
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System Log

Generating a System Log Report
Perform the following steps to generate a System Log Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "System File" Navigation Tree Node.
Result: the System File section of the Navigation Tree expands as displayed in the
following screenshot:



Manitou CS  Supervisor Workstation User Guide | © Copyright 2017 Bold Technologies LTD

568

3. Double-click "System Log".
Result: the "System Log" form displays as shown in the following screenshot:
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4. If you want, apply any of the following parameters to your System Log Report: 
· Category
· Qualifier
· User ID

5. The "Date" checkbox displays as preselected. If you want to run your Report by date,
enter the date and time parameters.

6. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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7.  For instructions on distributing your Report, refer to the "System Reports"
document.  
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Transmitter Count by Receiver

Generating a Transmitter Count by Receiver Report
Perform the following steps to generate a Transmitter Count by Receiver Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "System File" Navigation Tree Node.
Result: the System File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Transmitter Count by Receiver".
Result: the "Transmitter Count by Receiver" form displays as shown in the following
screenshot:
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4. If you want, apply either of the following parameters to your Transmitter Count by
Receiver Report: 

· FEP
· Receiver

5. To run a Transmitter Count by Receiver Report, enter a beginning value in the
"From:" field and an ending value in the "To:" field. The system will report on all
items that fit between the beginning and ending values. 

6. Select items in the "Receiver Types" area of the form you want to include in your
Report.

7. Select items in the "Receiver Line Prefix" area of the form you want to include in your
Report.

8. If you want your Report to include a "Summary", select either the "By Line" or "By
Receiver Line Prefix" option.

9.  Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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10. For instructions on distributing your Report, refer to the "System Reports"
document.  

Transmitter Count by TX Type

Generating a Transmitter Count by TX Type Report
Perform the following steps to generate a Transmitter Count by TX Type Report:
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1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "System File" Navigation Tree Node.
Result: the System File section of the Navigation Tree expands as displayed in the
following screenshot:

3. Double-click "Transmitter Count by TX Type".
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Result: the "Transmitter Count by TX Type" form displays as shown in the following
screenshot:

4. If you want, apply any of the following parameters to your Transmitter Count by TX
Type Report: 

· Customer ID
· Customer Name
· Dealer ID
· Branch ID
· Group
· Class

5. To run a Transmitter Count by TX Report, enter a beginning value in the "From:" field
and an ending value in the "To:" field. The system will report on all items that fit
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between the beginning and ending values. 
6. Items in the "Transmitter type" area of the form display as preselected. Deselect the

items you want to exclude from your Report.
7. If you want to group your Report by "Dealer" or "Branch", select that item from the

"Group by" area of the form.
8. Click "Options".
Result: the "Customer Status Options" window displays as shown in the following
screenshot: 

9. If you want to maximize the amount of information that displays in your Report,
select the "Include Customer Details" checkbox.

10. Items in the "Monitoring status" area of the window display as preselected. Deselect
any items you want to exclude from your Report.

11. Click "OK".
Result: the "Customer Status Options" window closes and the system returns the user
to the "Transmitter Count by TX Type" form.
12. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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13. For instructions on distributing your Report, refer to the "System Reports"
document.  

The Advanced Button
Some Report forms include an Advanced Settings button. Clicking this button results in
the display of an Advanced Settings window. Use the "Customer user defined fields"
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form in the Tools menu, under Options, and Account Creation/Maintenance to
customize Report fields on Advanced Settings windows. 

For instructions on how to access and use the form, refer to the "System Reports"
document. 

Unused Transmitters

Generating an Unused Transmitters Report
Perform the following steps to generate an Unused Transmitters Report:

1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "System File" Navigation Tree Node.
Result: the System File section of the Navigation Tree expands as displayed in the
following screenshot:
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3. Double-click "Unused Transmitters".
Result: the "Unused Transmitters" form displays as shown in the following screenshot:
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4. To run an Unused Transmitter Report, enter a beginning value in the "Transmitter
ID" "From:" field and an ending value in the "To:" field. The system will report on all
items that fit between the beginning and ending values. 

5. Items in the "Receiver line prefixes:" area of the form display as preselected. Deselect
the items you want to exclude from your Report.

6. If you want to run your Report by "Dealer ID", enter a Dealer ID into the appropriate
field.

7. If you want to include a summary view in your Report, select the "Summary view"
checkbox.

Note: you cannot select both the "Summary view" and the "List each open slot" options.
These two items are mutually exclusive.
8. The "Show range counts" option displays as preselected in the "Output format" area

of the form. If you want, select the "List each open slot" option instead. 
Note: you cannot select both the "Summary view" and the "List each open slot" options.
These two items are mutually exclusive.
9. The "Decimal" option displays as preselected in the "Unassigned range numbering"

area of the form. If you want the "Hex" or the "Hex, no A" option, select that item
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instead. 
10. If you want to group your Report by "Dealer" or "Branch", select that item from the

"Group by" area of the form.
11. The default option of "4" displays as preselected in the "Max transmitter ID length"

area of the form. If you want another maximum transmitter ID length for your Report,
select that value.

12. Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:
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13. For instructions on distributing your Report, refer to the "System Reports"
document.  

User Statistics

Generating a User Statistics Report
Perform the following steps to generate a User Statistics Report:
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1. Navigate to the Reports menu, and select "System Reports".
Result: the "System Reports" Navigation Tree displays as shown in the following
screenshot:

2. Click the "System File" Navigation Tree Node.
Result: the System File section of the Navigation Tree expands as displayed in the
following screenshot:

3. Double-click "User Statistics".
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Result: the "User Statistics" form displays as shown in the following screenshot:

4. The "Date" checkbox displays as preselected. To run your Report by date, enter a date
and time range.

5. Items in the "Operator Id" area of the form display as preselected. Deselect any items
you want to exclude from your Report.

6. The "Date" option in the "Order by" area of the form displays as preselected. If you
want to order your Report by Operator, select that option instead.

7. The "Detail Summary" option in the "Summary type" area of the form displays as
preselected. If you do not want a summary in your Report, select "None". If you want
a final summary instead of a detail summary, select the "Final Summary Only" option.

8. The "Include Session Details" checkbox displays as preselected. If you want to
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minimize the amount of information that displays in your Report, deselect the item.
9.  Click "Next". 
Result: the Distribution Tab displays as shown in the following screenshot:

10. For instructions on distributing your Report, refer to the "System Reports"
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document.  

Scheduled Reports
The Scheduled Reports form allows you to search for and view specific Scheduled
Reports in Manitou. You can search by Company, Customer, Dealer, or Branch. 

Viewing Scheduled Reports 
Perform the following steps to view a specific Scheduled Report:

1. Navigate to the Reports menu, and select "Scheduled Reports".
Result: the "Scheduled Reports" form displays as shown in the following screenshot:

2. Open the "Contact type:" dropdown menu, and select "Company", "Customer",
"Dealer", or "Branch".

Result: the "Contract No:" field displays as shown in the following screenshot:
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3. If you want to display every instance of the Contact Type, click "Show All". 
4. If you select the "Show All" option, skip steps 4-8 and continue with step 9.
5. If you want to limit your search to a specific Company, Customer, Dealer, or Branch,

select the icon to the right of the "Contract No:" field.
Result: the "Find" window displays as shown in the following screenshot:

6. Select the search criteria you want from the "Search Key" dropdown menus, and
enter a value in the corresponding "Value" fields.

7. When you have entered all the search criteria and values you want, click "Search".
Result: your search results display in the "Search Results" area of the window as shown
in the following screenshot:
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8. Select the Entity you want from the list and, click "Load".
Result: any Scheduled Reports for the Entity you selected now display on the Scheduled
Report form as shown in the following screenshot:
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9. Select the specific Report you want to view, and click "View Selected".
Result: a window displays details for the Scheduled Report you selected as shown in the
following screenshot:
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Report Queue
Accessing and Navigating the Report Queue 
Perform the following steps to preview, publish, delete, abort, re-queue or republish
Reports listed in the Report Queue: I can't get the Abort button to enable.

1. Navigate to the Reports menu, and select "Report Queue".
Result: the "Report Queue" form displays as shown in the following screenshot:
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2. If you want to preview a Report, select the Report from the Report Queue list, and
click "Preview".

Results: the "Report Preview" window displays as shown in the following screenshot:

3. If you want to publish a Report, select the Report from the Report Queue list, and
click "Publish". 

4. If you want to delete a Report, select the Report from the Report Queue list, and click
"Delete".
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Result: the Report you selected no longer displays in the Report Queue list.
5. If you want to re-queue a Report, select the Report from the Report Queue list, and

click "Re-queue".
Result: the Report you selected now displays with a white highlight and the "Status"
column displays as "Pending" as shown in the following screenshot:

6. If you want to republish a Report, click "Republish".
Result: the "Republish reports" window displays as shown in the following screenshot:

7. Select "Printer", "Fax", or "Email", and click "Republish".
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Report Templates
The Report Templates form allows you to change the default settings for subsequent
Manitou Reports. Any changes you make to a Report Template will display the next time
you access the Report to define the specific data you want included.

Accessing the Report Templates Form 
Perform the following steps access Report Templates: 

1. Navigate to the Reports menu, and select "Report Template".
Result: the Report Template form displays as shown in the following screenshot:

2. Select the Report for which you want to change the default settings.
Result: the Report Template for the specific Report you selected displays as shown in
the following screenshot:
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3. Make any changes you want to the Report default settings, and click "Save".  
Result: the next time you open the Report, the default settings will conform to your
changes.
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